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Shortcuts
You want shortcuts? We've got shortcuts...

Keyboard Shortcuts
Shortcut Menus
Mouse Shortcuts
                                                         
See also
Tips of the Day



Keyboard Shortcuts
The following sections contain comprehensive lists of keyboard shortcuts available in Sound Forge XP.

General Keyboard Shortcuts 
Edit Commands 
Misc. View, Option and Special Commands 
Cursor Movement 
Selecting Data 
Navigation and Playback 

See also
Shortcuts



General Keyboard Shortcuts
File Commands
Press To
Alt+Enter Show the Properties dialog for the active data window
Control+N Create a new data window
Control+O Open a sound file into a new data window
Control+S Save modified sound data back to the file
Control+W Close the active data window
Alt+F4 Exit Sound Forge XP

Window Management Commands
Press To
Alt+0 Set input focus to the waveform display in the active window.
Alt+1 Set input focus to the Regions List.
Alt+2 Set input focus to the Video Preview window.
Alt+F5 Restore the Sound Forge XP application window.
Alt+F10 Maximize the Sound Forge XP application window.
Control+F5 Restore the active data window.
Control+F6 Go to the next data window.
Control+F10 Maximize the active data window.
Control+Shift+F6 Go to the previous data window.
Shift+F4 Tile the data windows horizontally.
Shift+F5 Cascade the data windows.

                                                         
See also
Shortcuts



Edit Commands
Press To
Control+A Select all data in the active window.
Control+C Copy the selected data onto the clipboard.
Control+D See the Set Selection dialog box.
Control+E Paste the clipboard contents into a new data window.
Control+F Crossfade data from the clipboard with the active window.
Control+G Go to a specified spot in the waveform.
Control+M Mix data from the clipboard with the active window.
Control+T Trim (crop) to the current selection.
Control+U Toggle Undo buffer creation for the active window.
Control+V Paste data from the clipboard into the active window.
Control+X Move (cut) the selected data onto the clipboard.
Control+Y Repeat last process, effect or tool.
Control+Z Undo the last action.
Control+Shift+Z Redo the last undone action
Delete Clear (delete) the selected data; nothing placed on the clipboard.

                                                         
See also
Shortcuts



Misc. View, Option and Special Commands
Press To
S Toggle current selection on and off.
Control+Enter Maximize the width of the active data window.
Control+D Show the Set Selection dialog.
Control+G Show the Go To dialog.
Control+R Record new data into a data window.
Escape Stop or cancel the current action (including playback).
F1 Open the Sound Forge XP Help file to the Contents page.
F10 Make the menu bar active.
F6 Toggle playback scrolling on and off
Shift+F10 Display a shortcut menu.

                                                         
See also
Shortcuts



Cursor Movement
Press To move to
Right Arrow The next screen pixel.
Left Arrow The previous screen pixel.
End The last sample visible in the waveform display.
Home The first sample visible in the waveform display.
Control+End The last sample in the data window.
Control+Home The first sample in the data window.
Page Up 10% of the current view past the cursor position.
Page Down 10% of the current view previous to the cursor position.
Control+Right Arrow 2% of the current view past the cursor position.
Control+Left Arrow 2% of the current view previous to the cursor position.
Numpad + The next sample.
Numpad - The previous sample.
Control+Numpad + 10 samples past the current cursor.
Control+Numpad - 10 samples previous to the current cursor.

When Regions or Markers Exist in the File:
Control+ Left Arrow The previous region or marker boundary.
Control+ Right Arrow The next region or marker boundary.

                                                         
See also
Shortcuts



Selecting Data
Press To select from the cursor to
Shift+Right Arrow The next screen pixel.
Shift+Left Arrow The previous screen pixel.
Shift+End The last sample visible in the waveform display.
Shift+Home The first sample visible in the waveform display.
Control+Shift+End The last sample in the data window.
Control+Shift+Home The first sample in the data window.
Shift+Page Up 10% of the current view past the cursor position.
Shift+Page Down 10% of the current view previous to the cursor position.
Control+Shift+Right Arrow 2% of the current view past the cursor position.
Control+Shift+Left Arrow 2% of the current view previous to the cursor position.
Shift+Numpad + The next sample.
Shift+Numpad - The previous sample.
Control+Shift+Numpad + 10 samples past the current cursor.
Control+Shift+Numpad - 10 samples previous to the current cursor.

When Regions or Markers Exist in the File:
Control+Shift+Left Arrow The previous region or marker boundary.
Control+Shift+Right Arrow The next region or marker boundary.

                                                         
See also
Shortcuts



Navigation and Playback
Press To
Up Arrow Increase time magnification (zoom in closer to data).
Down Arrow Decrease time magnification (zoom out farther from data).
Shift+Up Arrow Increase level magnification
Shift+Down Arrow Decrease level magnification
Control+Up Arrow Zoom Selection if a selection exists, Zoom In Full if no selection.
Control+Down Arrow Zoom Normal (zooms to default zoom ratio set in Preferences).
Control+Shift+Up Arrow Pan data window up if zoomed in vertically.
Control+Shift+Down Arrow Pan data window down if zoomed in vertically.
Numpad 5 Switch cursor to opposite end of selection
Tab Cycle stereo selection from left channel to right channel to both channels
Shift+Tab Cycle stereo selection from both channels to right channel to left channel.
[ (open bracket) Set Mark In at the current cursor position.
] (open bracket) Set Mark Out at the current cursor position.
C or . (period) Center the cursor in the waveform display.
Spacebar Play or Stop the current data window in default mode.
Shift+Spacebar Play All or Pause the current data window.
Control+Spacebar Switch playmode between Normal and Looped.
Enter Pause playback; keep the cursor at the current position.
Escape Stop playback of the current data window.

                                                         
See also
Shortcuts



Regions List Shortcuts
Press To
Spacebar Play or Stop the active marker or region.
Enter Edit the active marker or region.
Delete Delete the active marker or region.
` (grave accent) Cycle through the Regions List display formats.
R Create region from the current selection
Shift+R Create region without bringing up dialog.

                                                         
See also
Shortcuts



Shortcut Menus
Shortcut menus are menus that appear when you right-click on certain areas of the screen. They allow 
you to quickly access important functions. Try right-clicking on any area in Sound Forge XP...chances are 
that a Shortcut Menu will appear.

Sound Forge XP Desktop 
Waveform Display 
Playbar Selection Status 
Regions List 
Time Ruler 
Display Properties 
Level Ruler 
Status Bar 
Marker Tag 
Record Dialog 
Summary Information Picture 
Video Strip 
Edit Tool Selector 

                                                         
See also
Shortcuts



Sound Forge XP Desktop Shortcut Menu
Right-click the desktop workspace of Sound Forge XP to see this shortcut menu. Use its option to 
manage sound files on your workspace. You can open recently used files from the Recent Files option. 
You can also quickly reach the Preferences dialog from this menu.

See also
Shortcut Menus 



Waveform Display Shortcut Menu
Right-click the waveform display of a sound file to see this shortcut menu. Use it to quickly reach the 
following commands and dialogs: Zoom In Full/Normal/Out Full, Paste, Crossfade, Mix, Go To, Selection, 
Scroll Playback, Properties. 

See also
Shortcut Menus 



Playbar Selection Status Shortcut Menu
Right-click any of the playbar's selection status fields to see this shortcut menu. It allows you to set the 
current status format.

See also
Shortcut Menus 



Regions List Shortcut Menu
This shortcut menu is reached by right-clicking on the Regions List. It allows you to perform the following 
Regions List operations: Add, Delete, Edit, Replicate, Update, Copy onto Clipboard.

                                                         
See also
Shortcut Menus



Time Ruler Shortcut Menu
This shortcut menu is reached by right-clicking on the Time Ruler. It allows you to reach the Add 
Marker/Region dialog for adding regions and markers. It also lets you change the status format.



Display Properties Shortcut Menu
This shortcut menu is reached by right-clicking on the Edit Tool selector at the upper left corner of the 
data window. It allows you to set the Status, Time Ruler, Time Zoom, Overview, Level Ruler, Video, Level 
Zoom, Scrollbar, and Data Window Only options.

See Display Properties for a complete description of these options.

                                                         
See also
Shortcut Menus



Level Ruler Shortcut Menu
This shortcut menu is reached by right-clicking on the Level Ruler. It allows you to change the labeling 
used, as well as various level zooming operations.

Zoom Out Full 
Zoom Level|Window 
Zoom Level|Selection 
Label in Percent 
Label in dB 
                                                         
See also
Shortcut Menus



Level Ruler|Label in Percent
When checked, the Level Ruler will be labeled in percent.

                                                         
See also
Level Ruler Shortcut Menu 



Level Ruler|Label in dB
When checked, the Level Ruler will be labeled in decibels.

                                                         
See also
Level Ruler Shortcut Menu 



Marker Tag Shortcut Menu
This shortcut menu is reached by right-clicking on a marker tag in the ruler.

Go To 
Delete 
Edit 
Update 
                                                         
See also
Shortcut Menus



Go To Marker
Choose this option to move the cursor to the marker's position.



Delete Marker
Choose this option to delete the current marker.



Edit Marker
Use the Edit Region/Marker dialog to change the name, type, or location of the marker.



Update Marker
If you've made changes to the file, choose this option to update the marker.



Status Bar Shortcut Menus
These shortcut menus allow you to change the playback rate, sample size, channels (Stereo/Mono), and 
status format by right-clicking on the status bar fields.

Sample Rate 
8-Bit 
16-Bit 
Mono 
Stereo 
Status 
                                                         
See also
Shortcut Menus



Status Bar|Sample Rate
Use this shortcut menu to select the playback rate of the current sound file, such as 32,000. Note that if 
you do not Resample the data, the pitch will change also. To resample, choose Resample from the 
Process menu. 

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Status
Use this shortcut menu to select the time or sample status format used.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|8-Bit
Use this shortcut menu to change the bits per sample of a sound file to 8.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|16-Bit
Use this shortcut menu to change the bits per sample of a sound file to 16.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Mono
Use this shortcut menu to make the sound file contain only one channel.

                                                         
See also
Status Bar Shortcut Menu 



Status Bar|Stereo
Use this shortcut menu to make the sound file contain two channels.

                                                         
See also
Status Bar Shortcut Menu 



Record Dialog Shortcut Menu
This shortcut menu is reached by right-clicking anywhere in the Record window. The Remote Record 
shortcut menu is similar, with options not available in the dialog available from the menu.

Reset clip 
Resolution 
Show Labels 
Hold Peaks 
Hold Valleys 
Review Pre/Post Roll 
Go to 
Selection 
Window 
New Window 
Aggressive Update 
                                                         
See also
Shortcut Menus



Record Meters|Reset Clip
This function resets the clip indication on the Record Meters. After a clip occurs, the clip indication will 
remain lit until the Reset Clip function is invoked. You can also click on the clip light or levels to clear it.

                                                         
See also
Options Menu



Record Meters|Resolution
These settings display the minimum and maximum readings for the Record Meters. Changing the 
resolution of the meters is helpful for metering sound files of varying dynamism.

-90 to 0 dB 
-78 to 0 dB 
-60 to 0 dB 
-42 to 0 dB 
-24 to 0 dB 
                                                         
See also
Shortcut Menus



Record Meters|-90 to 0 dB
Determines the bottom-most level that will be displayed. A value of -90 dB is the absolute minimum peak 
value in 16-bit audio, corresponding to a sample value of +/- 1.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-78 to 0 dB
Determines the bottom-most level that will be displayed. A value of -78 dB (0.012%) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-60 to 0 dB
Determines the bottom-most level that will be displayed. A value of -60 dB (0.1 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-42 to 0 dB
Determines the bottom-most level that will be displayed. A value of -42 dB (0.8 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|-24 to 0 dB
Determines the bottom-most level that will be displayed. A value of -24 dB (0.6 %) will be the smallest 
value displayed.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Show Labels
This option turns on or off the markings on the Record Meters.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Record Meters|Hold Valleys
This option turns on or off the markings to indicate the lowest peaks in the sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Blinking Status
Enables the blinking record status underneath the record meters.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Review Pre/Post Roll
Enables or disables Pre-Roll and Post-Roll on playback.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Go to
Takes you to the Go To dialog, which allows you to set a Record start time.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Selection
Takes you to the Selection dialog, which allows you to set a Record start and end time.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Window
Takes you to the Record Window dialog, which allows you to set a new Data Window to record to.

                                                         
See also
Record Dialog Shortcut Menu 



Record|New Window
Sets Record to write data to a new sound file.

                                                         
See also
Record Dialog Shortcut Menu 



Record|Aggressive Update
When enabled, the Record meters will respond much more rapidly to incoming audio. However, with 
some sound cards, this can lead in some cases to peaks not being detected. If you want complete 
security that your recording never reached 0 dB, turn this off.

                                                         
See also
Record Dialog Shortcut Menu 



Summary Information Picture Shortcut Menu
This shortcut menu is reached by right clicking on the picture area in File|Properties|Summary 
Information. It allows for copy, paste, and clear operations on the image.

                                                         
See also
Shortcut Menus



Summary Information|Copy
Use this to copy the current summary information image onto the clipboard.

                                                         
See also
Summary Information Shortcut Menu 



Summary Information|Paste
Use this to embed a picture in a sound file by pasting a bitmap, cursor, or icon from the clipboard.

                                                         
See also
Summary Information Shortcut Menu 



Summary Information|Clear
Use this to delete a picture from a sound file's embedded summary information.

                                                         
See also
Summary Information Shortcut Menu 



Video Strip Shortcut Menu
This shortcut menu is reached by right-clicking on the video strip above the waveform display.

Video Strip|Copy 
Video Strip|Go To 
Video Strip|Animate 
Video Strip|Number Frames 
                                                         
See also
Shortcut Menus



Video Strip|Copy
Copies the selected frame as a bitmap to the clipboard. You could, for example, then paste it into the 
Summary information folder (Properties in the File menu) by right-clicking over the shot you want to copy.

                                                         
See also
Video Strip Shortcut Menu 



Video Strip|Go To
Moves the cursor to the beginning of the frame.

                                                         
See also
Video Strip Shortcut Menu 



Video Strip|Animate
Displays the frame closest to the current cursor position during editing and playback instead of a static 
overview frame.

                                                         
See also
Video Strip Shortcut Menu 



Video Strip|Number Frames
Displays frame number on each frame.

                                                         
See also
Video Strip Shortcut Menu 



Edit Tool Selector Shortcut Menu
This shortcut menu is reached by right clicking on the Edit Tool Selector. The Edit Tool Selector is the icon
on the upper left side of the data window which allows you to switch between the Edit and Magnify tools.

The Edit Tool Selector shortcut menu allows you to enable and disable various parts of the Data Window, 
such as scroll bars and rulers.

                                                         
See also
Shortcut Menus



Edit Tool Selector|Status
Use this to show or hide the Playbar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Time Ruler
Use this to show or hide the Time Ruler in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Time Zoom
Use this to show or hide the Time Zoom spinner in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Overview
Use this to show or hide the Overview bar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Video
Use this to show or hide the Video Strip in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Level Ruler
Use this to show or hide the Level Ruler in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Level Zoom
Use this to show or hide the Level Zoom spinner in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Scrollbar
Use this to show or hide the Scrollbar in the current data window.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Edit Tool Selector|Data Window Only
When this is checked, only the Waveform Display will be shown in the selected data window. All other 
controls such as rulers and scrollbars will be hidden.

                                                         
See also
Edit Tool Selector Shortcut Menu 



Mouse Shortcuts
Select All 
Zoom Both Time and Level 
Magnify Mode 
Return Control Value to Default 
Main Status Bar 
Selection Status Bar 
Play Normal Button 
Slow and Fast Selection Scroll Toggle 
Ruler scrolling speed control 

                                                         
See also
Shortcuts



Select All
Double-click on the waveform display to select the entire sound file. 

                                                         
See also
Other Mouse Shortcuts 



Zoom Both Time and Level
Double-click on the Level Ruler to zoom the current selection both vertically and horizontally. If no 
selection exists, the entire waveform display data is zoomed. Double-click again to Zoom Out Full 
vertically and Zoom Normal horizontally.

                                                         
See also
Other Mouse Shortcuts 



Magnify Mode
To zoom in to a section, select an area while holding the Control key. This will switch Sound Forge XP to 
Magnify mode, which zooms to fit the selected area.

                                                         
See also
Other Mouse Shortcuts 



Return Control Value to Default
Double-click on a trackbar, fader, or spinner to set it to its default value.



Main Status Bar
Double-click on the Sample Rate, Sample Size, or Channels (Stereo/Mono) field to reach the Properties 
dialog. 

                                                         
See also
Other Mouse Shortcuts 



Selection Status Bar
Double-click on the left-most field to reach the Go To dialog. Double-click on the other two fields to reach 
the Set Selection dialog.

                                                         
See also
Other Mouse Shortcuts 



Play Normal Button
Press Control-click to Preview Cut (skip selection) on playback. Press Control+shift-click to play to cursor 
with pre-roll.

                                                         
See also
Other Mouse Shortcuts 



Slow and Fast Selection Scroll Toggle
When making a selection past the end or beginning of the waveform display, hold down the left mouse 
button and click the right mouse button to toggle between fast scrolling and slow scrolling.

                                                         
See also
Other Mouse Shortcuts 



Ruler scrolling speed control
When dragging the Time Ruler for horizontal scrolling, once you move the mouse outside of the data 
window, the further you move the mouse, the faster the scrolling occurs. The speed can also be controlled
by moving the mouse up and down while scrolling.
                                                         
See also
Other Mouse Shortcuts 



Sound Forge XP for 32 Bit Windows
This section discusses details specific to the 32 Bit version of Sound Forge XP 4.0.

Sound Forge XP for 32 Bit Windows is a true 32 Bit flat model digital sound editor available for the PC. 
The performance differences from a 16 Bit sound editor are amazing. Processing is often 2 to 3 times 
faster with the 32 Bit version of Sound Forge XP.

Sound Forge XP for 32 Bit Windows has been designed to run on the following platforms:

Ÿ Microsoft Windows 95.

Ÿ Microsoft Windows NT 3.5 or later. Alpha AXP, and x86 processors are supported.

When running Sound Forge XP for 32 Bit Windows on the Windows NT operating system, some 
limitations may be present. These limitations result from a lack of compatible hardware and software 
available for 32 Bit Windows or are a direct result of the Windows NT Operating System implementation. 
These limitations are summarized below.

Limitations under Microsoft Windows NT
The following is a list of limitations of Sound Forge XP for 32 Bit Windows when running under Windows 
NT:

Ÿ Not all sound cards have drivers available for Windows NT. Contact your manufacturer for availability 
of Windows NT drivers.



What's new in version 4.0
Below are just a few of the new features in Sound Forge XP 4.0. This is not a comprehensive list of 
changes but simply a few of the key features that you might want to check out. Many of these new 
features are ones that our users have requested. Keep those suggestions coming!

General Features
Direct Mode editing
You can now perform edits directly on the original file, meaning that file opens and saves are almost 
instantaneous. In previous versions of Sound Forge XP, a backup of the file being opened was always 
created. For very large files, creating a backup could take more than a few minutes. The downside of 
working directly on a file is that the original data is immediately changed whenever you make an edit. This
is why it's so nice to have multiple undo buffers. To work on a file directly, check the "Operate directly on 
the sound file" option while opening a file in the File Open dialog. If you don't want to work directly on 
files, simply leave the option unchecked.

Multi-level undo/redo
There is now no limit to the number of undo operations available. Use the Undo and Redo options in the 
Edit menu to restore the sound file to any edited stage. The Undo/Redo History option (Special menu) 
makes it easy to select from all the previously existing states.

AVI file support
To open a Video for Windows AVI file, select AVI as the file type from the File Open dialog. The video 
frames will be shown on top of the Waveform Display in the Video Strip. To view the video during 
playback, open the Video Preview window (View Menu).

Super fast screen redraws
Need we say more?

Level Zoom (vertical) and scrolling ruler
The Level Ruler on the left hand side of the Waveform Display is useful for estimating sample values in 
percentage or decibels. It is especially useful now that you can zoom and scroll vertically for viewing very 
low level signals. To zoom in vertically, use the Level Zoom spinner on the lower left hand corner of the 
Data Window or hit the Shift-Up Arrow or Shift-Down Arrow keys. Once you're zoomed in, dragging the 
Level Ruler allows you to view different ranges. Double-clicking on the Level Ruler centers the 0 axis.

Drag and Drop Mix/Paste shows destination position
When you drag from one sound file to another, a cursor and region now appear on the destination file that
show where data will be mixed or crossfaded. Remember, hold down the Alt key for pasting, otherwise a 
Mix will occur. You can also click with the right mouse button during dragging to quickly switch between 
modes.

Audio event locator
This feature allows you to find audio events by clicking and dragging the mouse on the Overview (the thin 
strip above the Time Ruler). Similar to a scrub, playback follows mouse movement across the Overview 
and loops when the mouse is still. Releasing the mouse stops playback and centers the cursor on the last
start position in the Waveform Display.

Internet Audio Support (Java, RealMedia, and Active Streaming Format)
Sound Forge XP 4.0 now supports many common Internet audio (and video) file formats. We've added 
Progressive Networks' RealMedia support and the new Active Streaming Format  (ASF) used by 
Microsoft's NetShow On-Demand. ASF files are designed for both audio and video streaming over the 
Internet. In addition, support has been added for the NeXT/Sun .au format for working with Java scripts.

Send Mail and OLE Drag and Drop



To send a sound file via email to somebody, select Send from the File menu. Dragging a file outside of the
Sound Forge XP workspace creates a true OLE object which can be embedded on any OLE container 
(such as Wordpad). To do so, you must drag from the OLE button in the lower right corner of the Data 
Window.

Effects/Processing/Tools
Smooth/Enhance
Quickly add or remove high frequency content.

DTMF dial tone generator
Generate touch-tone triggers in Sound Forge XP.

Graphic     EQ  
It's faster and more accurate.

Chorus and Flange 
Improvements have been made to apply smoother pitch modulation.

Time Compress/Expand 
Enhanced Algorithms allow you to stretch and squish farther than before without artifacts.

Record
New Meters
Higher accuracy meters allow for finer adjustment of input levels.

Markers and Regions

XP now allows Markers and Regions!
Markers and Regions allow for quick editing and navigation and aid in authoring interactive internet 
content through RealMedia and Microsoft NetShow.

Markers to Regions function
The Markers to Regions function converts all markers in a file to consecutive regions. This is handy after 
dropping makers while recording or during playback.

Snap to markers and regions when using drag and drop
When doing drag and drop mix, crossfade, or pasting, if the cursor is near a marker or region in the 
destination file it will "snap" to it. You can also snap to major ticks on the time ruler as well as to a specific 
frame in the Video Strip.

Markers and Regions annotations
The name of markers and regions can be displayed right on the Waveform Display.

Miscellaneous Marker and Region List functions
Markers and Regions are now stored in the clipboard for when you Copy, Mix, or Create New.

Double-clicking on the Waveform Display selects from previous to next marker or region.

Shift+double-click a marker to move the marker to the current cursor position.

Ctrl-Left or Ctrl-Right keys jump to the next marker or region if they exist.

Typing 'R' will create a region for the current selection.



Regions are now named after the start and end position of the region rather than order of creation.

And more...
Ÿ You can now drag-scroll the Waveform Display by dragging on the ruler. Drag speed is determined by

how far the mouse is moved beyond the end of the window horizontally or vertically.

Ÿ You can drag selection edges with the mouse.

Ÿ When playing in Looped Mode, playback always follows selection and cursor changes. 

Ÿ Support for the InterVoice file format for telephony applications.

Ÿ Envelope controls now multi-point editing as well as the ability to display the sound data in the 
envelope control.

Ÿ A free disk space display has been added to the status bar. You can turn this on or off in the 
Preferences section.

Ÿ We now use the Windows 95 Explorer common dialogs for open and save. We've also added the 
ability to auto play files in the Open dialog.

Ÿ Many new preference options have been added to allow you to customize the way you work.



Help Menu
Contents
Takes you to the on-line help table of contents. Shortcut: F1
Search for Help On
Use this to find help on a particular topic with the on-line help.
Keyboard Shortcuts
Displays a list of shortcuts – and Sound Forge XP is loaded with them.
Troubleshooting
Use this before calling the Tech Support line.
Tip of the Day
Displays a new Sound Forge XP tip.
The Sonic Foundry Home Page
Takes you to our little plot in cyberspace.
About Sound Forge XP
Use this to display pleasantly puzzling information about Sound Forge XP, such as the software license 
owner, copyright and system information, program version and serial number, and the cool Sound Forge 
XP logo.



Tip of the Day
This command will bring up the Tip of the Day pages in the help file. These are helpful and handy tips to 
increase your productivity with Sound Forge XP.



The Sonic Foundry Home Page
This is a direct link to our home page on the World Wide Web. Invoking this command automatically 
launches your default web browser and takes you to the Sonic Foundry Home Page 
(http://www.sonicfoundry.com). Here you will find downloadable demos and updates, technical 
information, and news of what's new with the folks here at Sonic Foundry.

You can also send us comments, suggestions, questions, sound files, gossip, whatever…via email from 
our web page (or direct to our development team at feedback@sonicfoundry.com). We'd love to hear how
Sound Forge XP is being used and your thoughts on how it can be improved.



Search for Help on
Use this to find on-line information on a particular topic.
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Sound Forge XP Main Screen Basics
This section will show you around the Sound Forge XP screen and teach you the most basic operations. 
We will cover:

Using the Mouse 
The Main Screen 
Toolbars 
The Data Window 
ToolTips 
Getting On-line Help 



Using the Mouse
Although using the mouse in Sound Forge XP is not required, it will make your editing sessions easier. 
Once you become familiar with Sound Forge XP you will probably want to use some of the built-in 
shortcuts provided by the mouse and the keyboard. The following list of terms will help you when reading 
the manual.

Pointing Moving the mouse pointer over an item is called pointing.

Clicking Pointing to an item and quickly pressing and releasing the left or right mouse button 
is called clicking. The documentation lets you know whether you need to right-click 
or left-click on an item to execute a specific function. When there is no specification, 
assume we mean left-clicking. Right-clicking is often used to reach Shortcut Menus.

Double-clicking Double-clicking means clicking twice in quick succession. Double-clicking always 
indicates clicking twice with the left mouse button.

Triple-clicking Triple-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it three times in quick succession. Triple-clicking always 
indicates clicking three times with the left mouse button. In Sound Forge, a triple-
click in the data window selects all data.

Toggle-clicking Toggle-clicking means clicking the right mouse button while holding the left mouse 
button to cycle through various options. This is a great shortcut for procedures such 
as drag-and-drop and changing the Magnify Tool mode of operation.

Shift-clicking Shift-clicking is holding down the Shift key on the keyboard while clicking the mouse.
Shift-clicking is used mainly to skip dialogs so that you can quickly repeat 
operations.

Control-clicking Control-clicking is holding down the Control key on the keyboard while clicking the 
mouse. Control-click to modify the operation of a normal click.

Dragging Holding down the mouse button while you move the mouse pointer is known as 
dragging. Drag to quickly move sections of data between separate windows and to 
move trackbars, scrollbars, faders.

Slow-dragging Holding down both the right and left mouse buttons while moving trackbars and 
faders increases the resolution of the movement. This is especially useful when 
making fractional adjustments to parameters in a dialog box.

Dropping After dragging an item, releasing the mouse button on top of another area is known 
as dropping.



The Main Screen
When you start Sound Forge XP, you see the main screen, or workspace, where you will do all your 
editing. When you first open Sound Forge XP, no Data Windows are open and you will need to either 
open an existing sound file or create a new one. See Opening an Existing File and Creating a New 
Window for more information. 

Click an area of the screen illustrated below for a description.



Program Title Bar
Shows the program name and the name of the currently active data window (if the data window is 
maximized within the workspace).



Data Window
Each opened sound file has its own data window. Data windows can be arranged, resized, or minimized.



Menu Bar
Shows the menu headings for the available functions. When no data windows are open, the Process, 
Effects, and Tools menus are not listed because these contain functions which require an open data 
window.



Status Bar
On the left, help and processing information is displayed. The fields on the right show the playback 
sample rate, sample size, mono/stereo, total length of the active data window, and the total free storage 
space. These fields can be edited by double-clicking or right-clicking on them (except for the free storage 
space, of course). When no data windows are open, the fields are blank.



Sound Forge XP Workspace
This is the background area behind the data windows. You can drag sections here to create new data 
windows.



Toolbars
You can use three toolbars in Sound Forge XP: the Standard, Transport, and Status toolbars. The 
toolbars contain buttons which are used to quickly execute commands.

Standard Provides quick access to many commonly used Sound Forge XP File and Edit menu
options.

Transport Provides the audio transport buttons: Record, Play All, Play Normal, Pause, Stop, 
Go to Start, Rewind, Forward, and Go to End.

Status Contains operations to set the display Status Format as well as the Snap To 
operations.

You can drag and drop these toolbars anywhere on the screen, resize them, and remove them. When you
drag a toolbar to any side of the main window, it docks, or attaches to the side. If you drag a toolbar away 
from a side, it becomes a floating toolbar. To hide a floating toolbar, click its Close button.

A list of available toolbars can be displayed by selecting the Preferences command under the Options 
menu and looking in the Toolbars folder (or choose Toolbars from the View menu). To show a toolbar, just 
check the box next to the toolbar you wish to use and then select OK. The number of open toolbars and 
their position on the screen is entirely up to you.



The Data Window
Data Windows are the windows which contain sound data files. These windows contain a number of sub 
windows and controls which you will use in editing and viewing your sound data. Many parts of the Data 
Window lead to Shortcut Menus, dialogs, and other operations.

Click an area of the Data Window to see a description.



Title Bar
Shows the file name or, if present, the title stored in the Summary information of .WAV files. Double-click 
to maximize and restore the window.



Level Ruler
Shows the amplitude of the waveform. Right-click to reach the Level Ruler shortcut menu. Drag to shift 
the view up or down when zoomed in vertically.



Time Ruler
Shows the current location in the data window as well as ruler tags. Right-click to reach the Time Ruler 
shortcut menu. Drag to scroll the data window.



Edit Tool Selector
Use this button to toggle between the Edit, Magnify, and Pencil Tools. Note: The Pencil Tool requires that 
the zoom ratio be between 1:1 and 1:16.



Playbar
On the left side of the playbar are the following audio transport buttons: Go to Start, Go to End, Stop, Play
Normal, and Play Looped. To the right are the playbar's selection status fields.



Selection Status Fields
Show the beginning, end, and length of a selection. If no selection has been made, only the cursor 
position (also known as the insertion point) is displayed. Double-click on the left-most field to reach the 
Go To dialog. Double-click on either of the other two fields to reach the Set Selection dialog. Right-click to
reach the Status Format shortcut menu.



Waveform Display
Shows a graphical representation of the sound file. The horizontal axis represents time (marked in the 
Time Ruler) and the vertical axis represents amplitude (marked in the Level Ruler). Right-click anywhere 
on the waveform display to reach the Waveform Display shortcut menu.



Position Scroll Bar
Use this to scroll the sound file forward and backward in time to see parts of the file not currently visible in
the waveform display.



Overview
Allows for quick navigation and playback of any part of the file. Overview also shows the fraction of the 
waveform being shown on the waveform display, as well as the selected region. Left-click to move the 
cursor. Double-click to center the cursor in the waveform display. Right-click to start playback or pause.



Time Zoom Resolution
(Also called Zoom Ratio) Specifies the number of samples of data represented by each point on the 
screen horizontally. This determines the length of time which is shown in the waveform display. With a 
small resolution value (1:1, 1:2, 1:4, ...), a shorter length of time is displayed.



Time Zoom In/Out
Use this to change the zoom resolution for the time axis. Between these buttons is a spinner that allows 
you to continuously change the time zoom resolution.



Level Zoom In/Out
Use this to change the zoom resolution for the level (vertical) axis. Between these buttons is a spinner 
that allows you to continuously change the level zoom resolution.



Maximize Width
Pressing this button stretches the width of the data window to fit within the Sound Forge XP workspace.



OLE Drag Source
Drag from this section of the data window into another application such as Microsoft Word, to link the 
sound file to other documents.



ToolTips
If you keep the mouse over a toolbar button or status bar field for more than one second, you will notice a 
small box appear next to the mouse pointer containing some text. This text is a quick description of the 
function of the button or field. Using ToolTips is an easy way to learn your way around the Sound Forge 
XP screen. If you wish, you can disable this function by selecting Toolbars under the View menu and un-
checking Show ToolTips.

When you press and hold a button in a toolbar or select a menu item, you will see a one line description 
of the command in the left side of the status bar. This gives you a little more descriptive information about 
the function of a button. If you release the mouse button outside of a toolbar or menu item, the toolbar 
command will not be performed.



Getting On-line Help
On-line help is available in a variety of ways. You can:

Ÿ Go straight to the Help table of contents by selecting Contents under the Help menu, or pressing 
F1. Once there, you can search for your help topic and also get information on using the on-line 
help.

Ÿ Press the Help button or the F1 function key in a dialog. This will take you straight to the help 
information on the dialog. 

Ÿ Press the F1 function key while selecting a menu item to get information on the command.
You will find that on-line help is extremely useful as a quick reference guide. Since many topics are cross 
linked, its easy to navigate through all of the help material available on a topic. Once you have become 
familiar with using Sound Forge XP, you'll probably never have to refer to this manual to find information. 
All you'll need is the on-line help.



Data Window Basics
With Sound Forge XP, you can have multiple sound data files open simultaneously on the screen. Each 
file has its own corresponding Data Window which shows you a graphical representation of the waveform 
and other information about the file. This section covers the following topics:

Opening an Existing File 
Playing a File 
Playing a Section 
Using the Transport vs. the Data Window Playbar 
Creating a New Window 
Active Windows vs. Inactive Windows 
Copying Data to a New File 
Saving a File 



Opening an Existing File
To open an existing sound file, do the following:

1. Select the Open command from the File menu. Sound Forge XP displays the Open dialog.
2. Use the Open dialog to select and open a file. You can preview .WAV files by pressing the Play 

button in the Open dialog. Press the Stop button to stop the playback. You can also have the files 
play when selected by checking the Auto play box.

You can use the Files of type list to select different types of data files. If Sound Forge XP recognizes the 
type of a file when it is highlighted in the files list, it will display its information in the bottom half of the 
dialog. 

Open the file TUTOR1.WAV now. This file is located in the directory where you installed Sound Forge XP.

You will now see the data window containing TUTOR1.WAV. This file is a recording of someone saying 
"Wow, sound editing just gets easier and easier."

Notice how even though the file name is TUTOR1.WAV the name of the data window is "Wow, sound 
editing..." This is because we have stored a title for the file within the .WAV file itself. Sound Forge XP 
allows you to embed descriptive titles as well as copyright information and other text fields for any .WAV 
file.

Sound files in Sound Forge XP can have a title that is different from the file name. To edit
the title, use the Summary page of the Properties command dialog (File menu). You can

quickly get to the Summary dialog by pressing Alt+Enter.



Playing a File
Once you have opened a file, you can hear it by clicking on the Play All button on the Transport toolbar.

While the file is playing, a pointer will move along the data window showing the current position. You will 
also see the current position in the first selection status field in the playbar.

Play the TUTOR1 file now. You will hear the words "Wow, sound editing just gets easier and easier."

You can play from any point in the window by simply moving the cursor. Move your mouse pointer to the 
silence section right after the "Wow" portion of the file. Left-click (don't drag, we don't want a selection 
yet), and you will see the flashing cursor in the silence area after the word "Wow." Click the Play button on
the Transport toolbar and now you will only hear the "sound editing just gets easier and easier" part. 

If you don't hear anything you may have made a small selection by accidentally dragging the mouse. To 
tell if you've made a selection just look at the three right hand status fields in the data window status bar. 
If only the first one is filled, then you don't have a selection. If they all have values then you need simply 
click in the data window again to clear the selection.



Playing a Section
You can also play portions of the sound data by making a selection on the waveform display with the 
mouse. To do this, click and drag the left mouse button starting at the section of silence prior to "Wow." 
Drag the mouse until you are in the portion after the "Wow." Notice that as you drag the data, the 
background appears in another color. Let the mouse button up and you will now have a highlighted 
section of data. Again click the Play button. You should now hear just the "Wow" portion of the file.

While making a selection, and after selecting, you will notice that the three selection status fields on the 
right side of the playbar have values. These values show you the start (Selection Left), end (Selection 
Right), and length (Selection Length) of the selection you have made. When no selection has been made,
the cursor position (also called the insertion point) is shown.

Let's clear the selection and put the cursor back at the start of the file. To do this click on the Go to Start 
button in the Transport toolbar (the fourth button from the right).



Using the Transport versus the Data Window Playbar
There are a number of ways to play your sound files within Sound Forge XP. The most common method 
is to use one of the Play buttons located either on the Transport toolbar or the playbar in the data window.
Let's take a look at both of them.

The Data Window Playbar

Click a button to see a description.

Whenever you play a file from the playbar, you will notice a small line that appears underneath the play 
arrow in the corresponding Play button. This is the current play mode which will be used whenever you 
select the Play button in the Transport toolbar (or hit the Spacebar). Play Normal is the current play mode 
in the playbar graphic shown above.

To change the current play mode, press the corresponding playbar button or use Control+Spacebar.

The Transport Toolbar

Click a button on the Transport toolbar to see a description.



Play Normal
Plays the currently selected section of data. If there is no selection, pressing the Play Normal button plays
from the current cursor position to the end of the file.



Play Looped
Plays the currently selected data in a loop: from beginning to end, then to the beginning again.



Record
Brings up the Record dialog which allows you to record to either a new or existing window. 

Shortcut: Control+R



Play All
Plays the entire sound file from beginning to end. This allows you to hear the entire sound even if you 
have a selection or the cursor positioned somewhere other than the start of the data. 

Shortcut: Shift+Spacebar



Play
Plays the file using the current play mode. To set the play mode select one of the play buttons on the 
playbar as described above. The last button used becomes the active play mode. 

Shortcut: Spacebar



Pause
Works like the Stop button in that it stops play of the current file. However when selecting Pause the 
cursor is placed at the current play position rather than back to where it was when play was selected. 

Shortcut: Enter during playback.



Stop
Stops play and positions the cursor back to where it was prior to selecting play. 

Shortcut: Spacebar during playback



Go to Start
Places the cursor at the beginning of the sound file. 

Shortcut: Control+Home



Rewind
Shuttles the cursor backward in the sound file. 

Shortcut: Control+Left Arrow



Forward
Shuttles the cursor forward in the sound file. 

Shortcut: Control+Right Arrow



Go to End
Places the cursor at the end of the sound file. 

Shortcut: Control+End



Creating a New Window

1. Select the New command from the File menu. Sound Forge XP displays the New Window dialog.

2. Select the new data format in the dialog.

If you're working with the TUTOR1 file, you can create a new window that has the same data format as 
TUTOR1. In the New Window dialog set the Sample size to 16-bit, the Channels to Mono, and the 
Sample rate to 44,100. When you click the OK button a new window will appear titled Sound2. This is an 
empty data window into which we are going to place data from TUTOR1.



Active Windows vs. Inactive Windows
When you have multiple windows on the screen, only one window is considered the active window. This is
the window on which you are currently working. Any operations you perform will only affect this window.

To make a window the active window click anywhere on the window with the left mouse button. The 
window's title bar will change to the color you have defined as the active window color in Control Panel in 
Windows.



Copying Data to a New File
If you're working with TUTOR1, make "Wow, sound editing..." the active window by clicking on its title bar. 
If you don't still have the word "Wow" selected, select it again. From the Edit menu, select the Copy 
command. This will copy the sound data for "Wow" onto the clipboard.

Now make Sound2 the active window by clicking on its title bar (if the title bar is covered by another 
window, you can always use the Window menu to activate a data window). Select the Paste command 
from the Edit menu and the "Wow" data will appear in the Sound2 window. If you press the Play button, 
you can hear how our new file sounds with just the word "Wow."



Saving a File
To save a data window, you first need to make it the active window. For this example, make sure the 
Sound2 window is active.

1. Select the Save command from the File menu. Since the Sound2 window is a new file, Sound 
Forge XP displays the Save As dialog. If the file had been opened or previously saved by Sound 
Forge XP the file would be saved immediately.

2. Type a file name into the File name field in the Save As dialog and select the OK button. Let's save 
the new sound file, Sound2, as MYFIRST – Sound Forge XP will add the file extension, .WAV, 
automatically.

The Save As dialog also allows you to change file types, data format, and set summary information fields. 
This is covered in a later section.



Simple Editing and Navigation
This section shows you the basic editing operations of Sound Forge XP.

Common Edit Operations 
Making a selection 
Copy, Paste, Cut, Undo, Redo 
Cropping 
Mixing 
Status Formats 
Magnification and Zooming 



Common Edit Operations
You can find the most common editing options on the Edit menu and the Standard toolbar. Most of these 
options use the Clipboard, which is a temporary storage area which can also be used to move data from 
one window to another. The following list provides a brief description of each operation:

Cut Deletes a selected portion of data and copies it on to the Clipboard.

Copy Copies a selected portion of data on to the Clipboard.

Clear Deletes a selected portion of data but doesn't copy it on to the Clipboard.

Trim/Crop Deletes all data in a window except the selected section.

Paste Inserts the contents of the Clipboard into a Data Window at the current cursor 
position.

Mix Mixes the contents of the Clipboard with the current data in a window starting at the 
current cursor position.

Crossfade Crossfades the contents of the clipboard with the current data in a window starting 
at the current cursor position.

To show how these operations are used, we can use the TUTOR1.WAV file. If it is not currently open 
please open the file now. (See Opening an Existing File for instructions.)



Making a Selection

1. If TUTOR1 is not the active window, activate it by clicking on its title bar. 

2. To make a selection, you must first make sure that you are using the Edit Tool. To get to the Edit 
Tool, look under the Edit menu for the Tool item (it should already be checked) and select Edit. 

3. Select the word "Wow" with the mouse by clicking and dragging. You can verify you have the right 
section of data by pressing the Play button to hear it.



Copy, Paste, Cut, Undo, and Redo

Copying Data to the Clipboard
Once you have a selection, you can use the Copy command from the Edit menu. This will copy the 
selected data onto the clipboard. You will see no change since the Copy command does not change the 
data, it only copies it to the clipboard.

Pasting Data from the Clipboard
Now move the cursor to the beginning of the file by selecting the Go to Start button on the playbar. To 
insert the contents of the clipboard into the file, use the Paste command from the Edit menu. You should 
now see the data for the word "Wow" appear at the beginning of the window. Press the Play button just to 
make sure. You should hear "Wow Wow Sound editing just gets easier and easier."

You have just made your first edit in Sound Forge XP!

Pasting Data to Another Window
Data on the clipboard remains there until it is replaced by another operation which places data onto the 
clipboard. Therefore, you can continue pasting the data anywhere you want.

To demonstrate this, create a new window as described in the previous section by selecting the New 
option from the File menu. Now, select the Paste command from the Edit menu once more. You should 
now have a new data window with the data for the word "Wow." You can also do this by selecting the 
Paste to New function in the Paste Special item of the Edit menu. This creates a new window and fills it 
with the clipboard contents in one easy step.

Cutting Data
To cut data, first you need to select a section of data you want to cut. Select one of the "Wow" words (you 
should have two if you have been following the examples) from TUTOR1.

Now select the Cut command from the Edit menu. This will remove the selected data and place it on to 
the clipboard.

Undoing an Edit Operation
After any edit operation you can cancel it by selecting the Undo command from the Edit menu.

Let's undo the cut we just made. Select Undo Cut from the Edit menu and you will see the original two 
"Wow" words in the TUTOR1 window.

Redoing an Edit Operation
If you change your mind again and decide you really liked an edit you undid, simply select Redo from the 
Edit menu. Doing this re-performs the edit operation you last undid. In this case selecting Redo would re-
cut the second "Wow" from the TUTOR1 window. 

Let's redo the cut. Select Redo Cut from the Edit menu and you will see the second "Wow" has been cut 
from the file again.

The Undo/Redo History window (View menu) also allows you to restore your sound file to
previous states by undoing or redoing operations. For more information, see the



Reference section.



Trimming edges (crop)
Trim (also called Crop) allows you to single out a section of data and cut everything else out of the 
window except that section. This is a handy feature since you can keep using the Play button to hear 
selections until you have just the right amount and then get rid of everything else with the Trim/Crop 
command in the Edit menu.

1. By now you should be getting used to selecting data on the screen, so select the "Wow, sound 
editing just gets easier" section in the TUTOR1 window, but don't select the second "easier." 
Remember you can use the Play button to hear how the selection sounds at any time.

2. Once you have the selection, select Trim/Crop from the Edit menu or the Standard toolbar. After 
cropping you will have only "Wow, sound editing just gets easier" left in the window. 

3. At this point let's close the "Wow, sound editing..." window. Either click the close box of the 
TUTOR1 window, or select the Close command from the File menu. You will be asked whether you 
want to save the changes you have made to TUTOR1. Select the No button since we don't want to 
keep the changes we made to TUTOR1.

4. Also close any other windows you may have open, like MYFIRST.WAV.



Mixing
Mixing is a powerful and useful edit operation which you will use often. Mixing allows you to combine two 
sounds into one window so you can create complex sound effects.

1. This time we are going to open two files, TUTOR1.WAV and TUTOR2.WAV. Open them now as 
we've shown you in the previous sections.
TUTOR2 is a file which contains the sound of a snare drum. We are going to mix this sound with 
TUTOR1; the "Wow, sound editing..." window.

2. Before we begin mixing, let's make sure the Status Format is set to Time to make finding the mixing
points a little easier. To do this select the item Time from Status Format under the Options menu. 
You will need to do this for both data windows since Sound Forge XP keeps track of the format type
for each individual window.

3. To make the windows easier to view during the mix operations you may want to maximize Sound 
Forge XP by clicking the Maximize Window button in the upper right corner and selecting the Tile 
Vertically item from the Window menu. This will arrange the windows vertically – fully utilizing the 
Sound Forge XP workspace – and make things easier to see.

4. If you activate each of the TUTOR windows you will notice that the length of TUTOR1 is 5.0 
seconds long and TUTOR2 is 3.0 seconds long. For this example, we want the drum hit to occur 
just before the "Wow." We could just copy the drum hit sound on to the clipboard and then paste it 
before the "Wow", but this would increase the length of TUTOR1 to 8.0 seconds. So instead we'll 
use the Mix command.

5. Select all the data in Drum Hit by making it the active window and then double-clicking in the 
waveform display with your left mouse button (you could also use the Select All command under the
Edit menu). Now copy the data onto the clipboard by selecting the Copy command from the Edit 
menu.

6. Make TUTOR1 the active window and then select the Go to Start button on the playbar. This will put
the cursor at the beginning of TUTOR1. 

7. Select the Mix command from the Paste Special option in the Edit menu or the Standard toolbar.
The Mix dialog now appears. Keep both levels at 0 dB and select OK.

8. You will see that the drum hit sound has been mixed into the TUTOR1 window and the length of 
TUTOR1 is still 5.0 seconds. Press the Play button to hear the results.

9. Select the Undo Mix command from the Edit menu to put TUTOR1 back to its original state. 
10. Now let's mix the drum hit sound closer to the "Wow" portion of TUTOR1. The "Wow" occurs at 

about 0.8 seconds into TUTOR1, so move your cursor in the TUTOR1 window to approximately 0.8 
seconds. You do this by clicking with the left mouse button in the data window of TUTOR1 and 
watching the cursor position status field on the status bar (the left most field). You don't have to be 
exact. Once you've positioned the cursor, select the Mix command again and then choose Play for 
the result. Notice how the drum hit sound and the "Wow" sound overlap each other.



Status Formats
To set files to different formats, right-click the Time Ruler and selection status fields on the playbar. You 
can coordinate sound files with other events, or edit to a timing base you feel most comfortable using.

Display lengths and positions in a variety of formats including Samples, Time, Seconds, Frames, 
Measures and Beats, and SMPTE.

Selecting a Status Format
To select a format choose the Status Format item from the Options menu. Then choose an option to set 
the status format for the current data window.

Samples Number of samples

Time Hours, minutes, seconds and milliseconds

Seconds Seconds and fractions there of

Time & Frames Hours, minutes, seconds and frames as defined by the Edit Frame Rate (Special 
Menu )command

Absolute Frames Frames and fractions there of

Measures & Beats Measures, beats and 1/4's of a beat

SMPTE Non-Drop SMPTE at 30 or 29.97 frames per second (fps) non-drop

SMPTE Drop SMPTE at 30 fps with drop frames

SMPTE EBU SMPTE at 25 fps

SMPTE Film Sync SMPTE at 24 fps

Using the current file, TUTOR1, let's take a look at how the status formats affect values in the status 
display fields. 

1. First, select the Samples format from the Status Format menu under the Options menu.
2. Now select all of the data in the TUTOR1 window. To do this choose the Select All option from the 

Edit menu. This will select all data in the window.
3. In the selection status fields on the playbar (at the lower right hand side of the data window) you 

should see the values of 0, 240,006, and 240,007. This means that the first selected sample 
(Selection Left) is sample 0, the last selected sample (Selection Right) is 240,006, and the total 
number of samples in the selection (Selection Length) is 240,007.

4. Now select the Time option from Status Format under the Options menu. You will see that all these 
values change to values specified in hours, minutes, and seconds rather than samples. You can 
see that a sound containing 240,007 samples with a sample rate of 44,100 Hz will play for 5.000 
seconds. You can experiment with each of the status formats to see how each format is displayed.

Configuring Frames and Measures & Beats
When setting the status format to Frames or Measures & Beats, there is additional information you can 
provide to Sound Forge XP to customize how these values are displayed. The Edit Frame Rate dialog in 
the Special menu allows you to change the frames per second. In the Edit Tempo dialog, also in the 
Special menu, you can specify the Beats per minute and Beats per measure values used to calculate 
measures and beats. The default values for Frames and Beats are set on the Status page in the 
Preferences folder (Options menu).



Magnification and Zooming
When sound data is drawn on the screen, it is necessary to represent many samples of data for each 
horizontal point on the screen. There are almost always many more samples in a sound file than there are
horizontal points (pixels) on the screen. Depending on the editing operations you need to use, you may 
want to view the entire file at once, or you may want to look only at a small portion in greater detail. This is
where the magnification, or zoom ratio, comes in.

Time Ruler Zooming 
Level Ruler Zooming 
Using Zoom Selection and Zoom Out 
Magnify Tool 



Time Ruler Zooming
In the bottom right corner of the data window, just above the data window playbar, is the current time 
magnification ratio. The Zoom Ratio defines how many samples of sound data are squeezed into each 
horizontal point on the screen. This setting is shown as a value of 1:XX , where XX is the number of 
samples represented by each horizontal point on the screen.

For example, if the setting is 1:1 then each point on the screen is one sample. With this setting, a very 
short length of time is shown on the waveform display. You might not be able to see the cursor or 
selection because you are seeing it at such close range. If the setting is 1:1,024, then there are 1,024 
samples represented by each point on the screen and a longer length of time can be seen. By dragging 
the Time Ruler right or left, you can easily scroll the data window. The further you drag in either direction, 
the faster the window will scroll.

If you right-click on the waveform display you can quickly select various Zoom
commands from the Data Window shortcut menu.

When Sound Forge XP opens a file it sets the horizontal magnification to the value specified by the 
Normal zoom ratio set on the Display page in the Preferences folder, unless the file is too small.

To increase or decrease the Zoom Ratio, use the Zoom In/Out spinner control found on each data window
next to the ratio. Clicking on either of the magnifying glasses increases or decreases the zoom ratio by 
single steps. If you drag the small rectangular button between the two magnifying glasses, you can spin 
the zoom ratio by large amounts.



Level Ruler Zooming
In the bottom left corner of the data window, just above the Go To Start button, is the spinner control for 
zooming in and out vertically in the data window. Zooming in along the level axis allows for more precise 
editing at the lower levels (where many edits start and end).

The labels for this axis can be either in decibels or in percent and are switched by right-clicking on the 
ruler. When zoomed in, only the lower level samples can be seen; the peaks of the waveform will have 
moved beyond the scope of the data window. To view these peaks, drag the Level Ruler up or down.

To optimize both the time and level scaling of a selection, double-click on the Level Ruler.
Double-click again to zoom out to the normal level.



Using Zoom Selection and Zoom Out
If you would like to quickly magnify a section of a data window horizontally, select the area you want to 
magnify, and then choose Zoom Time|Selection from the View menu or the Data Window shortcut menu. 
Sound Forge XP then calculates the minimum zoom ratio which will allow the full selection to fit on the 
screen and then centers the selection within the waveform display. 

This will not affect the zoom ratio of the Level Axis. Only the Zoom Selection command in
the Level Ruler shortcut menu will zoom the selection both vertically and horizontally.

To display all data in a window at one time, use the Zoom Time|Out Full command. This command sets 
the Zoom Ratio to the lowest value needed to display all of the data at once in the waveform display.

If you wish to set the zoom factor to its maximum magnification (1:1), use the Zoom Time|In Full 
command also found in the View menu or the Data Window shortcut menu (Zoom In Full). You will then 
be able to see the actual waveform oscillations which correspond to physical sound waves when played 
through your speakers.



Magnify Tool
Another way to zoom in to a particular section of the sound file is to use the Magnify Tool. You can select 
this tool from the Edit menu (Tool|Magnify) or by clicking on the Edit Tool selector (upper left-hand corner 
of data window) until the magnifying glass appears. 

When you choose the Magnify Tool, instead of making a selection, the mouse cursor will become a 
magnifying glass and a dotted square will appear. The zoom will take place within this dotted square. The 
three different modes of operation for the Magnify Tool can be selected by toggle-clicking (See Using the 
Mouse). These allow you to time zoom, level zoom or both simultaneously. You must then return to the 
Edit Tool mode to do edit operations.

You can also enter this Magnify mode temporarily by holding down the Control key when making a 
selection. If you drag the mouse while still holding the Control key, you can select a region which will then 
be magnified to a best fit ratio within the waveform display.



Advanced Editing and Navigation
This section will show you how to use the advanced editing and navigation operations of Sound Forge 
XP:

Making a selection using the Set Selection dialog 
Extending the selection points with the mouse 
Selecting with the keyboard 
The Overview 
Using the Go To dialog 
Drag And Drop Operations 
Editing Stereo Files 



Making a selection using the Set Selection dialog
If you need to select data at specific points, use the Set Selection dialog to type in selection points or 
choose a selection from a list of regions. To reach the Set Selection dialog, choose the Selection 
command from the Edit menu.

In the Set Selection dialog, you can modify the Start, End, Length, and Channel of the selection. Pre-
determined regions can also be chosen from the Selection drop-down list.

You can perform many commonly used functions in Sound Forge XP a number of ways. For example, you
can reach the Set Selection dialog by double-clicking on the playbar field to the left of OLE, or you can 
pick the Selection item from the Waveform Display shortcut menu. Sound Forge XP has been designed to
allow you to choose how you want to work. It doesn't force you to work in a certain way. To avoid 
confusion in our demonstrations, we won't always tell you about every method of accomplishing the same
task. See Shortcuts for more information.



Extending a Selection the Mouse
After selecting a section of sound data, you may find that the start or end points are not exactly where you
want them to be. You could just re-select the data, but it is often difficult to get the start or end points just 
right. 

Sound Forge XP allows you to update the selection by grabbing a selection edge and moving it. 

1. Once you have established a selection, place the mouse over the selection start or end point. The 
cursor changes to a bi-directional arrow. 

2. Press the left mouse button and move the selection to a new position. The new position will be 
updated once you let up on the mouse button.



Selecting with the keyboard
The keyboard selection controls allow you to quickly select data or update a selection accurately. For 
example, say you want to extend the selection end by a small amount. First make sure that the cursor is 
at the end of the selection. Press Home to move to the start and End to move to the end. Use the C key 
to center the cursor in the waveform display. You can then use the Shift+Right arrow and Shift+Left arrow 
combinations to extend the selection end point by small increments.

The following list shows the available keyboard commands for selecting data.

Press To select from cursor to…

Shift+Right arrow the next screen pixel.

Shift+Left arrow the previous screen pixel.

Shift+End the last sample visible in the waveform display.

Shift+Home the first sample visible in the waveform display.

Press To select …
Shift+Page Up 10% of the current view previous to the cursor position.

Shift+Page Down 10% of the current view past the cursor position.

Shift+Control+Right arrow 2% of the current view past the cursor position (see below).

Shift+Control+Left Arrow 2% of the current view previous to the cursor position (see below).

Shift+Numpad + the next sample.

Shift+Numpad - the previous sample.

Shift+Control+Numpad + 10 samples past the current position.

Shift+Control+Numpad - 10 samples previous to the current position.

In Windows 95, Shift Numpad + will not work unless the Numlock indicator on the
keyboard is lit.

As you can see from the above lists, Sound Forge XP has extensive keyboard support for selecting data. 
You will find that almost any operation has an equivalent keyboard shortcut which advanced users find 
invaluable. For a complete listing see Shortcuts.

Example using keyboard shortcuts
Let's take a quick look at how to use some of these keys. 

1. Open the file TUTOR1.WAV. 

2. Make sure that you're using the Edit Tool by selecting it in Tool under the Edit menu. 

3. Select the word "Wow" with a generous amount of space on each side of the word. When you press 
the Play button you should hear a little bit of silence, "Wow", and a little more silence.

4. Choose the Zoom Selection command from either Zoom Level or Zoom Time in the View menu. This 
will fit the selection on the screen with the best possible resolution. 



5. Now let's adjust the right side of the selection. Grab the end of the selection with the mouse and drag 
to the right. Adjust the selection to be close to the end of the word "Wow" and release the mouse 
button. 

6. Now let's do the same thing with the keyboard. Hold down the Shift key and press the right arrow key.
The selection will extend to the right by one screen pixel. If you hold down the Shift key and press the 
left arrow key, the selection will decrease by one pixel. One screen pixel is equal to the number of 
samples shown in the Zoom Ratio field. You can move the end of the selection in this manner until 
you've got the selection just right. 

7. Now let's adjust the start of the selection. Since the cursor is at the end of the selection, any keys we 
press for selecting will adjust the end. So we need to put the cursor at the front of the selection. To do 
this, press the Home key. You will see the cursor jump to the start point of the selection. Now, use the 
selection keys to adjust the start of the selection. 

A selection can also be updated on a per sample basis rather than a pixel basis. If you look in the above 
list you will see that the Shift + Numpad + (plus) and - (minus) keys are used for these operations. This 
allows you to get the exact selection you need without having to change the Zoom Ratio.



The Overview
While making selections and navigating through a sound file, you probably noticed the overview (the thin 
bar directly underneath the title bar) change. The overview represents the length of the entire sound file, 
as if you were zoomed out all the way. From the overview, you can determine what section of the entire 
sound file is being displayed, the selection made, and the cursor location.

Getting the Whole Picture 
1. Zoom out all the way on the TUTOR1 window (Zoom Out Full in the Data Window shortcut menu) 

and make a selection over the word "Wow." Notice that the entire overview has brackets above and 
below it, since the entire sound file is being displayed. Also notice how the selection and the cursor 
are displayed on the overview.

2. Now press the Zoom In button a few times (the large magnifying glass in the lower right-hand 
corner of the data window) and notice how the brackets become smaller. This corresponds to the 
smaller fraction of the entire sound file which you can see when you zoom in on the waveform 
display. The selection size, however, remains the same and does not move. Even when you can't 
see them on the waveform display, you always know where the cursor and the selection are in the 
sound file by referring to the overview.
You can also change the cursor position by left-clicking anywhere on the overview. As always, when
you change the cursor, you lose your selection. Remember you can use Toggle Selection if you 
want to restore it.

Fast Navigation and Playback
When you left-click outside the bracketed region in the overview, you will not be able to see the cursor on 
the waveform display. However, double-clicking anywhere on the overview will move the cursor and 
center the waveform display to the selected position in the sound file.

You can also play back the sound file starting from the current cursor position by right-clicking anywhere 
on the overview. Right-clicking again pauses playback. Left-clicking in the overview also moves the cursor
position. Also note that left-clicking on the overview during playback moves the cursor to the point where 
you clicked and continues playback at that point. These navigation tools make it very easy to find sections
in large files.

As an example, say you wanted to move the cursor to the beginning of a phrase in a speech. You can 
right-click on the overview bar to begin playback and then left-click at different positions within the 
overview until you find the right start point. Once you find the start point, you can press the Stop button to 
stop playback. The cursor should now be positioned at the last spot on which you left-clicked in the 
overview; select Center Cursor from the Special menu and you are ready to edit.



Using the Go To dialog
To quickly move the cursor to a specific point and center it in the waveform display, use the Go To 
command. You can reach the Go To dialog in a number of different ways:

Ÿ Use the Go To item in the Edit menu
Ÿ Right-click on the waveform display and select Go To from the shortcut menu
Ÿ Double-click on the left-most selection status field
Ÿ Press Control+G

The Go To dialog is much like the Set Selection dialog. You can type in the location where you want to go 
or use one of the predetermined locations from the list.



Drag And Drop Operations
You can perform a mix, paste, or crossfade by dragging a selection from one data window and dropping it
on another. See also Creating a New Window with Drag and Drop.

1. Open two sound files, such as TUTOR1.WAV and TUTOR2.WAV, and select Tile Vertically from the 
Window menu just to make them easier to work with. TUTOR2 is the source window and TUTOR1 
is the destination window. 

2. Press and hold the left mouse button in the selected area of the source data window. While holding 
the mouse button down, move the cursor until it changes to an arrow dragging a little box. 

For example, highlight all the data in TUTOR2 by making it the active window and dragging to 
select in the waveform display. You can also choose Select All from the Edit menu to select the 
complete waveform. Now drag the selected section by pressing and holding the left mouse button in
the data window of the TUTOR2 window. Notice that the cursor changes to a pointer with a small 
box when you begin dragging.

3. Drag the block to the beginning of the TUTOR1 data window. This is where you want the mix, paste,
or crossfade to occur. You will see a shaded block that represents the range of the source material. 
You will also see that the little box accompanying the cursor now contains an "M"(Mix), "C" 
(Crossfade), or "P" (Paste).

4. Mix: Let go of the left mouse button to see the Mix dialog. You see the Mix dialog which shows the 
TUTOR2.WAV window as the source and TUTOR1.WAV as the destination. Leave the levels at 0 
dB, and select OK. You will see that again the drum hit sound has been mixed into the TUTOR1 
window.

Crossfade: To perform a crossfade instead of a mix, hold the Control key down while letting go of 
the mouse button. You then see the crossfade block. This X-shaped block shows you where one 
sound begins to fade out and the other to fade in. The cursor position marks the beginning of the 
process. By dragging to the left and right, you can adjust the length of the crossfade. Once you 
have determined where you would like the crossfade to begin, let go of the mouse button. You 
should hear the end of TUTOR1 fade out as the beginning of TUTOR2 fades in.

Paste: Hold the Alt key down while you position the paste point at the beginning of TUTOR1. Now, 
let go of the mouse button. If everything was done correctly, you should have pasted the data from 
TUTOR2 at the insert position in TUTOR1.

5. Press the Play button to hear the results.

Tip: An easier way to select whether you will perform a mix, paste, or crossfade is to simply drag the 
block to the destination window and then while holding the left mouse button, click the right mouse button 
to toggle among the Mix, Paste, or Crossfade functions. You will see the block change according to the 
method; a mix will look like a solid block, a crossfade will look like an "X" (or perhaps, a butterfly), and a 
paste will be represented by a segmented vertical line rather than a block. 



Creating a New Window with Drag and Drop
A very useful feature of drag and drop is the ability to quickly create a new window from a selection. Make
a selection in a data window and drop it on an empty area of the Sound Forge XP workspace. A new data 
window is automatically created containing the data from the selection.



Editing Stereo Files
When editing stereo files you have two channels of data on which to work. The upper channel is the left 
channel and the lower channel is the right channel. We will refer to them in both ways left (upper), and 
right (lower).

Selecting Data in Stereo Files
When selecting data in stereo files, Sound Forge XP allows you to select either the left channel, right 
channel or both channels for playing, editing, and effects processing.

When editing a stereo file, the waveform display showing the two channels is split into three logical 
sections for selection with the mouse. The upper quarter of the waveform display is the left channel hit 
section, the lower quarter is the right channel hit section, and the middle half selects both channels. When
selecting data with the mouse, the cursor location determines what channel(s) will be selected.

1. Open the file TUTOR1.WAV and convert it to stereo by editing the Format under Properties in the 
File menu or by right-clicking on the Channels playbar field and selecting Stereo. Set the Channels 
to Stereo and press OK. Select Both Channels for the destination in the Mono to Stereo dialog. You 
should now have a stereo version of TUTOR1.WAV.

2. Move the mouse pointer near the top of the left channel and select the word "Wow." Notice the 
change to the left channel selection cursor, and that only the left channel of the data becomes 
highlighted. 

3. Now do the same thing but in the middle half of the window near the top of the right channel and the
bottom of the left channel. This time you should see both channels being selected. Do this one 
more time near the bottom of the waveform display and you should see only the right channel being
selected.

Cursor when selecting both channels of a stereo file or when in a mono file.
Cursor when selecting the left channel of a stereo file.
Cursor when selecting the right channel of a stereo file.
Cursor when extending a selection.

Toggling Channel Selections
Once you have made a selection in a stereo file you can switch between channel selections by pressing 
the Tab key. The Tab key will cycle between selections of Left Channel, Right Channel, and Both 
Channels. You can also set the channel selection by using the Channel drop-down list in the Set Selection
dialog.

Previewing Channels
Selecting a single channel allows you to hear a preview of a single channel in the stereo file. For example
double-click in the TUTOR1 window to select all the data (or use Select All from the Edit menu). Press the
Play button and listen to the clip. Next press the Tab key to toggle the channel selection into a single 
channel and press the Play button again. Do this one more time to hear the other channel.

Single Channel Editing
Stereo data files are tied together by the nature of their format. In other words, they always play together. 
This means that there are some edit operations, such as Cut and Paste, which you can't use on a single 
channel. It would leave one channel shorter or longer than the other. This is usually not a problem in real 
world editing situations. To shift a single channel in time by small amounts, you can use the Delay/Echo 
function.



You can copy a selection from a single channel to the clipboard by selecting the data in either the left or 
right channel and using the Copy command. This will place a mono clip on the clipboard. You can then 
paste the mono clip to a mono file, both channels of a stereo file, or you can mix it into a single channel or
both channels of a stereo file. When mixing mono clipboard data to a stereo file you will be asked with a 
dialog whether you wish to mix to a single channel or both channels.



Working with .AVI Files
Sound Forge allows you to open and save Microsoft Audio and Video Interleave (.AVI) files. This allows 
you to edit the audio tracks of a video with single frame accuracy. This section covers:

Opening an .AVI File 
Handling Multiple Streams 
Video Strip 
Video Preview 
Attaching a Video to a Sound File 
Saving an .AVI file 
.AVI Video Compression 
Compression Algorithms 
Compression Settings 



Opening an .AVI File
To open an .AVI file, choose Open from the File menu and select Video for Windows (*.avi) from the Files 
of type list. Then, double-click on the file you wish to open. If the .AVI file being opened in Sound Forge 
contains exactly one video stream and one audio stream, it will open these streams automatically. 
However, if no audio is present an audio stream will be created containing only silence for the entire 
length of the video.



Handling Multiple Streams
.AVI files can contain more than one video or audio stream. A stream is not the same as a track in a multi-
track video or audio editor. Multiple streams are most commonly used to contain different versions of a 
video or audio track. For example, you could have an .AVI file with one video stream and multiple audio 
streams in different languages. An .AVI player, such as Microsoft's Media Player, can detect which 
language version of Windows your computer is using and automatically play the correct audio stream for 
that language.

If more than one stream exists you have the option of choosing which one will be opened in Sound Forge.
This is done in the Video Stream dialog. In this dialog, you must select a video and audio stream to open 
by using the Stream Selectors (black diamonds) to the left of each stream. Once you've selected one of 
each, press OK.



Video Strip
When you open an .AVI file, you will notice the video strip on top of the waveform display. When you're 
zoomed out, all of the frames in an .AVI will not be displayed. The left edge of the displayed frames are 
aligned with the audio in time. If you'd like to see the frame numbers on the frames, right-click on the 
video strip and select Number Frames.

To resize the video strip, drag its lower edge up or down.

To enable frame animation in the video strip, select Animate frames from the Video Strip shortcut menu. 
When this option in enabled, moving the cursor will cause the nearest frame to be displayed above it. 
During playback, you will see the active frame window play the video as the cursor moves past it.



Video Preview
The Video Preview window is opened by selecting Video Preview from the View menu. The frame closest 
to the cursor (during editing or playback) will always be displayed in this window.

At the top of the window, the original frame size and current display size (in parenthesis) are displayed, 
along with the frame rate and current frame number. An asterisk (*) by a frame number indicates that the 
frame is a key frame (see the section on compression below).



Attaching a Video to a Sound File
To attach a video to an opened sound file, select Properties from the File Menu and go to the Video folder.
Pressing the Attach button will take you to the Attach Video dialog, where you can select an .AVI file to 
attach a video from. Press OK after selecting an .AVI with a video stream.

The Video Properties will now display the audio and video streams in the .AVI. An .AVI file can contain 
multiple streams, but in most cases you'll have one audio stream and one video stream.

The square checkbox to the left of each stream indicates which streams will be stored when you go to 
save your file. The black diamond next to it is the Stream Selector, which indicates which streams are 
currently being used in Sound Forge.

Press OK again and you should now see the video strip above the waveform display. Once you're done 
editing, you must save the file as an .AVI if you want to store the video.



Saving an .AVI file
To save an opened file in the .AVI file format, follow these steps:

1. In the Save or Save As dialog, select Video for Windows (.avi). After naming the file, etc.., press 
Save.

2. The Video Save Options dialog appears next. In here, you can select which streams to store in 
the .AVI file by checking the square checkbox to the left of each stream. In this dialog, it is also 
possible to edit the titles of the streams.

3. Pressing OK will take you to the Compression Options dialog. Here, you can select a compression 
scheme for each audio and video stream. To change the options for a stream, select it and press 
the Options button. By checking the Interleave every _ Frames option, you can specify how 
frequently the audio chunks are interwoven with the video.

4. If you pressed the Options button, yet another dialog, Video Compression, let's you select from 
different compression algorithms, and even go to another dialog to set specific compression 
configuration parameters. For more information on compression, see the next section. Selecting No
Recompression saves the stream in its original format, which is the Sound Forge default.

5. Once you're done setting compression options, hitting OK several times will complete the process. 
If the video is long and/or the compression scheme selected is slow, saving the file might take a 
while. However, if you didn't change any video compression formats, the save will be much faster, 
since no recompression takes place.



.AVI Video Compression
If you thought audio files chewed up your hard-disk space quickly, wait until you start using video! CD 
quality audio takes up about 10 MB of hard-drive space per minute:
 (60 seconds x 44,100 samples per second x 2 tracks for stereo x 2 bytes per 16-bit sample). On the 
other hand, a typical video for multimedia use will easily contain about 200 MB per minute, and this for a 
small window of video:
(60 seconds x 15 frames per second x 320 x 240 x 3 bytes for 24 bit pixels).
Using uncompressed video as a final distribution format is out of the question for most practical purposes.
Video compression is a necessary evil.



Compression Algorithms
Many different compression algorithms exist and many more will continue to be created in the next 
several years. With all algorithms, trade-offs will have to be made between video quality, size reduction, 
and compression/decompression processing time. Compressing by large amounts quickly will generally 
produce visual artifacts such as jumpy or grainy video.

When saving an .AVI in Sound Forge, you can select from all of the installed compressors installed in 
your system. Included with Windows are Cinepak by Radius (cvid), Intel Indeo (IV32), and Microsoft 
Video 1 (CRAM). These can be selected from the Video Compression dialog (see section above).



Compression Settings
Many compressors use key frames during compression and decompression. A key frame is a frame in the
video stream which is not inter-frame compressed. The following compressed frames are derived from the
closest key frame. Having fewer key frames will make the video size smaller. However, it will take a lot 
more time to display the frames, specially when jumping around the end video.

When editing, .AVI files in Sound Forge, the display speed will suffer greatly if there is
only one key frame in the entire file. In such cases, Sound Forge needs to scan all

preceding data when drawing every single frame.

Also in the Video Compression dialog, you can specify the Data Rate of the video, which relates directly 
to the final size of the file. Different compressors do different things with this value, since its only an 
expected value. In most cases you should leave this unchecked. If you have very limited playback data 
rates, such as in a single-spin CD-ROM, you might then want to set this value. However, note that the 
Compression Quality control setting will also affect the output size.

Use the Preview button to get an idea of the video's output quality and compression
amount.



Editing Audio in .AVI Files
When doing any operations on the soundtrack of an .AVI file, the video stream is always left untouched. 
For example, doing a cut, paste, time compression, ,etc. on a sound file will not change the duration of 
the video stream.

In Sound Forge, the video stream and audio stream will always start together, and you will see the video 
frames only where audio exists. Therefore, if you want to view the entire video stream, you should use 
Insert Silence to add enough audio to run the entire length of the video. You can then later mix in any 
needed sounds into the file.



Editing Sound Formats
This section will show you how to deal with the many different sound formats.

Changing sound formats 
Mono to Stereo and Stereo to Mono Conversions 
Converting 16-bit samples to 8-bit samples
Converting files
Embedding Summary Information in WAV files



Changing Sound Formats
When you open a file or create a new window, the format for the window is shown on the first three status 
fields of the main status bar at the bottom of the program window. The format parameters consist of the 
Sample Rate, Sample Size, and number of Channels (Mono or Stereo). The last status fields display the 
Total Length of the sound data, and amount of Free Storage available.

Changing the sample rate will make your sound play faster or slower and with a higher or
lower pitch. If you want the file to sound the same at a different sample rate, use the

Resample function under the Process menu.

When you right-click on any of the three format fields, a shortcut menu will pop up at the current mouse 
location allowing you to change that parameter. You can also change all three parameters at one time by 
selecting Properties|Format under the File menu. The Properties dialog can also be invoked by double-
clicking on any of the format fields, or by right-clicking on the waveform display of the data window and 
selecting Properties in the shortcut menu.



Mono to Stereo and Stereo to Mono Conversions
For demonstration purposes, open the file TUTOR1.WAV located in the directory where Sound Forge XP 
4.0 was installed (in most cases this will be C:\Forge40). To convert the file from mono to stereo, right-
click on the status field which has the word Mono and select Stereo from the shortcut menu. 

When you do conversions from mono to stereo, you see a dialog which asks you where you want to put 
the data. Your choices are as follows:

Left Channel The mono data is placed in the left channel. The right channel is set to silence.

Right Channel The mono data is placed in the right channel. The left channel is set to silence.

Both Channels The mono data is copied into both channels.

When performing stereo to mono conversions, the following options are available:

Left Channel Mono data is taken only from the left channel of the stereo file.

Right Channel Mono data is taken only from the right channel of the stereo file.

Mix Channels Mono data is created by mixing both channels of the stereo file.

For now let's put the data in the left channel so we can get a feel for how the function works. Click the 
radio button next to Left Channel and select the OK button.

You will now have data in the upper half of the data window (the left channel) and silence in the right 
channel. Press the Play button and you will hear "Wow, sound editing just gets easier and easier" in only 
the left channel. 

If your card supports only mono data you will still be able to play stereo files if you set
your playback device to Sound Mapper in the Wave section of Preferences in the Options

menu.

For now let's go back to a mono sound file, but we'll do it in a different manner. Select the option 
Properties in the shortcut menu that appears when you right-click on the waveform display. In the 
Properties dialog select the Format tab. This page allows you to change all the parameters at once. Set 
the radio button for Channels to Mono and select the OK button. Select the Left Channel for the source 
channel in the Stereo to Mono dialog and we're back where we started. 

The above steps were used for demonstration purposes. Simply using Undo would have
been much more efficient.



Converting 16-bit samples to 8-bit samples
To save storage space, 16-bit sound files are often converted to 8-bit files. However, when you represent 
a sound file with only 8-bits, an audible distortion referred to as quantization error becomes very 
prominent. To minimize quantization error, there are several things you can do to the 16-bit sound file 
before converting it to 8-bit. You can:

Ÿ Apply a Noise Gate (Effects menu) to completely mute out the silent parts in a sound file. Often, a 
low level signal in a 16-bit sound file will become noise after the 16- to 8-bit conversion, so it's best 
to have complete silence between the sound parts.

Ÿ Normalize (Process menu) the sound to 0 dB (peak). This ensures that the entire dynamic range 
available in 8-bit samples is used and lowers the signal to noise ratio.

You can apply both dynamic compression and normalization at once by using the
Normalize function with the Average RMS power option. Set Apply dynamic compression

in the If clipping occurs drop-down list.

Once you have performed the above operations, you should use Convert to 8-Bit in the Process menu to 
do the 16 to 8-bit conversion. Select a 16 to 8-bit conversion option:

Truncate simply removes the lower 8 bits and they are lost forever. 

Round is similar to Truncate, only some attempt is made to represent the highest of the low bits by 
rounding up if possible. 

Dither is used to mask the quantization noise with less obtrusive noise. In the Convert to 8-Bit dialog, set 
the Dither bit depth to a low value (like 0.1) and increase the value slowly until you reach an acceptable 
sound.

Remember, an 8-bit sound file will always sound noisier than a 16-bit sound file, so whenever possible, 
stick with 16-bit. When trying to save space, it is possible to get better results from lowering the sample 
rate (see Resample for more information) instead of using 8-bit samples.



Converting Files
When producing audio files you may find that you need to provide the file to a client in a variety of 
formats. This could be .WAV files with data formats such as 8-bit mono, 16-bit stereo, or even ADPCM. 
You may need the files converted to Raw data, .VOC, or some other PC format. You may even need to 
convert to a different platform like Macintosh .AIF files or Amiga .SVX.

We have seen in the previous sections that you can quickly convert between mono/stereo, 8/16-bit, and 
change the sample rate in Sound Forge XP. You can then use the Save As command to save the file to a 
new name, or you can save in a new format within the Save As dialog.

1. If you don't have TUTOR1.WAV open, open it up now. From the File menu, select the Save As 
command.

2. On the Save As dialog, there are three controls used for file conversion:
Save as type. This lists all the available output file types. When you bring up the Save As dialog, 
the Save as type will be set to the type from which the file was opened. The default for new files is 
Microsoft Wave (.WAV). You can change to the type of file you want to save by selecting the new 
type from the Save as type list. Notice that the extension of the file name will be changed to reflect 
the type of file you are saving.
Format. The Format drop-down list shows the format of the data which will be saved in the file. 
Usually this will be PCM which is the standard for most file types. PCM (Pulse Code Modulation) is 
a standard format for normal uncompressed audio. If you are saving a file to a file type which 
supports other formats, they are displayed in the drop-down list. Other formats are typically used 
when saving audio data in a compressed form.
Attributes. The Attributes drop-down list shows the sample size, channels, and sample rate which 
will be stored when saving this file. Examples include: 11,025 Hz, 8-bit Mono or 44,100 Hz 16-bit 
stereo. You can quickly change the attributes of the data by selecting one of the options available in
the drop-down list. When you change from a mono file to a stereo file using the Attributes field, that 
data is copied to both channels. If you change a stereo file to a mono file, the data is mixed to one 
channel.
When you change the Save as type you may notice that the Format and Attributes fields will also 
change. This is because not all file types support the same types of sound data. For example the 
Dialogic .VOX format only supports 16-bit mono Dialogic ADPCM files. This means you can't store 
stereo 8-bit data in this file. Don't worry, in most cases Sound Forge XP automatically converts any 
file you save to an acceptable format.



Embedding Summary Information in WAV Files
Microsoft .WAV files allow you to store over 30 text fields including: Creation Date, Copyright, Keywords, 
and a variety of other informational text data. Sound Forge XP supports viewing and editing any of these 
fields.

Summary Information
When editing .WAV files, the Summary tab is available in the Properties section of the File menu. This 
allows you to view and/or change basic summary information currently stored in the file.

Extended Summary Information
The Extended Summary dialog consists of a list of available fields, each of which may or may not have 
attached text. The Fields list shows the abbreviation of the field type, a short description, and if the field is 
currently empty, the word (Empty) appears after the short description. Below the list of fields is the 
Contents which shows the contents of that field. At the bottom of the dialog is a longer description of the 
current field.

To the left of each field in the list is a check box which is used to enable or disable fields of this type when 
saving .WAV files. The field is enabled or disabled by clicking on the check box. If a field is empty, i.e. has
no text associated, enabling the check box has no effect on a saved file. Field information is only saved if 
text information exists for that field.

The Save Summary Information in .WAV files check box in the Save As dialog is used to quickly 
enable/disable saving of all summary fields to a file during a Save As operation. This allows you to quickly
strip all summary information from a file. 

For a description of the fields available, see General Properties.

Default
If you select the Default button, the text in the summary fields is saved with the defaults fields that are 
automatically filled when creating a new .WAV file. The Creation date field (ICRD) is always filled with the 
current date for new files. Saving a custom default setup is handy for saving copyright and engineer 
information for new files created at your site.

Open the file TUTOR1.WAV and select the Summary tab from Properties in the File menu. This will show 
you the Summary dialog. Press the Extended button and notice that the default for saving summary 
information is to have all fields enabled. The fields which have already been filled in for TUTOR1.WAV are
Comments, Copyright, Creation Date, Engineer, Keywords, Name/Title, Product, Subject, Software, and 
Source. Scroll to and select each field. You will see the embedded text for each of these fields.

Additional Embedded Information
The Microsoft .WAV file format allows non-text data to be embedded in the sound file. If you open and edit
a file which has additional information created by other software, Sound Forge XP will keep track of this 
data and place it back in the file when you save to the original format. 

If you wish to add or remove additional data (such as embedded bitmaps, metafiles, etc.), you can use 
the Save As item from the File menu. When you save data using the Save As option, Sound Forge XP will
ask you if you wish to copy the additional non-audio information to the new file. At this point you can 
answer either Yes to place the additional information in the new file or No to save only audio data and any
additional data types you have selected. 

Sound Forge XP will only prompt you to save if such data exists. 



Creating RealMedia and ASF (NetShow) files
Sound Forge supports two different formats for creating files that are optimized for streamed playback 
over (usually) slow networks such as the Internet. Both Progressive Network's RealMedia (.RM,.RA) , 
which includes RealAudio and RealVideo and Microsoft's Active Streaming Format (.ASF) files can be 
created in Sound Forge XP. To play these files, you must have the appropriate player application installed 
in your computer.

Using Sound Forge XP to create RealMedia files 
Using Sound Forge XP to author NetShow content 



Using Sound Forge XP to Create RealMedia Files
Sound Forge XP gives you the ability to save sound files in RealMedia formats (RealAudio and 
RealVideo) along with editing tools that help maximize the audio's fidelity. This section first explains how 
to save files in RealAudio format, then covers saving files in RealVideo format. All of the tips for 
converting files to RealAudio also apply for converting AVI files to RealVideo. For more information on 
authoring RealMedia content, refer to Progressive Networks' RealMedia home page (www.real.com).

Preparing RealAudio Files
Preparing RealAudio files is a three-step process: 

Recording the audio
Preparing a sound file for RealAudio encoding 
Setting the RealAudio text fields

Saving RealVideo Files
Saving an AVI File in RealVideo Format 

                                                         
See also
RealMedia Save Options



Recording the audio
To record a sound file in Sound Forge XP:

1. Click the Record button. The Record window appears displaying the settings from the last clip 
recorded.

2. Use the defaults or click the New button to change the Sample Rate, Sample Size or number of 
channels of the source file.

3. Check the Monitor box and play the clip to be encoded. Check for clipping. You want the levels to 
be mostly in the green area, a little in the yellow and only occasionally in the red. If Sound Forge XP
displays a red Clip warning above the Monitor, you should: 
Ÿ Stop the input source. 
Ÿ Click the Reset button. 
Ÿ Lower the volume of the input source either by turning down the output of your sound source or 

by turning down the input volume on your sound card's mixer window. In general, you don't 
want any of your levels too high or too low. 

Ÿ Check the levels again. It is better to be conservative with the starting levels. 
4. Check the DC Adjust box. Sound Forge XP can automatically calculate how much offset is 

necessary. With your sound source connected but no sound playing, click the Calibrate button. If 
you always use the same input device, you only have to perform this step once. Otherwise, you 
should re-calibrate each time you switch input devices. 

5. Click the Record button on the Record window to start the record process.
6. When the file is recorded completely or when you click the Stop button, a graphical display of the 

wave file appears.
7. Click the Close button to close the Record window. 



Preparing a sound file for RealAudio encoding
To prepare a recorded file for RealAudio encoding: 

When you have finished recording a file, it is recommended that you perform the following processes on 
the file before saving the file in a RealAudio format. 

Note: Sound Forge XP allows you to save preset settings for each of these processes. So once you set 
them up the first time, you can always use the same settings. 

Normalize
This process ensures that the loudest part of the file is at the maximum recording level. 

1. Press Ctrl-A to select the entire file.
2. Click Normalize from the Process menu. The Normalize window appears.
3. Click the Peak Level box.
4. Move the Normalize to slider to -.50 dB (94.41%).
5. Click the OK button. Sound Forge XP normalizes the file. 

Compress 
If you have not already audio compressed the clip, you can do so now. RealAudio files benefit from 
compression because it increases the overall volume and intelligibility of the sound. The suggested 
settings use very light compression. 

1. Press Ctrl-A to select the entire file.
2. Click Dynamics from the Effects menu and select Graphic. The Graphic Dynamics window appears.
3. Check the Sync Stereo Gain box. 
4. Check the Auto Gain Compensate box.
5. Move the Threshold slider to -10.00 dB.
6. Move the Ratio slider to 2.0:1.
7. Set the Attack box to 1.0 milliseconds.
8. Set the Release box to 300.0 milliseconds.
9. Click the OK button. Sound Forge XP compresses the file.



Setting RealAudio text fields
To set the RealAudio text fields: 

1. Click Properties on the File menu. The Properties window appears.
2. Click the Summary tab.
3. Enter the Title, Engineer, and Copyright information. This information will appear in the Title, Author,

and Copyright text boxes on the RealAudio Player.
4. Click the OK button. 



Saving a File in RealAudio Format
To save a file in RealAudio format: 

1. Select Save As from the File menu. The Save As dialog appears.

2. Enter the file name of the file you are saving.

3. Select RealMedia (*.rm;*.ra) as the Save as type. The default extension for this type of file is .rm.    To 
save using the .ra extension, type .ra at the end of the file name.

4. Select Save. The RealMedia Save Options dialog appears. The options in this dialog are covered in 
the below section, RealMedia Save Options.

5. Select the Audio compression type from the drop-down list. A brief description of the highlighted 
compression type is displayed below this list.

6. If the file you recorded was stereo and you selected a mono compression type, select the Stereo to 
mono conversion. It is recommend that you use the Both Channels option.

7. Select OK. After the file has been saved, a message appears asking whether you want to listen to the
saved file through the RealPlayer. This message verifies that you have saved the file in RealAudio 
format. You can listen to the file by clicking the Yes button if you have the RealPlayer installed.

See 
RealMedia Save Options 



Saving an AVI File in RealVideo Format
To save an AVI file in the RealVideo Format:

1. Select Save As from the File menu. The Save As dialog appears

2. Enter the file name of the file you are saving.

3. Select RealMedia (*.rm;*.ra) as the Save as type.

4. Select Save. The RealMedia Save Options dialog appears. The options in this dialog are covered in
the below section, RealMedia Save Options.

5. If you wish to include the audio in the new RealVideo file, make sure the Save Audio Stream option 
is checked. Then, select the Audio compression type from the drop-down list. A brief description of 
the highlighted compression type is displayed below this list.

6. If you wish to include the video in the new RealVideo file, make sure the Save Video Stream option 
is checked. Then, select the Video compression type from the drop-down list. For a brief description
of the two compression types, see the below section, RealMedia Save Options.

7. The final step before saving the file is to specify the Desired maximum data rate in total kilobits per 
second (Kbps). This option is only available if you are saving a video stream. Refer to the 
documentation for Desired Maximum Data Rate in the RealMedia Save Options section for more 
information.

8. Select OK. After the file has been saved, a message appears asking whether you want to listen to 
the saved file through the RealPlayer. This message verifies that you have saved the file in 
RealVideo format. You can view the file by clicking the Yes button if you have the RealPlayer 
installed.

See 
RealMedia Save Options 



Using Sound Forge XP to create ASF files
This tutorial shows how to create Active Streaming Format (ASF) files using Sound Forge XP. ASF is a 
multimedia file format used for streaming information across the Internet using Microsoft NetShow. With 
ASF files, you can deliver multimedia content, audio or video, open Web pages, or deliver scripting 
commands to the client computer.

Sound Forge XP includes support for saving WAV and AVI files and their associated markers and script 
commands in an ASF file. ASF files can be played off of your local drive, streamed off of an HTTP server, 
or optimally stored and streamed off of a NetShow server.

NetShow is a scaleable solution and ASF facilitates authoring of streaming content for a variety of bit-
rates. This tutorial will cover creating low bit-rate and relatively high bit-rate video-based ASF content, 
although audio-only content is also an option.

NetShow Requirements 
NetShow Tutorial 



NetShow Requirements
In order to play ASF files you must install the Microsoft NetShow Player and Tools. The Tools install the 
encode codec for the VDOnet VDOWave video codec. Both of these components are available on the 
Sound Forge XP CD-ROM and can also be downloaded free of charge from the NetShow web page.

To install the client, select Microsoft NetShow Player from the list in the main setup program on the Sound
Forge XP CD-ROM. This will run Microsoft's setup program for the player. Optionally, you can run 
NSOPLAY.EXE directly from the \EXTRAS\NETSHOW2.0\X86 folder on the Sound Forge XP CD-ROM.

To install the ASF authoring and conversion tools, select Microsoft NetShow Tools from the list in the main
setup program on the Sound Forge XP CD-ROM. This will run Microsoft's setup program for the NetShow
Tools. Optionally, you can run NSOTOOLS.EXE directly from the \EXTRAS\NETSHOW2.0\X86 folder on 
the Sound Forge XP CD-ROM.

Further documentation for this software is available on the NetShow web page. At this time, the 
components shipped on the Sound Forge XP CD-ROM are for the x86 and Pentium platforms only. See 
Microsoft's web page for availability of components for other platforms.



NetShow Tutorial
NetShow is a scaleable solution and ASF facilitates authoring of streaming content for a variety of bit-
rates. This tutorial will cover creating low bit-rate and relatively high bit-rate video-based ASF content--
although audio only content is certainly an option.

Converting a High Bit-Rate AVI to ASF 
Authoring a Low Bit-Rate ASF 
Sample HTML Using an ASF File 
Calculating Appropriate Bit Rates for the Internet 
What Do I With My ASF Files 

                                                         
See also
ASF Save Options 



Converting a High Bit-Rate AVI file to ASF format
This section of the tutorial demonstrates how you can create high bit-rate video content and convert it to 
ASF. SAMPLE1.AVI is a short video clip that uses the Intel Indeo Interactive VCM video codec installed 
with the NetShow Player. The Intel codec is well suited for mid to high bit-rate video. The audio track in 
this file is PCM format.

1. From the File menu, open SAMPLE1.AVI from the \SAMPLES\NETSHOW folder on the Sound Forge 
XP CD-ROM. From the File menu select Properties. Select the Format page and set the audio 
Sample Size to 16 bits. Make sure that Channels is set to mono. Select OK.

Note that editing and playback performance of an AVI file will suffer greatly unless you first copy it to 
your hard drive. It is strongly recommended that you always copy AVI files that you are editing onto 
your hard disk.

2. From the Process menu select the Resample command. The Resample dialog will appear. Set the 
new sample rate to 8,000 Hz and select OK.

3. From the Process menu select the Normalize command and select OK.

4. Now convert the edited AVI file to an ASF file by saving it on your hard drive. Select the Save As 
command from the File menu. Select Active Streaming Format (*.asf) from the Save as type drop-
down list.

5. The NetShow Player installs the Lernout & Hauspie CELP 4.8kbit/s ACM codec (see previous 
section), which is excellent for low bit-rate voice audio. Select this codec from the Format drop-down 
list. Select Save. (Note that it is not a requirement of ASF to convert the audio from PCM. We perform
the conversion as part of this tutorial to demonstrate how to take advantage of the installed codecs.)

6. The ASF Save Options dialog presents the settings for the Active Streaming Format file. Select OK to 
select all the default settings.

7. Next, the Video Save Options dialog appears. It allows you to view the audio and video properties of 
the AVI file. Select OK.

8. The Compression Options dialog presents the available video compression options. Press OK to 
select the Indeo codec.

9. When the ASF file has been created Sound Forge XP will prompt you to play it. Select Yes. This will 
start the NetShow Player.

10. From the File menu in the NetShow Player select Properties. Note the following Properties pages:

·The General page contains the general information contained within the AVI file.

·The Details page shows that the ASF file has a bit-rate of 875,000 bps.

·The Codecs page displays information about the codecs being used with the file.



Authoring a Low Bit-Rate ASF File
This section of the tutorial creates a low bit-rate video suitable for playback on the Internet at 28.8 Kbps. 
SAMPLE2.AVI is a smaller version of SAMPLE1.AVI. It uses the Intel Indeo Interactive codec and has 
been re-sized to 160 x 120 at 6 frames per second with one key frame every 36 frames. The VDOnet 
VDOWave codec and the Intel Indeo Interactive codec require that the video frame size be a multiple of 
16 (i.e., 160 x 120, 320 x 240, etc.). The audio track in this file is PCM. The steps below describe how to 
use the VDOnet VDOWave video codec, which is an exceptional codec for low bit-rate content.

1. From the File menu, open SAMPLE2.AVI from the \SAMPLES\NETSHOW folder on the Sound Forge 
XP CD-ROM. You will be prompted with a message from Sound Forge XP asking if you want to 
disable the video strip. Select No.

Note that editing and playback performance of an AVI file will suffer greatly unless you first copy it to 
your hard drive. It is strongly recommended that you always copy AVI files that you are editing onto 
your hard disk.

2. From the File menu select Properties. Select the Format page and set the audio Sample Size to 16 
bits and verify that Channels is set to mono. Select OK.

3. From the Process menu select the Resample command. In the Resample dialog, set the New Sample
Rate to 8,000 and select OK.

4. From the Process menu select the Normalize command and select OK.

5. Now add Markers and ASF Script Commands. From the Special menu select Region List/Add. Add 
the following three Markers:

Type Name Time

Marker ASF CAPTION:John is here to… 00:00:01.000

Marker This is the middle of my ASF 00:00:09.000

Marker ASF CAPTION:John is not here… 00:00:10.000

Note that you can drag and drop the markers along the time line once they have been created and 
during playback. Markers that start with the preface ASF are processed as stored as script commands
within the ASF file. For more information, see Sound Forge XP online Help.

6. Now save the edited AVI file to an ASF file. Select the Save As command from the File menu. In the 
Save As dialog, Select Active Streaming Format (.asf) from the Save as type drop-down list.

7. The NetShow Player installs the Lernout and Hauspie CELP 4.8kbit/s ACM codec, which is excellent 
for low bit-rate voice oriented audio. Select this codec from the Format drop-down list. Select Save. 
The ASF Save Options dialog presents the settings for the ASF file.

8. Set the Maximum lead time setting to 5,000 and select OK. Note that 5,000 is the lead time setting 
that should be use when authoring low bit-rate video ASF files.

9. Select OK to close the Video Save Options dialog.

10. The Compression Options dialog presents the available video compression options. Select the 
Options button, and in the Video Compression dialog select the VDOnet VDOWave codec from the 



Compressor drop-down list. 

11. Select the Configure button to bring up the Encoder Configuration dialog. This dialog allows you to set
the specific bit-rate for the video stream. Drag the slider to the left until it is at the 14 Kbit/sec setting. 
Select OK.

12. Back at the Video Compression dialog verify that the check box next to the Key Frame Every field is 
enabled and set the Frames edit field to 60. This will set a key frame every 10 frames. It is necessary 
to reduce the number of key frames to attain the desired low bit-rate. Select OK.

13. Back in the Compression Options dialog verify that the Interleave Every check box is clear. Select OK
to start building the ASF file.

14. When the ASF file has been created Sound Forge XP will prompt you to play it. Select Yes. This will 
start the NetShow Player.

15. From the File menu in the NetShow Player select Properties. Note the following Properties pages:

· The Details page shows that the ASF file has a bit-rate of 19,332 bps. Achieving the exact bit-rate for 
a video stream will vary depending on the content. Complex video may require fewer frames per 
second or less frequent key frames. Frame rate, key frames, and video frame size are all variables 
that affect bit-rate.

· The Codecs page displays information about the codecs being used with the file.



Adding an ASF File to a Web Page
On the Sound Forge XP CD-ROM in the \SAMPLES\NETSHOW folder there is an HTML file containing 
an example of how to use the NetShow Active Control to add an ASF file to a web page. This sample will 
be used with the low bit-rate video ASF file, SAMPLE2.ASF. Note that the HTML sample requires 
Microsoft Internet Explorer v3.0 or better.

1. Copy SAMPLE.HTM to the folder on your hard drive that contains SAMPLE2.ASF. 

2. Modify the FILENAME parameter within the NSOPlay object to reference your local SAMPLE2.ASF 
file (a fully qualified path is required). 

3. Open the edited SAMPLE.HTM file within your browser. There are additional instructions on the 
sample page.



Calculating Appropriate Bit-Rates for the Internet 
When authoring Internet file formats, it is important that the content not exceed the bit-rates of your 
targeted modem connection. The reason is that modem connections to the Internet are often less than 
14.4 Kbps or 28.8 Kbps. It is important not to consume all the bandwidth available to the browser, control 
protocols, etc. The following guidelines suggest a combined (audio and video) bit-rate with error 
corrections slightly below the targeted Internet connection:

Internet Connection Authored Bit-Rate (audio + video) Total Bit-Rate w. Error Correction

28.8 Kbps 18,500 bps 20,813 bps

14.4 Kbps 10,000 bps 11,250 bps

For example, in the Authoring a Low Bit-Rate File section above, the audio was set to 4.8 Kbps and the 
video was set to 14 Kbps. With the addition of error correction to the stream, the total ASF file bandwidth 
as displayed in the NetShow Player is 19,332 bps.



What Do I Do with My ASF Files?
ASF files are specifically designed for network streaming and are authored for specific network 
bandwidths. For network streaming, ASF files can be stored on an HTTP server or optimally off of a 
Microsoft NetShow server. The NetShow Player can play back ASF content as an embedded Active 
control within an OCX container such as Microsoft Internet Explorer 3.0 or Microsoft Visual Basic. The 
NetShow Player can also run in standalone mode, such as when an ASF file is launched as a link within 
any Internet browser. ASX files (ASF Redirector Files) are meta files that pass the ASF file link from the 
browser to the NetShow Player so it can start streaming.

For more information, see the NetShow web site. The entire Microsoft NetShow product can be 
downloaded free of charge from www.microsoft.com/netshow.



Recording
Sound Forge XP has a variety of sound recording modes and options each of which come in handy for 
different situations. These include recording new data, recording over existing data, commonly known as 
"Punch In" mode, and Remote Recording.

Recording basics
Recording modes
Record Meters 
Remote recording



Recording basics
To start a record session you can either select Transport then Record from the Special menu or press the 
Record button on the Transport toolbar. The Record button is the first button on the Transport toolbar with 
the red circle on it.

If you experience problems recording, see Troubleshooting for information on common
recording problems.

After pressing the Record button or selecting Transport|Record from the Special menu, you will be 
presented with the Record dialog. Notice that the window into which you will be recording has its title 
displayed in the dialog title.

Warning: The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities.

To prevent accidentally recording over sound data, record into a new or scratch data window and paste 
the takes you want to keep into the desired sound data window. For extra safety Sound Forge XP 
automatically defaults to record in a new window when the current sound file is opened in direct edit 
mode.

In the upper left corner of the dialog are the Recording attributes. These are the record sample rate, 
sample size, and number of channels which will be used when recording. These attributes are applied to 
the data window into which you will be recording. If you want to change these attributes, exit the Record 
dialog and change them in the data window, record to a new window, or record to another window.

Recording to a New Window
If you want to record to a new window rather than the currently selected record window, select the New 
button found at the upper right of the Record dialog. This brings up the New Window dialog where you 
can specify the Sample rate, Sample size, and Channels for the new data window. These attributes will 
be applied while recording.

Selecting an Alternate Record Window
If you wish to record to a window other than the one currently displayed in the Record dialog title, you can
do so by selecting the Window button. Pick the window you want to record to from the drop-down list in 
the Record Window dialog and select OK. The title of the window you select will now appear in the 
Record dialog title.



Recording Modes
Choose one of the following modes of recording.

Automatic Retake
The Automatic Retake mode is the easiest method of recording. Recording starts at the position shown in 
the Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position is reset to the beginning of the take allowing an immediate review and retake if desired.

Automatic Retake is the default mode when recording into an empty Data Window or when you select the 
record button with no data selected in the current Data Window.

Multiple Takes
The Multiple Takes mode allows multiple takes to be recorded. Recording starts at the position shown in 
the Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position remains at the end of the take allowing the next take to be recorded immediately.

Punch In
Punch In mode is used when you want to record over a region of data in an existing Data Window. 
Recording starts at the position shown in the Start field when you select the Record button and continues 
until you select the Stop button, or the length of the data recorded is equal to the length in the Length 
field. This makes it easy to record over a section of audio without effecting the rest of the file. You can use
the Play button to hear the selected Punch In region at any time.

You may adjust the Punch In region by changing the values in the Start, End, or Length edit fields. You 
may also adjust the format of these fields to a variety of different display status formats by selecting a 
format from the Input format drop down list box.

Punch In mode is the default mode when you select the Record option while you have a region of data 
selected in the current Data Window.

Using Pre/Post-Roll with Punch In Mode
At the bottom of the Record dialog are two edit fields which contain the Pre-Roll and Post-Roll times. 
These can be used when listening to a region in Punch In mode. These times define the amount of audio 
you will hear prior to (Pre-Roll), and after (Post-Roll), the selected region when using the Play button. This
allows you to hear the transitions between the Punch In region and sound before and after the region. If 
you wish to use the Pre/Post-Roll option you must check the Review check box at the bottom of the 
dialog. To disable Pre/Post-Roll uncheck this box.

Using the Prepare Button
The Prepare button is used when you need Sound Forge XP to begin recording as soon as possible after 
selecting the Record button. The Prepare button opens the wave device and loads all recording buffers in 
order to minimize the time between selecting the Record button and sound actually beginning to be 
recorded.

The Prepare button is optional. It is not necessary to select this button prior to recording, however it does 
allow for more accurate takes in the Punch In mode.

Recording Status
While you are recording, the amount of time recorded will increase and the Time left on drive will 



decrease. Make sure and keep an eye on your Time left on drive if your available record time is limited. 
It's never fun running out of recording time!

Available Recording Time
Near the bottom of the dialog you will see the Time recorded and Time left on drive fields. These two 
boxes show how much time you have recorded and how much time is available on your hard drive for 
additional recording. If your Time left on drive field is displaying a limited amount of available time you 
may want to free up some space on your hard drive or pick an alternate drive where Sound Forge XP 
stores its temporary files. You can get more information on temporary file usage by referring to the 
Reference chapter on Temporary Storage.

Finishing Recording
When you have finished recording select the Close button to exit the Record dialog and return to normal 
editing mode.

Previewing Recorded Sounds
After recording your material, you can listen to what you have recorded by selecting the Play button. You 
can also listen to the section over which you plan to record in Punch In mode. To stop playing select the 
Stop button at any time.



Record Meters
The Record Meters can be scaled to view differing dynamic ranges by right-clicking on the meters and 
selecting the appropriate range from the shortcut menu. For most recording situations it is probably best 
to select -42 -to 0 dB, as this is the most practical range to view a good record signal. To view very low 
levels, select -90 to 0 dB. This is a good way to measure the amount of noise you have in your system 
due to noisy sound sources and/or poor equipment (such as an inexpensive sound card).

Also in this shortcut menu, you can set the meters to Hold Peaks and Hold Valleys. It is recommended 
that Hold Peaks be checked, as this is a good way to view the peak levels while setting the record level 
(see below). To reset the current peak, single-click on the meter's text output (just above the meters).

Checking Record Levels
Sound Forge XP allows you to check the level of your input source before recording begins. To view your 
levels engage the Monitor check box. The meters will light up in relation to the level of the incoming 
signal. For best results, the level should be somewhere in the yellow range with an occasional red. Once 
your levels are checked you can immediately begin recording by selecting the Record button. If you do 
not see the meters light up, you may have your mixer levels or input source set incorrectly. See 
Troubleshooting for more information on these problems.

Adjusting Levels Using the Peak 
The peak values displayed above the level meters are useful for maximizing your input level without 
clipping. When recording you generally want your input signal to be as hot as possible without clipping. By
this we mean you want your input levels to be as high as possible without exceeding the range of values 
which can be stored digitally when recording. When you clip, the peaks of your waveform become clipped
off resulting in distortion. The peak values show you (in decibels) the highest peak that you have reached 
since hitting the Monitor button.

To adjust your levels, select the Monitor check box so that Sound Forge XP begins to listen to your 
recording device. This is just like recording except that Sound Forge XP doesn't store any of the data it 
receives. Apply an input signal by speaking into your microphone, playing your CD, or whatever it is 
you're trying to record. If the peak value stays at a low value, increase the levels of sound you are 
supplying so that the peak value is somewhere in the -6 dB range. If the peak reaches 0 dB then you 
have clipped and will see the word Clip above each meter. Once you lower your input levels, right-click on
the meters and select Reset Clip to clear the current peak value. Sound Forge XP always keeps the 
maximum peak displayed above the meters or via Hold Peaks.

Once you have adjusted your levels you can immediately begin recording by selecting the Record button 
or end monitoring the levels by un-checking Monitor below the meters.

It is particularly important to record sounds with the hottest levels possible when you plan
to later convert 16-bit data to 8-bit. This assures that you will use the greatest dynamic

range possible in an 8-bit file (which uses fewer values to represent the waveform).



Remote Recording
By selecting the Remote button on the Record dialog you enter into Remote Recording mode. Remote 
Recording mode hides the main Sound Forge XP window and puts up the small Record Remote dialog 
which always stays as the top-most window.

The Remote dialog is a fully functional but condensed version of the regular Record dialog. It's particularly
useful when using applications that control your input sources, sound levels, or CD audio. To return to 
normal record mode from the Remote dialog select the Back button. 

You can access all of the same Record dialog features from the Remote Record dialog
(right-click on the title bar).



Applying Sound Processing Functions
The Effects, Process, and Tools menus include options for applying an effect on the sound data, 
displaying information, or even synthesizing new sounds.

Applying sound processing effects 
Applying an Effect to a Section of the Sound File 
Canceling a Function in Progress 
Applying Effects to Stereo Files 
Getting Help on a function 
Using Controls 
Processing shortcuts 



Applying Simple Processes and Effects
To apply an effect, first select a section of data on which you wish to operate.

If you don't have a selection when you perform an effect which requires one, Sound
Forge XP will apply the effect to the entire file.

To show how effects are used we will once again be using the TUTOR1.WAV file. If it's not currently open,
please open the file now.

Select the Reverse item from the Process menu. The Reverse operation reverses the data selection, 
making it sound like it's playing backwards. Once the operation has finished, press the Play button to hear
how TUTOR1 sounds when played backwards.



Applying an Effect to a Section of the Sound File

1. If you used the Reverse effect, select the Undo Reverse item from the Edit menu to put TUTOR1 
back to its original state. 

2. Now select only the word "Wow" in the window and again select the Reverse item in the Process 
menu. Play the file again and notice how only the word "Wow" is played backwards. After you have 
listened to the effect, undo the reverse again so we can try another effect.

3. Again, let's select only the word "Wow" in the TUTOR1 window. This time after selecting the data, 
select the Volume item in the Process menu. Use the scale factor fader to set the scaling to -6 dB 
(50%). Clicking on the fader and using the up/down arrows will give you more precision. 

4. Now select OK. If you press Play you will notice that the volume is now at 1/2 of its original volume. 
You can undo the last operation by selecting Undo from the Edit menu.

These examples show you how easy it is to apply effects to files. Sound Forge XP has many of different 
processes and effects, ranging from simple volume changes to complex multi-tap reverb/delays. To learn 
about a particular effect, please refer to the Effects, Process, or Tools menus.



Canceling a Function in Progress
While applying an effect, the progress meter at the lower left-hand side of the main screen shows what 
percentage of a selection has been processed while running a function. You can select the Cancel button 
to stop processing the file. When you cancel an operation in progress, the affected data remains in the 
sound file. Undoing the operation will return the file to its original state.



Applying Effects to Stereo Files
In a stereo file, only the selected region in the channel which you've selected is processed. Most functions
can be applied to the left, right, or both channels. The only functions which cannot be applied to separate 
left and right channels are functions which affect the length of the data, since each track in a stereo file 
must be of the same length. These include Insert Silence, Resample, Time Compress/Expand, and Pitch 
Bend.

If you need to run a process like Insert Silence in only one channel, you should divide the stereo file into 
two mono files first, insert the silence, and then join them back together into a stereo file. Separating 
stereo files into two mono files is a good idea if you are going to be changing the duration of each track by
cutting or inserting space to synchronize different events.

Applying a Function to a Single Channel in a Stereo File
Previously, we reversed TUTOR1 so that we could hear how the data sounded when played backwards. 
Now let's try this on a single channel of a stereo file. 

1. First convert TUTOR1 to stereo by right-clicking on the status field which has the word Mono and 
select Stereo from the shortcut menu as we did in a previous section. Make sure to select the Both 
Channels option in the dialog so we have data in both channels of the new stereo file.

2. Select the entire left channel by double-clicking in the upper 1/4 of the TUTOR1 waveform display. If
you select both channels, just use the Tab key to toggle the selection to only one channel. 

3. Now select the Reverse item from the Process menu. You will notice that only the left channel data 
is reversed. 

4. Press the Go to Start button on the playbar to clear the selection and place the cursor at the start of
the file. 

5. Press the Play button and you will hear "Wow, Sound editing is easy" backwards in the left channel 
and forward in the right channel. If you only hear one channel then you are in single channel 
preview mode. To hear both channels use the Tab key to toggle the cursor or selection to 
encompass both channels and again press the Play button.

If you want more information on how to use a function, press the F1 function key while
selecting the function title in the menus. Also, you can press the F1 function key or the

Help button in all function dialogs.



Getting Help on a function
If you want more information on how to use a function, press the F1 function key while selecting the 
function title in the menus. Also, you can press the F1 function key or the Help button while in the function
dialog of those functions with dialogs.



Using Controls
Before going any further, let's become familiar with all of Sound Forge XP's different controls used to 
enter function parameters. Here's a list of controls used in Sound Forge XP:

Vertical Fader and Horizontal Trackbars 
Edit Box Spinner Control 
Drop-down List 
Push Button 
Radio Button 
Check Box 
Envelope Graph 



Vertical Fader and Horizontal Trackbars
To see examples of these common controls, display the Dynamics dialog box. Choose Dynamics from the
Effects menu. The fader controls the Threshold level and the trackbar adjusts the Ratio.

Fader:     Trackbar: 

To change the parameter values, just left-click the box (or "thumb") that slides along the fader or trackbar. 
Drag left and right or up and down to increase or decrease the value.

You can fine tune a control's value by holding down both the left and right mouse buttons
at the same time (or holding down Control on the keyboard) 

There are many keyboard shortcuts when using faders and trackbars. You can use the Up, Down, Left 
and Right arrow keys to change the value in small increments or the Page Up and Page Down keys to 
change the value in larger increments. The Home and End keys change the parameter value to its 
maximum or minimum.

If you double-click on a fader or trackbar thumb, it returns to its reset value (usually 0%, 50%, or 100%). 
Left-clicking on the hash marks in a fader also changes the value by very small increments. 



Edit Box Spinner Control

In the Dynamics dialog, you can edit the Attack time and Release time parameters with edit box spinner 
controls. The edit box is the box containing text, while the spinner is the small control to the right. With 
this type of control, you have several options for changing a parameter value. You can: 

· Type in the number by left-clicking on the edit box and then typing in the value.
· Increment the value by clicking on the two small up/down buttons.
· Use the spinner to change the value. This is done by left-clicking on the center button (between the 

two up/down buttons) and dragging the mouse up or down. Again, holding down both the left and 
right mouse buttons at the same time will cause the values to increment in finer steps. You can also 
use the Up/Down arrows and Page Up/Page Down keys to alter the value.

· Adjust the spinner while holding down both mouse buttons to see the finer increment resolution (or 
hold down the Control key).



Drop-down List

For an example of this control, display the Pitch Bend dialog box. Choose Pitch Bend from the Effects 
menu. To select an item from a drop-down list, click on the drop-down list and select the item. If you have 
to scroll through a large list, click on the scroll buttons or use the arrow keys. The Pitch Bend dialog uses 
a drop-down list to select the channels of a stereo source.



Push Button

To use a push button, left-click on it or press the Spacebar while it is selected. In the Pitch Bend dialog, 
the OK, Cancel, Help, and Reset Envelope controls are push buttons.



Radio Button

Radio buttons always come in groups of two or more. They are used like the radio station selector in a car
radio; turn one on and the rest turn off. For example, the Current operator control in the Simple Synthesis 
dialog is a group of radio buttons.



Check Box

A check box, as its name implies, is a square box you can check or leave blank. They are used to turn a 
feature on or off. The Create Undo and Show Wave controls on the Pitch Bend dialog are check boxes.



Envelope Graph
Use envelope graphs to draw the shape of a frequency or amplitude envelope that will be applied. The 
horizontal axis represents time, with the left-most point specifying the start of the selection and the right-
most point specifying the end of the selection. The vertical axis represents either amplitude or frequency.

·To create a new knob on the graph, left-click anywhere on the line connecting the envelope points and 
drag the knob in any direction, sort of like pulling a rubber band.

·You can delete a knob by double-clicking or right-clicking within it.

·To reset the graph (delete all knobs) click on the Reset Envelope button.

Moving Multiple Envelope Points
It's possible to select and move more than one envelope point at once. Just try:

1. Clicking on an unused section of the Envelope Graph.
2. While holding the mouse button down, drag the mouse. A dotted-line selection square will appear.
3. Move the mouse to surround the needed points with the selection square.
4. Release the mouse button. The selected points will now be colored red.
5. To move all of the selected points, drag any one of the points.

You can also select all points by pressing Control+A when the Envelope Graph is active.

Displaying the Waveform on an Envelope Graph
Some envelope graphs (such as in the Graphic Fade or the Pitch Bend dialogs) allow you to view the 
waveform of the selected data region on the graph. If the selection is small, the waveform is automatically
displayed. Otherwise, you must press the Show wave check box. If you have a stereo file, you can 
choose between displaying the Left channel only, Right channel only, or Mix channels in the drop-down 
list.



Processing shortcuts
To execute a function with the same parameters as the last time the function was used, hold the Shift key 
down while selecting the function. This is known as shift-clicking and works for most operations in Sound 
Forge XP, not just the effects. Shift-clicking works for toolbar buttons, as well as menu items.

You can also use the Repeat item (Control+Y) under the Edit menu to quickly repeat the last operation 
used. This works for all Process, Effects, and Tools functions in Sound Forge XP. Holding down the Shift 
key while selecting Repeat takes you to the last function's dialog.



Sound Processing Techniques
This section covers basic concepts related to some of Sound Forge XP's processing functions used for 
modifying (or creating) sound.

Delay/Echo
Reverb
Chorus
Flange
Noise Gate
Compression
Changing Time Duration
Synthesis
Graphic EQ



Delay/Echo
Delay/Echo creates copies of the original sound which are then mixed with the sound file to create simple 
echo effects.

1. Open TUTOR1.WAV and select Delay/Echo from the Effects menu. Enter 0.4 in the Delay Time field
and choose OK. When you play the sound, you hear a second copy of the sound 0.4 seconds after 
the original. Changing the Delay time determines the time between the original and echoed sound.

2. If you want an echo effect that contains more than a single copy of the original sound, check the 
Multiple delays/echoes box. The Decay time determines how long it takes for these echoes to fade 
out.

3. The Pre-delay/echo function creates echoes heard before the original sound. Use this effect while 
the spaceship in your next sci-fi flick travels back in time by means of a wormhole.



Reverberation
The Reverb function is used to simulate the acoustics of different environments. When a sound is 
generated inside a room, you first hear the original sound, followed by a quick succession of echoes. 
These echoes are the early reflections. Then, as the echoes accumulate, you hear thousands of echoes 
combined into a smoothly decaying reverberation.

1. Open TUTOR1.WAV and select Reverb from the Effects menu. Select the Bright hall button, choose
OK, and play the sound. Notice how the imagined space where the recording took place changes 
from a small studio to a large, rich hall.

2. Now, choose the Metal tank button, choose OK, and play the sound. This option uses a different 
Reverberation mode. Notice how its tone quality is very different – very metallic.



Chorus
The Chorus function is used to simulate multiple sound sources from a single sound. This is achieved by 
mixing a delayed, pitch-modulated copy of itself to the sound source.

1. With TUTOR1.WAV open, select the Chorus item from the Effects menu.
2. Choose the Light effect and play the file to hear an example of chorusing. Then compare this to the 

Echo-vibrato effect, which has a richer, fuller quality.



Flange
Use the Flange function to create the sweeping effects often heard in 60's guitar recordings and techno-
sounds of today.

1. To hear what flanging sounds like, open TUTOR1.WAV and select Flange from the Effects menu.
2. Choose the Slow button and play the file. Then choose Warble to compare the flange effects.



Noise Gate
When recording a sound, you may also record an audible noise floor during silent breaks. Noise is 
generated by many different things, including electrical equipment, machinery, and traffic outside your 
window. When your sound source is much louder than this background noise, it is simple to remove the 
noise during silent breaks, where the noise is most noticeable, with a noise gate.

1. For example, open TUTOR1.WAV. Move the cursor to a location between "Wow" and "Sound" and 
select Insert Silence from the Process menu. 

2. In the Silence Length field, specify 1 second of silence to be inserted at the cursor. 
3. Create a new file. In the new file, choose Synthesis from the Tools menu to generate four seconds 

of noise at -60 dB amplitude. 
4. Choose Noise from the Waveform shape list, enter 2000 in the Frequency field, and drag the 

Amplitude slider until the value is approximately -60.
5. Copy all of the noise on to the clipboard and mix it to the beginning of TUTOR1. To mix, choose 

Paste Special from the Edit menu and select the Mix option. Use 100% for the noise (Source) and 
100% for the voice (Destination). You should now have a file with voice and a relatively low hissing 
sound in the background.

6. To remove the noise during silent breaks, first you should analyze the amplitude of the noise. In 
TUTOR1, select a region with only noise (no voice), and choose Statistics from the Tools menu. 
Take note of the Maximum sample value percentage. If you followed the preceding steps, it should 
be close to -60 dB.

7. Select Noise Gate from the Effects menu. In the Noise Gate dialog, slide the threshold level to a bit 
over the Maximum sample value (in percentage). A value of -50 dB should be high enough to 
differentiate the noise from the vocals. Press OK. Notice that the noise during the silent regions 
should have disappeared (total attenuation). If it didn't, try raising the Threshold level until it does.

8. The other two parameters in the Noise Gate determine how fast the gate will open and close. This 
will affect how the beginning and end of the sound will fade in and out. If the Attack time is too slow,
the beginning of the vocals might get cut off. Likewise, if the Release time is too fast, the end of the 
vocals will be cut. Experiment with these times until you can remove as much noise as possible 
without removing any of the voice.



Compression
Compressing a sound lowers its dynamic range. When you compress a sound, you lower the volume of 
loud sections and then raise the overall volume to compensate. This is done to keep the volume level 
from fluctuating too much over time.

You can use Compression and Normalization together to increase the apparent loudness
of a file. This is currently a popular mastering technique.

1. Open the file TUTMUSIC.WAV. From the File menu, choose Save As, and then save the file with a 
new name, such as Music2. 

2. With the new file active, select Dynamics from the Effects menu.
3. Drag the Threshold level control until you see the value -18 dB. Drag the Ratio control until the 

compression ratio is 2:1. Select OK to see the results of compression in the sound. If you can see 
both files at once and are zoomed out, you'll notice how the levels of the new file are more constant
than the original. Listening should reveal the same thing. 

4. In this example, sounds above the Threshold (-18 dB) are attenuated at an input to output ratio of 
2:1. Sounds below the Threshold are not affected by the compressor. 

5. Undo the previous operation and select Dynamics again. Now, increase the Ratio to 7:1 and select 
OK. The sound will be even more compressed, meaning that more attenuation and boosting will be 
applied to compressed signals. 

Note: Too much compression starting at too low of a threshold level will usually lead to a
distorted sound.



Changing Time Duration
Another Sound Forge XP process unique to digital processing is the ability to stretch or compress the 
time duration of a sound without altering the pitch. This is useful for lengthening or shortening sounds to 
meet a specific time length.

1. Open SAXRIFF.WAV and select Time Compress/Expand from the Process menu.
2. This process is very simple to use. In the dialog, you can specify the final duration of a sound, from 

50% to 500% of the original length. You can select a mode of time compression to match the type of
material you're processing. The Solo instruments mode does a good job with this sound file. Select 
it from the Mode list. Change the Final length from 2.5 to 2.0 seconds (80% of original) and select 
OK. Press the Play button and you should hear the riff played at a faster tempo.

The Time Compress/Expand dialog offers a number of compression modes for various kinds of source 
material. If you have sounds that have few loud, sustaining low-bass frequencies, you can use modes that
will result in no echoes. These include the Drum and Solo Instrument modes. For complex music, you 
must sacrifice some time localization for the ability to reproduce long bass notes.

If you have a drum recording with bass drum, snare, and cymbals, you will find the Drums, unpitched 
(minimum echo) does an impeccable job. However, once you start adding ringing low toms and congas, 
the Drums (better for toms) mode will work better. Again, experimentation is the key. 



Synthesis

Basic synthesis
Use the Synthesis tool to generate a simple waveform of a given shape, pitch, and length.

1. Create a new window by selecting the New item from the File menu and set the data format for the 
window to be 16-bit, 22,050 Hz, Mono. 

2. Select Synthesis from the Tools menu.
3. Select the Sine option from the Waveform shape list. Enter 3 in the Length field and 261.52 in the 

Frequency field. Choose OK to generate a sine wave in the window that is 3 second long and has a
pitch of 261.52 Hz (Middle C). Press the Play button to hear your reference tone.

DTMF synthesis
The DTMF Synthesis tool is used to generate the dial tones used by telephone companies. These dial 
tones correspond to the numbers in a telephone unit, along with other special codes. 

1. To create these tones, choose DTMF/MF Tones from the Tools menu. 
2. Enter a phone number in the Dial string field. The Amplitude control determines how loud the tones 

will be. Press OK to generate the tones. Now when you play back the sound file, you'll hear the 
tones which would dial the number you specified.



Filtering
Filtering Intro 
Graphic EQ 



Filtering Intro
What can you do when you have a sound that is not quite perfect, but not bad enough to throw away? 
Sometimes, judicious use of filtering can keep a favorite sound bite from losing favor. Filtering is not a 
cure-all for bad sound, but slight alterations of a sound can bring it back to life.

Sounds are composed of varying amounts of one or more frequencies. For example, a sound with a rich 
timbre will contain many different frequencies. A sine wave sound has only one frequency in it, like 60 or 
440 Hz.

Filters allow the tailoring of the frequency spectrum of a sound. A spectrum is nothing more than a 
representation of how much of each frequency component (from 20 Hz up to one-half the sample rate) is 
present in a signal. Less of any given component means that the given frequency component is not as 
prevalent aurally as another component. Filters pass or reduce (attenuate) frequency components.

Many factors such as the frequency response characteristic of your speakers and sound card can also 
affect which frequencies are more prominent during the playback of a sound. In general, the goal is to 
make a recording sound as close to the original as possible. However, filtering is also commonly used to 
remove unwanted sounds such as noise, or make individual instruments in a recording sound louder.



Graphic Equalizer
The Graphic Equalizer divides all the possible frequencies into ten bands which you can boost or 
attenuate (cut). Each band has a Center frequency related to it. The 125 Hz band, for example, affects 
frequencies between 90 and 190 Hz. The Gain value above each band indicates the amount of cut or 
boost applied to the band. When a band is set to zero, it means that the frequencies in the band will not 
be modified. Positive gain values indicate a boost and negative values indicate a cut in amplitude.

1. Open TUTMUSIC.WAV and select Graphic EQ from the Process menu.
2. To remove some of the high frequencies from the music, drag the 1K fader to the bottom. Repeat 

the process for all the faders to the right of 1K. Click OK to remove the high frequencies from the 
music file. Press the Play button to hear how the music is much duller.



The Regions List 
In this section, we will go over Sound Forge XP's ability to create regions and markers in a Data Window. 
Each Data Window has its own Regions List stored along with the sound data when using the .WAV file 
format.

Uses for the Regions List

Creating Regions

Editing Regions

Using Markers 



Why use the Regions List?
Fast Navigation
The most basic use of the Regions List is for dividing a sound file into separate named regions. These 
regions can then be quickly played or highlighted in the data window. You can also mark important time 
positions with markers so that you can get around large files faster.



Creating Regions
Creating a Region Using Menu Commands
As with most features in Sound Forge XP, you can create a region in your sound file in a number of 
different ways. One of the simplest ways is to drag a selection from a data window into the Regions List. 

Let's create a region in the file TUTFILL.WAV. Open the file as explained earlier in the manual and then 
open the Regions List window. This window is opened by selecting Regions List from the View menu. You
can also open this window by pressing Alt+1.

To create a region, listen to the file by pressing Play and then select the cymbal crash at the end of the 
file. Next, select the Add command from the Regions List shortcut menu in the Special menu. The Add 
Region/Marker dialog will appear.

Name the region Cymbal Crash and then select OK. A region will be created and placed in the Regions 
List. Each region in the Regions List has a Play button which you can use to play that particular region. In 
addition, Region Tags that show the location of the region are created in the Time Ruler.

Other Ways of Creating Regions
There is also a shortcut menu to let you quickly create regions. Select the beginning part of the sound file 
with the drum roll and then right-click on the ruler. From the Ruler shortcut menu, select Add 
Region/Marker and the Add Region/Marker dialog will appear. Name this region Drum Roll. Notice that if 
you click on Drum Roll or Cymbal Crash, in the Regions List window, the region is selected in the data 
window.

The easiest way of creating regions is to drag them from a data window directly into the Regions List 
window. To do this, select the portion of data between the Drum Roll and Cymbal Crash regions and then 
drag it to the Regions List window and release the mouse button. The Add Marker/Region dialog will 
immediately appear upon releasing the mouse button. Name this region Toms and press OK.

Pressing "R" after a selection is made will create a region as well. This is a very fast method of creating 
regions, however, the Add Regions dialog won't pop up. This means the region will be named 
automatically by its time boundaries. You can change the region name later (see below).



Editing a Region
Changing the end points of a region is as simple as sliding the region tags on the data window ruler 
(above the waveform display). When you left-click on a region tag, the corresponding region end point tag
is also highlighted. Also, the name of the region is displayed in the left side of the status bar. Double-
clicking on a region tag changes the selection points to the region area.

Region edit operations can be performed by right-clicking on the region tags. This brings up the 
Marker/Region shortcut menu. You can then choose from the following options:

Select Modifies the current selection points to be equal to the region end points

Delete Deletes the region, not the sound data, from the Regions List

Edit Takes you to the Edit Marker/Region dialog for manually editing region 
attributes

Update Modifies the region end points to be equal to the current selection

Editing Regions in the Regions List
Another way to edit region points is to double-click on a region name in the Regions List. This brings up 
the Edit Marker/Region dialog, which allows you to type in region parameters. Also, right-clicking on the 
Regions List allows you to choose from various commands in the Regions List shortcut menu.



Using Markers
While regions are used to specify a section in a sound file, a marker is a location in the sound file you 
wish to use as a reference point. Markers make it easier to get around the sound file, as they are often 
used to tag important locations.

Creating a Marker with the Ruler Shortcut Menu
A marker can be created in the same ways discussed earlier for making regions. The quickest way is to 
place the cursor where you want the marker and then right-click anywhere on the ruler. This will bring up 
the Ruler shortcut menu, where you then select the Marker/Region option. In the Add Region/Marker 
dialog, type in a name for the marker and select OK. If you had no selection in the data window, Sound 
Forge XP will automatically create a marker at the cursor position. If you have a selection, Sound Forge 
XP defaults the Type to Region in the Add Marker/Region dialog.

Editing Markers
Markers can be edited in the same way as regions. The marker tags in the ruler can be moved back and 
forth, and shortcut menus appear when you right-click on the tag.

Starting Playback from a Marker Location
To play the sound file beginning at a marker location, press the small Play button to the left of the marker 
name in the Regions List window.

Dropping Markers While Playing or Recording
Another useful feature in Sound Forge XP is the ability to create markers as you listen to the sound file. 
To do so, first start playback on any sound file. A marker will be created each time you press the "M" key 
or the Mark-In toolbar button. When finished, you can then rename each marker to whatever you wish. 
The most accurate method for creating markers during playback is to use the "M" key.

While recording, you can press the Drop Marker button (to the right of the Play button) in the Record 
dialog. Once focus is on this button, pressing the Spacebar will create other markers.



Optimizing Sound Forge XP
This chapter contains information on how to configure your system to maximize Sound Forge XP's 
performance.

Hard-Drive Use
Editing in Direct Mode 
Fast File Saving 
Playback Cursor and Record Counter 
Meters 
Passive Updating for Video and Time Displays 
Audio and Video Synchronization 
Setting up Wave Devices
Background Processing
Crash Recovery



Hard Drive Use
Sound Forge XP is a disk-based sound editor which means that all editing operations are performed on 
your hard drive rather than in your computer's memory. This allows Sound Forge XP to edit sound files of 
almost unlimited size. Sound Forge XP also stores undo/redo information and clipboard data on the hard 
drive.

The drive you specify for Temporary storage (on the Performance page of the Preference folder) must 
have enough free space to store the data for each opened sound file, as well as undo/redo information, 
and the clipboard. Although this can use a lot of disk space, it allows you to edit long sound files that 
could never fit into your computer's memory (RAM). And hard drives are typically much cheaper than 
memory.

Since Sound Forge XP is hard-drive intensive, the faster your disk access, the faster Sound Forge XP will
be. The easiest thing to do to improve your performance without buying new hardware is to defragment 
your hard drive. Over time, and especially with heavy use, a hard drive can become fragmented. This 
means the data stored on the hard drive gets scattered across the surface of the disk making your files 
discontiguous. When files are discontiguous, the hard drive must jump around to retrieve the data. This 
jumping around can slow down access to your files and can be very noticeable on older hard drives. DOS
6.0 and above come with a program called Defrag that will defragment your hard drive. Windows 95 
comes with a Disk Defragmenter utility which can be found in the System Tools folder in your Accessories
folder. 

Windows 95 Default Configuration
Choosing system configuration settings other than the default Windows 95 settings can result in reduced 
performance from Sound Forge XP, as well as Windows 95. To check these settings go to System under 
Control Panel and click the Performance tab. File System and Virtual Memory should both be set to 32-
bit. In the advanced settings area of the window, click on File System. In the File System Properties 
dialog, the Hard Disk tab setting for Read-ahead optimization should be set to Full and the 
Troubleshooting tab should have all of the options unchecked. 

Now, click on Graphics in the Advanced Graphics Settings dialog. In most cases this setting should be set
to Full. If you are experiencing unexplained glitching in your audio playback, try different settings. 
However, if changing these settings doesn't clear up the problem, change them back. Finally, click on the 
Virtual Memory button under the Advanced settings of the Performance page. In most cases, you should 
choose to let Windows 95 handle your virtual memory.



Editing in Direct Mode
Whenever you open a file in Sound Forge XP, a backup copy is created so that the original file is not 
affected until you select to save your work. However, when you open a file as read-only or direct 
(specified in the Open dialog), Sound Forge XP will not create a backup copy of the file, which makes 
opening files quicker and uses less disk space. In fact, editing in direct mode can make opening a file 
almost instantaneous. Direct mode can only be used on files which are 16-bit and stored in the Microsoft 
Wave format.

The first time you open a file in direct mode Sound Forge XP will scan the file to create a peak file. This 
allows Sound Forge XP to display the data in the file extremely fast as well. This peak file is stored in the 
same location as the wave file with the same name as the wave file but with the extension .sfk. After a 
peak file is created Sound Forge XP automatically keeps it updated when you edit the file. The only time 
the peak file may need to be regenerated is if you modify the file with an application other than Sound 
Forge XP. This allows Sound Forge XP to instantaneously load the file next time you open it.

The only drawback to editing a file in direct mode is that you no longer have the security of a backup file. 
In most cases this is not a problem, since all changes can be undone (with ample disk space). But if, for 
some reason, Sound Forge XP terminates improperly, the file would remain in its edited state.



Fast File Saving
When creating a new file Sound Forge XP creates a temporary file that contains all of your new sound 
data. When you are ready to save the file, Sound Forge XP must copy this data into the file you specify in 
the Save As dialog. If you are saving the sound data as a 16-bit Microsoft Wave file, Sound Forge XP can 
make this process almost instantaneous by quickly moving the file rather than copying the data to a new 
file. In order for this to work, the new file into which you are saving your data must be on the same drive 
as your temporary storage folder. Thus it is recommended that you keep your temporary storage folder on
the same drive where you keep most of your sound files. You can set your Temporary storage folder on 
the Performance page in the Preferences folder.



Playback Cursor and Record Counter
The playback cursor and record counter options in the Preferences|Performance folder allow you to 
configure whether or not the numeric counters (position information displayed in status fields) will be 
updated during playing and recording. If you are recording or playing at high sample rates (44,100 or 
48,000 Hz) and are experiencing gapping or skipping problems in the data, try disabling the playback 
cursor and/or record counters to decrease overhead.



Meters
The Record Meters in Sound Forge XP take a small amount of processing overhead during recording. If 
you hear gaps in the sound while recording and you have the Monitor option enabled in the Record 
dialog, try turning off the Record Meters by un-checking the Monitor option.



Passive Updating for Video and Time Displays
Selecting Passive Update for Video and Time Display from the Options menu lowers the priority of the 
repainting for these displays during playback. If your computer is relatively slow and you are experiencing 
gapping during playback, or the your machine just seems to be bogging down during playback, try turning
on Passive Update. This forces the repaints for the Video and Time Display to only update if there is time 
to do so. In most cases you won't even be able to tell if it is missing some updates, so turning these 
options on can decrease the amount of overhead during playback with little inconvenience.



Audio and Video Synchronization
If you are having trouble synchronizing the audio with your video, there are a few points to keep in mind. If
your video has been opened from a slow device, such as a CD-ROM or network drive, then Sound Forge 
XP may have trouble accurately playing back the audio and video in sync. This happens because video 
information is streamed at all times from the original .AVI file. You should always copy the videos you are 
working with to a fast hard drive.

After you open an .AVI file you may be notified that your video has very few key frames. This is generally 
representative of tutorial videos captured with a program that saves the video as a Run Length Encoded 
(RLE) stream with a single key frame. Due to non-linear access requirements of Sound Forge XP this 
may result in difficulty with audio synchronization. It is recommended that you save your file with more key
frames and re-open it for better performance during digital editing.

Here are a few other tips that can help when trying to synchronize the audio and video:

Ÿ After assembling or editing the audio you wish to use with your video, place markers during video 
playback to correspond to any major synchronization points. You can locate a particular frame by 
dragging the cursor along the audio – provided the Video Preview window is open or the Animate 
Video Strip option is enabled. After primary locations have been located, double-click and drag your
audio to these markers bringing up corresponding dialogs for mixes, pastes, and crossfades.

Ÿ Features like Insert Silence and Time Compress/Expand are commonly used to tighten 
synchronization. Another useful trick is to create a region representing the delta between a video 
frame and audio event. Then you can enable the Lock Region Length and drag the delta region to a
preceding silent section. Use the region as a template for adjusting the audio stream length — 
either copying and pasting to insert time or deleting to remove time.



Setting up Wave Devices

The Sound Mapper/Wave Mapper
Sound Forge XP allows you to choose any installed Windows compatible sound card for playback and 
recording. It also provides one more option for playback and record called the Sound Mapper (depending 
on your configuration, this may be called the Wave Mapper). The Sound Mapper is a special device which
attempts to select the most appropriate sound card (map) on which to play a sound, or it will translate the 
sound into a format that can be played on your sound card.

If you are having problems with breakups this may be caused by the overhead introduced when the 
Sound Mapper does format conversions. To check this, make sure that your sound card supports the data
format you are playing or recording. The easiest way to do this is to choose a playback and record device 
that is not the Sound Mapper. If Sound Forge XP is able to play and record the sound using the actual 
sound card's Wave driver, then the Sound Mapper is not causing the breakups.

However, if the Sound Mapper must be selected to play or record the format that you are having trouble 
with, then you should convert your sound data to a format that is directly supported by your sound card. 
This will remove all overhead required to translate the sound data for your sound card.

There is nothing wrong with using the Sound Mapper when the sound data format is directly supported by
your sound card. The Sound Mapper will simply pass the data through to your sound card which requires 
negligible overhead. For more information on the Sound Mapper, refer to the Appendix called Sound 
Forge XP and The Microsoft Audio Compression Manager. The Sound Mapper is a component of the 
Audio Compression Manager (ACM).

Total Buffer Size
The Total buffer size option, found in the Wave folder of the Preferences dialog, specifies the total amount
of RAM that should be used for buffering when recording to or playing from the hard drive. For most 
systems 512 kb is a good number. If you are still experiencing gaps during playback you may want to use 
more buffering or record at a lower sample rate.

There are some drawbacks to increasing the Total buffer size. It requires more of your computer's 
memory and, if you have set a large Preload size, there can be small delays when starting and stopping 
playback.

Preload Size
The Preload size option in the Preferences|Wave folder tells Sound Forge XP how much sound data it 
should prepare and load into your sound card driver before starting playback. This preloading is 
performed between the time you press the Play button and the time you hear the sound play.

Turning this option on may help skipping (audible gaps) on initial playback of a sound. These gaps are 
normally observed by people with slow or fragmented hard drives. The trade-off for enabling this option is 
a slight delay before play begins; the delay time is greater for larger preload sizes. This option does not 
affect operations other than playing.

Some Windows sound drivers do not support this option correctly. If you are experiencing noise or 
dropouts at the very start of playback, try disabling this option.



Background Processing
When Sound Forge XP is performing operations that take a long time, such as opening a file or 
performing audio processing, a Progress Meter is displayed on the status bar. While this Progress Meter 
is visible, Sound Forge XP is doing its work. You can cancel the operation at any time by pressing the 
Cancel button to the left of the Progress Meter, or you can press the Escape key.

All processing performed by Sound Forge XP is done in the background. What this means is you do not 
have to wait for Sound Forge XP to finish its work before you can use other applications. If an operation is
taking a long time in Sound Forge XP, simply switch to another application and work on something else. 
Sound Forge XP will continue processing while you work in another application.

If you minimize Sound Forge XP while it is processing, the percentage processed will update in the title of
the Sound Forge XP icon. This allows you to keep an eye on Sound Forge XP's progress while using 
other applications.

You may have noticed that Sound Forge XP displays the amount of processing time an operation required
in the status bar when it is completed. This processing time is intended for entertainment purposes only–
this value is not intended for accurate profiling. The accuracy of this processing time value is heavily 
dependent on what other activity is being performed by your computer while Sound Forge XP is working. 
Using other applications while Sound Forge XP is working can cause the processing time to increase 
substantially.



Crash Recovery
If for some reason Sound Forge XP is terminated improperly – when Sound Forge XP or, most likely, 
another program crashes – all of the opened and unsaved sound files can be recovered excluding those 
opened in direct and read-only modes. Unless a file is opened in direct or read-only modes, a temporary 
file is created and any edits made are stored in this file. When an improper termination of the program 
occurs, these temporary files remain on your hard drive and can be reopened to recover any work done to
the sound files before crashing. Also, the original sound files will remain unchanged until you save your 
work.

Crash Recovery
When starting the program, any temporary files detected in your temporary file directory will indicate that 
something went wrong. You have the option to delete these files if no important work has been done, or to
just ignore these files. Ignoring the files leaves them intact on your hard drive.

Recover
Use this to change the ending of all file names from FORGExxx.TMP to FORGExxx.WAV. You can then 
open these .WAV files using the File Open dialog. The files will be placed in the directory specified on the 
Storage page of the Preferences folder.

Delete
This command deletes all the temporary files regardless of selection in the drop-down list. Use this only 
when you are sure that no important work is in the file.

Ignore
If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command. However, it is recommended that you either rename the files and check their contents 
or delete them, since they are taking up valuable disk space.



Object Linking and Embedding (OLE)
32 Bit Only: OLE support is only available in the 32 Bit version of Sound Forge XP.

Sound Forge XP for 32 Bit Windows supports Microsoft's Object Linking and Embedding (OLE) 
technology for improved integration with other applications. This section discussing the implementation 
details and different uses for the OLE technology supported by Sound Forge XP. The following topics are 
covered:

Introduction to Object Linking and Embedding (OLE)
Using OLE with Sound Forge XP
Tips, Limitations, etc.



Introduction to Object Linking and Embedding (OLE)
Object Linking and Embedding (OLE) is a technology developed by Microsoft to allow independent 
applications to behave as though they are tightly integrated. Note that this is not an all encompassing 
definition, but it will work for the implementation provided by Sound Forge XP. If you would like a more in 
depth look at OLE, there are many references available at most book stores that discuss the technology.

By using the OLE support in Sound Forge XP, you can embed digital audio files used by Sound Forge XP 
into documents used by other applications (such as Write, Microsoft Word and Excel). Once a digital 
audio file is embedded into a document, you can then edit the audio with Sound Forge XP at any time by 
activating the embedded object (usually by double clicking on it with the mouse).



Using OLE with Sound Forge XP
Sound Forge XP is an OLE server. What this means is Sound Forge XP can create OLE objects (serve 
them up if you will) that can be embedded (inserted) into applications that are OLE containers (the 
consumers of objects supplied by servers). Don't let the terms scare you. We'll go through some 
examples that will make everything clear as mud shortly.

The OLE objects that are created by Sound Forge XP are called Sound Forge XP Audio objects. These 
objects are really just links (oh no, another term!) to a sound file on your hard disk or network server. 
Therefore, when you embed a Sound Forge XP Audio object into Write, you are really only inserting a link
(a directory and file name) to the actual sound file. We will explain why this is important to know in the 
Tips, Limitations, etc. section.

There are three methods that can be used to create Sound Forge XP Audio objects. When we mention an
OLE container, we simply mean an application that can contain OLE objects (like Microsoft Word and 
Excel). The three methods are as follows:

1.Dragging and Dropping a link from the OLE Drag Source control in Sound Forge XP to an OLE 
container.

2.Using the Copy Object Link command in the Edit menu of Sound Forge XP to place an Object Link 
onto the Clipboard. This Object Link can then be Pasted into an OLE container.

3.Invoking the Insert Object command from an OLE container and selecting the Sound Forge XP Audio 
object from the list.

Drag and Drop
The most convenient method of embedding a Sound Forge XP Audio object into a document is to Drag a 
link from the OLE Drag Source control in Sound Forge XP and Drop the link on the document that you 
desire. Note that the application that you drop the OLE object on must be OLE 2.0 compatible. Because 
of this, you cannot drop Sound Forge XP Audio objects on Write so the example below uses Microsoft 
Word for Windows 95 when running on Windows NT.

Follow these steps to embed a Sound Forge XP Audio object into WordPad (Windows 95) or Microsoft 
Word for Windows 95 (Windows NT) using Drag and Drop:

1.Run WordPad (Windows 95) or Word 7.0 (Windows NT).
2.Now run Sound Forge XP and open a sound file (TUTOR1.WAV in your Sound Forge XP directory will

suffice).
3.Ensure that at least a portion of WordPad or Word 7.0 is visible while Sound Forge XP is open (if 

either application is maximized, you will need to restore them and re-size them accordingly).
4.Locate the OLE Drag Source control in the upper right corner of the Data Window. It is on the right 

end of the ruler and contains the letters OLE.
5.Click and hold the left mouse button on the OLE Drag Source control and then Drag the mouse cursor

while holding the mouse button down.
6.Now Simply Drag the mouse over the top of WordPad or Word 7.0 and Drop it (release the mouse 

button). If you did everything correctly, a Sound Forge XP Audio object will now be embedded in 
your document.

A newly created sound file must first be saved before you can drag and drop the object into an OLE 
container. If the sound file in question needs to be saved, you will be prompted to do so when you click on
the OLE Drag Source control.



There is an option in the More page of the Preferences dialog to turn off the OLE Drag Source control 
(hide it). It may be desirable to turn this control off if you do not plan to use the OLE Drag and Drop 
support of Sound Forge XP.

Copy Object Link
Another method for creating a Sound Forge XP Audio object is to invoke the Copy Object Link command 
under the Edit menu in Sound Forge XP. This method is sometimes preferable to the Drag and Drop 
method because you do not need a mouse.

Follow these steps to embed a Sound Forge XP Audio object into WordPad (Windows 95) or Write 
(Windows NT) using the Copy Object Link command:

1.Run Sound Forge XP and open a sound file (TUTOR1.WAV in your Sound Forge XP directory will 
suffice).

2.Select the Copy Object Link command under the Edit menu of Sound Forge XP. If the sound file 
needs to be saved, you will be prompted to do so.

3.At this point, a Sound Forge XP Audio object is on the Clipboard and ready to be Pasted into a 
document.

4.Run WordPad (Windows 95) or Write (Windows NT) and select the Paste command from the Edit 
menu. If you did everything correctly, a Sound Forge XP Audio object will now be embedded in your
document.

Insert Object
The last method for creating a Sound Forge XP Audio object is to use the Insert Object command from 
another application. This method provides a convenient way to get a new Sound Forge XP Audio object 
embedded into a document without having to first create it in Sound Forge XP and copy it into the 
document.

Follow these steps to embed a Sound Forge XP Audio object into WordPad (Windows 95) or Write 
(Windows NT) using the Insert Object command:

1.Run WordPad (Windows 95) or Write (Windows NT).
2.Select the Insert Object command. For WordPad, use the Object option under the Insert menu. For 

Write, use the Insert Object command under the Edit menu.
3.From the Object Type list, select the Sound Forge XP Audio item and click OK. Note that WordPad 

has two options: Create New and Create From File. You will need to select the Create New option.
4. At this time, Sound Forge XP will be run automatically to create the new object. A new window is 

automatically opened allowing you to copy or create any new sound data you wish. Note that you 
must create the sound data in the window supplied.

5. After creating any desired sound data, simply save the modifications and close Sound Forge XP. If 
you did everything correctly, a Sound Forge XP Audio object will now be embedded in your 
document.

After the Sound Forge XP Audio object has been created and embedded into the document, you can edit 
it at any time using Sound Forge XP by double clicking on the object in your document.



Tips, Limitations, etc.
As stated earlier, Sound Forge XP Audio objects are implemented as links to existing sound files on your 
hard disk or network server. Because of this, there are some limitations you should be aware of before 
using the OLE support in Sound Forge XP.

Links can be broken, but not mended
The most important rule to bare in mind when using OLE with Sound Forge XP is that links can be 
broken, but not mended. When you create a Sound Forge XP Audio object, it stores only a link (which is 
simply a directory path) to the sound file. Sound Forge XP uses links because sound files tend to be very 
large and would usually not be acceptable to store along with your documents.

Because Sound Forge XP uses Object Links, moving, renaming or deleting the sound file associated with 
a Sound Forge XP Audio object will break the link. Attempting to edit the object in your document will fail 
because Sound Forge XP will not be able to locate the correct sound file.

To fix a broken link, simply delete the Sound Forge XP Audio object from the document and create a new 
one using the correct sound file.

If you need to move a sound file that is linked to a document, you can use Sound Forge XP to save the 
file to a different location and the object link will automatically be updated. However, you must open the 
sound file that you want to move as an object for this feature to work. To open a sound file as an object, 
simply double click on the Sound Forge XP Audio object in your document; do not open the sound file 
directly. You can then use Save As to move the sound file. Sound Forge XP will prompt you about 
updating the object link after saving the new file.

Sound files do not travel with your documents
When you copy a document that contains one or more Sound Forge XP Audio objects to another 
computer, the sound files that are linked to the objects are not copied with the document. If you need to 
copy a document to another computer, you will need to copy all sound files associated with it as well. 
However, you must also ensure that the sound files have the exact same path on the new computer as 
they did on the old computer.

Using a Network Server
To ease the problems associated with moving or sharing documents between computers, it is suggested 
that you use a network server to store all sound files that are embedded in the documents. If you do this, 
all computers that have access to the network server will be able to open and edit the Sound Forge XP 
Audio objects.

There are two methods of ensuring a common network server will work with shared documents. The first 
is to make sure you use the same drive letter when connecting to the network server on all machines. 
Remember that the full path must remain constant between computers.

The second and more preferable method is to use Universal Naming Convention (UNC) paths when 
embedding Sound Forge XP Audio objects into your documents. A UNC name looks like this:

\\server\share\<directory and file name>

Therefore, if your sound files are stored on \\myserver\sounds, then open them in Sound Forge XP using 
UNC path names rather than a drive letter. You can then create the Sound Forge XP Audio object using 
either the Copy Object Link command or the OLE Drag Source control and embed the sound files into 
your documents. By using UNC names, you eliminate the need to use a common drive letter on all 
computers that share the document.

If you are running Windows 95, UNC path names are extremely simple to use. Instead of using a drive 



letter when browsing in the File Open dialog, select Network Neighborhood in the Look In field and 
browse to the appropriate network server and share containing your sound files. This method of browsing 
uses UNC names exclusively.

Sound Forge XP is not an OLE Container
Although Sound Forge XP can create OLE objects to embed in other applications, the inverse is not true. 
Therefore, OLE objects created by applications such as Microsoft Word or Excel cannot be embedded 
into sound files open in Sound Forge XP.



File Menu
New 
Open 
Close 
Save 
Save As 
Save All
Properties 
Send
Exit



New
The New command creates a new sound data window.

Sample Rate
Select a standard sample rate from the drop-down list or type in a custom rate.
Sample Size
Check the button to select whether the new data will be 8-bit or 16-bit.
Channels
Check the button to select whether the new data will be mono or stereo.
Maximum Editing Time
Shows the maximum time currently available on the hard drive for editing a file of the specified type. 
Note that files open in Sound Forge XP are edited in 16-bit format and are only converted to 8-bit or 
compressed audio when closing the file.

Using the New toolbar button (or holding the Shift key down while selecting New from the
menu) will skip the New dialog and use the previously selected Mono/Stereo, 8-bit/16-bit,

and Sample Rate settings.

Shortcut
Control+N
Drag and drop a selection to the Sound Forge XP desktop to create a new file from the selection.
Selecting a portion of the Sound Forge XP desktop will create a new file with the most recently used 
attributes.

                                                         
See also
File Menu
Creating a New Window
Drag and Drop Operations



Open
Use this command to load a sound file into Sound Forge XP in Windows 95. If you are running Windows 
3.x, go here.

Look In
Lists available drives and directories.
File Name
Type the File name you want to open or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.
Files of Type
Shows the type of files displayed. Choose a type from the drop-down list. If you select All types (*.*), 
Sound Forge XP will try to auto-detect the file format.
If you know that the file format is unsupported, select Raw File (*.*). Choose OK to see the Open raw 
data file dialog where you'll be able to specify format parameters.
MRU Folders
Lists the most recently used directories. Use to speed the opening of regularly used files in different 
folders.
Open as Read-only
When checked, the sound file will be opened but you will not be able to alter the sound data in the file. 
This feature is useful if you only need to play the file or copy sections from the file. You can still change 
the Summary information for the file, but these changes must be saved to a new file.

When you open a sound file, Sound Forge XP defaults to whichever edit mode you last
selected (either Open as read-only or Operate directly on the sound file). You can change

modes in the Open dialog.

Operate Directly on the Sound File
When checked, the sound file will be opened for editing but with no temporary file created. This greatly 
speeds the opening process but doesn't give you the security of a backup file. In most cases this is not 
a problem since all changes can be undone (if you have enough disk space), but if, for some reason, 
Sound Forge XP terminated improperly the file would remain in its edited state.

Whenever you open a file in Sound Forge XP, a backup copy is created so that the
original file is not affected until you elect to save your work. When you open a file as
read-only or direct, Sound Forge XP will not create a backup copy of the file, which

makes opening files quicker and uses less disk space.

AutoPlay
When checked, a file selected in the window will automatically begin playback without opening it in 
Sound Forge XP.
Play
Auditions the sound file without opening it in Sound Forge XP. If playing a file from a slow network or 
CD-ROM, some skipping might occur. This feature is only available for .WAV files.
More
Select a file and then choose the More button to see the general properties of the file.

Shortcut
Control+O
Control+F12
Control+Alt+F2
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Open (Windows 3.x)
Use this command to load a sound file into Sound Forge XP in Windows 3.x. If you are running Windows 
95, go here.

Drives
Lists available drives. Select a new drive from this drop-down list.
Directories
Lists available directories. Select a new directory from this drop-down list.
List Files of Type
Select the type of file you want to open. If you select All Types, Sound Forge XP will automatically 
identify the format of a sound file if it can.
File Name
Type the file name you want to open or a *. and an extension to see a list of files with the corresponding
extension in the current directory.
MRU Folders
Lists recently used folders. Use to speed the opening of regularly used files.
Read-only
When checked, the sound file will be opened but you will not be able to alter the sound data in the file. 
This feature is useful if you only need to play the file or copy sections from the file. You can still change 
the Summary information for the file, but these changes must be saved to a new file.

When you open a sound file, Sound Forge XP defaults to whichever edit mode you last
selected (either Open as read-only or Operate directly on the sound file). You can change

modes in the Open dialog.

Direct
When checked, the sound file will be opened for editing but with no temporary file created. This greatly 
speeds the opening process but doesn't give you the security of a backup file. In most cases this is not 
a problem since all changes can be undone (if you have enough disk space), but if, for some reason, 
Sound Forge XP terminated improperly the file would be remain in its edited state.

Whenever you open a file in Sound Forge XP, a backup copy is created so that the
original file is not affected until you elect to save your work. When you open a file as
read-only or direct, Sound Forge XP will not create a backup copy of the file, which

makes opening files quicker and uses less disk space.

AutoPlay
When checked, a file selected in the window will automatically begin playback without opening it in 
Sound Forge XP.
Play
Auditions the sound file without opening it in Sound Forge XP. If playing a file from a slow network or 
CD-ROM, some skipping might occur. This feature is only available for .WAV files.

Shortcut
Control+O
Control+F12
Control+Alt+F2
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Open raw data file
This dialog box is reached when you select Raw from the List of File Types in the Open dialog. Use this 
to open a file that is not stored in one of the standard sound file formats supported by Sound Forge XP.

Sample Rate (2,000-96,000 Hz)
Sample playback rate which will be used by Sound Forge XP when playing the file.
Sample Type
Format used to store each sample.

8 Bit PCM
Uncompressed linear format.
16 Bit PCM
Uncompressed linear format.
G.711 u-Law
Compressed format commonly used for telecommunications in the United States.
G.711 A-Law
Compressed format commonly used for telecommunications in Europe.

Format (Unsigned, signed, sign bit)
Shows the sample format that the data is stored as. Samples are most often saved in the PCM format.
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian is used by Intel 
microprocessors, while Big Endian is used by Motorola microprocessors.
Header Bytes
Number of bytes stored in the file before the sound data.
Trailer Bytes
Number of bytes stored in the file after the sound data.
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Open Video Stream
This dialog is reached when you select an .AVI file that has multiple audio or video streams. It allows you 
to select a particular video stream and an audio stream to open in Sound Forge XP. Most .AVI files have 
just one video stream and one audio stream, in which case this dialog doesn't appear.

Stream
The black diamond on the left side of a stream indicates that it has been selected to be open. If you 
have more than one audio stream or video stream, click on the left of the stream to select it for opening.
Additional information about each stream is available by clicking on the + area to expand the list.
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Close
Use this command to close the current sample data window. If the data has not been saved since the last 
edit you will be asked if you wish to save your changes.
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Save
Use this command to save the current sound data. If the data is new data which was not retrieved from a 
previous file or was loaded from a format which is not supported for saving, you will be prompted with the 
Save As dialog. The Macintosh Resource (SND) format is not supported for saving. If you need to export 
sound files to a Macintosh, use the Macintosh AIFF format.

Shortcuts
Control+S
Shift+F12
Alt+Shift+F2
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Save All
Use this command to save all the currently opened files. You will be prompted for each unsaved file. If you
hold the Shift key down when selecting this command, no prompts will be displayed.
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Save As
Use this command to save the current sample data in a different file and/or file format. The Macintosh 
Resource (SND) format is not supported for saving. If you need to export sound files to a Macintosh, use 
the Macintosh AIFF format.

Save in
Choose the appropriate drive and folder for the file you want to save.
File name
Type the name of the file in which you want to save the current sample.
Save as type
Select the type of file to which you would like to save, such as Wave (Microsoft *.wav).
MRU Folders
Lists the most recently used directories. Use to speed the opening of regularly used files in different 
folders.
Format
Shows the sample format in which the data will be saved. Samples are most often saved in the PCM 
format. However, other formats are often used for compression purposes. You can save files in a variety
of compressed formats including the Microsoft ADPCM format.
When saving as a Raw file, other options are available after choosing OK in this dialog box.
Attributes
Sample Rate, sample size, and stereo/mono. Here, you can change the sample size (8 or 16 bit) that 
the file will be saved as. You can also convert a file between mono and stereo formats. When you 
convert from mono to stereo, the data will be stored in both channels. When converting from stereo to 
mono, the data will be mixed to a single channel.
Save Regions and Markers in .WAV files
Check this box to save any regions and markers in the .WAV file.
Save Summary Information in file
Check if you want Summary information (such as author and copyright) stored in the WAV file.

Only data formats supported by the selected File Type are listed in the Format drop down
list box. Other file types are available when saving a file as Raw data.

Shortcut
Alt+F2
F12
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Save As Raw Data File
This dialog box is reached when you select Raw from the Format list in the Save dialog. Use this to save 
an opened file into a file format that is not one of the standard sound file formats supported by Sound 
Forge XP.

Name
This list of file formats contains preset versions of raw file storage formats commonly used by other 
applications. You can create a new file format by using the Save As button to save the current storage 
parameters.
Sample Type (8-Bit PCM, 16-Bit PCM, G.711 u-Law, G.711 A-Law)
Format used to store each sample.
Format (Unsigned, Signed, Sign bit)
Binary format of each sample. 
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian (low, high) is used by 
Intel microprocessors, while Big Endian (high, low) is used by Motorola microprocessors.
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Video Save Options
This dialog is reached when you select Video for Windows (.avi) from the Save as type list in the Save As 
dialog. In this dialog, you can select which video streams you wish to save and edit the title, language, 
and priority of the saved streams.

Streams
Check the streams that you want to save. The black diamond next to each check box indicates 
currently opened streams.
Additional information is available by clicking on the + area to expand the list. This information can be 
edited by right-clicking on a field and selecting Edit.
Save Audio to New Stream
If this option is checked, the audio track currently open in Sound Forge XP will be saved to a newly 
created stream.



Compression Options
This dialog is reached when you select Microsoft .AVI from the Format list in the Save As dialog and then 
press OK in the Video Save Options dialog.

Choose a Stream
Check the audio or video stream for which you want to set the compression formats.
Interleave Frames
When checked, selects how the audio and video streams will be interleaved. Interleaving the audio and 
video streams improves playback performance when using storage devices that are more efficient at 
providing data sequentially (such as CD-ROM disks). The Frames value indicates the interval between 
video and audio segments. The default is 1 for CD-ROMs, but can be increased for faster media.
Options
Press this button to view and/or edit the audio and video compression options for the selected stream.



Video Compression
This dialog is reached when you select Microsoft .AVI from the Format list in the Save As dialog, press 
OK in the Video Save Options dialog, and after selecting a stream pressing the Options button in the 
Video Compression dialog.

Compressor
Select a compression format from any of the installed .AVI compression schemes. Compression 
formats are available from different vendors (not from Sonic Foundry), and also come included with 
Windows.
If the file is already compressed, you should select No Recompression. This will be faster and will also 
avoid the loss of quality inherent in most recompression.
Compression Quality (0 to 100)
Determines the final output quality. Usually, higher quality (close to 100) means less compression and 
fewer visual artifacts.
Key Frames Every
Some compression formats are based on key frames (sometimes called temporal compression). A key 
frame is a frame which is usually less compressed. Compressed frames that follow a key frame are 
smaller but slower to draw. This option is only relevant to video streams.
A high number of key frames increases quality, but decreases compression. Also, if the number of key 
frames is very low, it will takes a long time to perform decompression when drawing the video strip or 
moving randomly through the file.
Data Rate (Kilobytes per second)
Determines the data rate which will be required to play the compressed stream in real time. Lower data 
rates are less demanding on computer systems than higher rates. If the data rate is too high for a 
certain computer (usually because of a bottleneck such as a slow CD-ROM, network, or hard drive) the 
quality begins to suffer and glitching can occur.
Configure
Press this button to set more detailed configuration parameters specific to the compression scheme 
being used. Not all compressors provide this options.
Preview
Press this button to view a preview of the final output.



RealMedia Save Options
This dialog is reached when you select RealMedia (*.rm;*.ra) from the Save as type list in the Save as 
dialog. This feature is only available for Windows 95 and NT running on x86 processors.

Enable Selective Record Capabilities
When checked, RealMedia-compatible players can allow users to save (record) RealMedia streams to 
their hard drives. Use this option only if it is acceptable for users to create copies of the RealMedia file. 
The RealPlayer Plus from Progressive Networks supports Selective Record capabilities.
Enable PerfectPlay Capabilities
When this option is enabled, users connected with standard modems can select to download a higher 
quality version or the audio and/or video that is normally only available over ISDN or LAN connections. 
The higher bandwidth RealMedia stream is then played back from the user's hard disk after the 
download process is complete. The RealPlayer Plus from Progressive Networks supports PerfectPlay 
capabilities.
Create Event File (RAE) from Marker and Region Labels
When this option is enabled, events can be embedded from the Regions List (View menu) into the 
RealMedia stream.
To embed an event, create a marker or region with a label starting with one of the below prefixes 
followed by a colon.
·RM URL: Specifies a URL (web address) to open.
·RM Title: Sets the Title field in the RealPlayer.
·RM Author: Sets the Author field in the RealPlayer
·RM Copyright: Sets the Copyright field in the RealPlayer

For example, if you create a marker with the label RM URL:http://www.sonicfoundry.com, the 
RealPlayer would open the Sonic Foundry home page at the marker's location in the file during 
playback. You can just as easily open specific web pages. For example, RM 
URL:http://www.sonicfoundry.com/realaudio.html would open the realaudio.html page on Sonic 
Foundry's web site.
Progressive Networks publishes extensive information on RealMedia events on their web site 
(www.real.com). However, Sound Forge XP is capable of generating all event files automatically rather 
than requiring several tools as described in Progressive Networks' documentation.
Save Audio Stream
When checked, the file's audio stream will be converted and saved into the RealMedia file.
Audio Compression
This option selects the RealAudio compressor that is used when saving the file. If you need to save 
RealAudio files with Bandwidth Negotiation capabilities, you can automate the process using Sonic 
Foundry's Batch Converter Plug-In (available for Sound Forge 4.0 only).
When a compression type is selected, a brief description of it is displayed below the list box. The 
frequency response parameter of the description indicates how wide, in Hertz, the bandwidth of the 
audio in the RealMedia file will be. The bandwidth of a normal human's hearing is about 20,000 Hz or 
20 kHz.
Stereo to Mono Conversion
If the source audio file is stereo and you choose to convert to a mono RealAudio format, you will need 
to decide what channel(s) to use for the mono signal. Selecting Both channels will evenly mix the signal
together. If you are unsure of this option, always choose Both Channels.
Save Video Stream
When checked, the file's video stream will be converted and saved into the RealMedia file.
Video Compression
Currently there are two types of RealVideo compression: RealVideo (Standard) and RealVideo 
(Fractal). Each type is optimized for different types of video and transfer rates. Detailed information on 



the two types is available on the RealMedia home page (www.real.com).
Video Compression Quality (1 to 100)
This option allows you to compromise between quality of compression and lowest possible data transfer
rate. Setting this level at 100 provides the best quality video with the greatest required bandwidth to 
stream. A setting of 1 gives you the lowest quality video but requires the least bandwidth to stream 
effectively.
Frames per second (0.050 to 1000)
This setting allows you to change the frame rate of the video that is being compressed. A lower frame 
rate, such as three or five frames per second, will greatly lower the bandwidth requirements for 
streaming the video. Just type the desired frames per second into the edit box, or choose one of the 
presets from the drop-down list.
Desired maximum data rate (1.0 to 500.0 Kbps)
This setting is available only if you are saving a video stream. The data rate specifies the desired total 
kilobits per second (Kbps) for the RealMedia file (including audio and video). To increase the bandwidth
available for streaming the video, you can either lower the data rate for the audio, or increase the 
desired maximum data rate. Note that you must allow some room for inconsistent transfer rates. For 
example, a 28.8 modem cannot sustain 28.8 Kbps. Instead, you should target your maximum data rate 
for between 20.0 and 22.0 Kbps. The allowed data rates are displayed next to the Audio/Video 
compression options. After the file has been saved, statistics about the actual data rate will be 
displayed. Use this information to adjust parameters as necessary.
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ASF Save Options
This dialog is reached when you select Active Streaming Format (.asf) from the Save as type list in the 
Save As dialog. This feature is only available for Windows 95 and NT platforms.

Maximum Lead Time (milliseconds)
Defines the lead time, if any, that the NetShow On-Demand player should buffer before starting 
playback. The default is 1,000 milliseconds. The lead time can affect the bit-rate that is calculated for 
the ASF file. Some video codecs may require that the lead time setting be increased to achieve the 
desired low bit-rate for the ASF stream. The VDOnet codec, for example, works best with a setting of 
5000.
Marker and Region Labels
Specifies how Marker and Region labels should be used when saving the ASF file. Not only can 
markers specify locations in the ASF file for seeking purposes, but the labels can also identify 
commands for the NetShow Player.

ASF <ScriptCmd>: Specifies a user-defined script command event
ASF URL: Specifies an URL (web address) to open
ASF Filename: Specifies an .ASF file to chain to at the specified point
ASF Title: Sets the Title field in the NetShow On-Demand player
ASF Author: Sets the Author field in the NetShow On-Demand player
ASF Copyright: Sets the Copyright field in the NetShow On-Demand player

For example, if you create a marker with the label ASF URL:http://www.sfoundry.com, the NetShow On-
Demand player would open the Sonic Foundry home page during playback at the marker's location in 
the file. You can just as easily specify web pages, images, etc. For example, ASF 
URL:http://www.sfoundry.com/netshow.html would open the netshow.html page on Sonic Foundry's web
site.
In addition, the example ASF CAPTION:What a fine day specifies a user defined script command 
CAPTION with the parameter "What a fine day". The NetShow On-Demand client will fire a Visual Basic
event into the browser or container of the NetShow control. The event type can be processed as type 
"CAPTION" and the description parameter of the event would be the "What a fine day" text that could 
then be printed for the user, perhaps synchronized with an audio or video segment.
Microsoft publishes information about the NetShow control and ASF commands on the NetShow web 
site (http://www.microsoft.com/netshow). There are also extensive samples on the web site and in the 
SDK. However, Sound Forge XP is capable of generating all commands automatically rather than 
requiring several tools as described in Microsoft's documentation.
Enable Error Correction (8 + 1 parity)
Enables error correction for low bandwidth files (not greater than 150 KB per second). The error 
correction information is used by the NetShow Player to recover from bad transfers that are common on
low bandwidth connections (especially modems using standard phone lines). For high bandwidth 
content (greater than 150 KB per second), error correction is automatically disabled since the reliability 
of the connections required for these files is substantially better.
Enable Wavespan for Audio Only Streams
This option is used to enable a tradeoff between more efficient handling of larger audio objects and 
better interleaving of client processing time with smaller audio objects. For most audio codecs, this 
option should remain unchecked. However, some newer codecs may require this option to be checked 
for proper playback.
Change Video Compression Options
This option is only available when saving files that contain video. When you check this option, Sound 
Forge XP will display a video Compression Options dialog (see above section on Compression 
Options) after clicking OK. The Compression Options dialog allows you to redefine the compression 
algorithm (codec) used for the video when saving the ASF file.



Frames per second (0.05 to 1000)
This setting allows you to change the frame rate of the video that is being compressed. A lower frame 
rate, such as three or five frames per second, will greatly lower the bandwidth requirements for 
streaming the video. Just type the desired frames per second into the edit box, or choose one of the 
presets from the drop-down list.
Packet Size (512 to 57,344 bytes)
This option is only available when saving files that contain video. If a specific packet size is desired for 
the ASF file, you can specify the requirements here. Changing the packet size can affect how efficiently 
ASF packets are transmitted and processed. Unless required, it is recommended that the default value 
be used.
Wavespan (400 to 5,000 milliseconds)
This option is only available when saving files that contain video. If a specific wavespan is desired for 
the ASF file, you can specify the requirements here. Wavespan is the minimum length (in milliseconds) 
of audio objects that are manipulated by NetShow. This value is a tradeoff between more efficient 
handling of larger audio objects and better interleaving of client processing time with smaller audio 
objects. Most users will not need to change this option.
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Properties
The Properties folders list attributes and information which is embedded in the currently active sound file. 
The available Properties folders are:

General 
Summary Info 
Format 
Video 
Display 
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General Properties
This folder contains technical information regarding the current sound file, including size, location, file type
and attributes of the file.

Microsoft .WAV files are composed of sections called RIFF chunks. These chunks contain the sound data 
plus other embedded information. If there are any non-standard chunks found in the current file, the junk, 
padding, and additional chunks fields will be checked. These chunks might be used by other sound 
utilities, or might just be garbage which can cause problems like glitching in some less intelligent 
programs.
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Summary Information Properties
This folder contains extra information that can be embedded in the sound file, about the sound file. It is 
only available in .WAV, .AVI, .RA, and .ASF files.

Title, Subject, Engineer, Copyright, Comments
Commonly used fields you can quickly edit. To view and edit all other fields, press the Extended button.
Picture
Allows you to select an icon, bitmap or cursor to be attached to the current file.
Load
Sets all of the fields to the default values. The default values can be set in the Extended Summary  
dialog box.
Extended Summary
Allows you to view and edit all available summary fields.

Fields
To edit a field, you must first select it from the Fields list. The check appearing to the left of the 
type tells whether this field is currently enabled for saving to the WAV file. If the check is not 
shown, the field will not be written to saved files. To change the state of the check, click with the 
left mouse button in the area immediately to the left of the type or double click on the entry.
If the field for a type currently has no text associated with it the word (Empty) will appear to the 
right of the type in the list box. Empty fields are not saved.
Contents
Shows the text associated with the selected field. The text can be changed by typing in this box.
Default
Sets the default fields to the current file's field information. Use this to save information which will
be used in a number of different files, like copyright and engineer information at your recording 
site. 
Load
Sets the current file's summary information fields to the default settings.

Shortcut
Double click on the right-most field of the Status Bar
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Attach Picture
Use this dialog to select a bitmap (.bmp), cursor (.cur), or icon (.ico) to embed in the current sound file.
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Format Properties
Use this folder to change the data format of the current data window. This includes Sample rate, Sample 
size (bits per sample), and Stereo/Mono.

Sample Rate
The playback rate can be set from 2,000 Hz to 60,000 Hz by entering the rate you wish to use. You may
also select the most common sample rates by using the drop-down list. Note that this will not resample 
the sound file. If the playback rate is different from the originally recorded rate, the pitch will vary unless 
resampling is done.
Sample Size
Select 8-or 16-bit for the sample size.
Channels
Select Mono or Stereo for the number of channels.
Cursor Position
Displays the cursor position in the sound file using the current units.
Sample Value
Displays the sample value at the current cursor position in the sound file. For 16-bit audio, this value 
ranges from -32768 to 32767. For 8-bit audio, it ranges from -128 to 127.
Peak Data Ratio
Ratio at which the peak data is stored. This means that when zoomed out beyond 1:512, the peak file, 
instead of the entire file is scanned when drawing the waveform.
Sound Data Size
Amount of storage space being used by the sound data.
Video Source Format
Frame size (height, width, bits per pixel) and compression algorithm of the original .AVI file.
Video Decompression Format
Intermediate frame size (height, width, bits per pixel) and compression algorithm used by Sound Forge 
XP before displaying the video frames. The video decompression mode can be changed from the 
Performance page in the Preferences folder.
Undo buffers
Number of Undo buffers currently existing for the sound file and the amount of hard-drive space they 
consume.
Redo buffers
Number of Redo buffers currently existing for the sound file and the amount of hard-drive space they 
consume.

Shortcut
Alt+Enter
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Video Properties
This folder contains information specific to Microsoft .AVI files. If your sound file does not currently contain
any video, you can attach a video from an .AVI file by pressing the Attach button.

An .AVI file can contain multiple video and/or audio streams (or tracks). For example, you can include 
multiple audio tracks in different languages to go along with a video. When playing back, Microsoft's 
Media player detects what language the operating system is set to and plays the corresponding video 
stream.

Stream
Displays information about the video and/or audio streams present in the .AVI file, such as name, 
compression format, frame rate, and language.
The black diamond to the left of the streams indicate the active streams. You can view and edit 
additional information (stream name, language, and priority of the active audio stream) by clicking on 
the + sign to expand the list. Right-clicking on a field allows you to edit it.

Streams that are checked will be preserved when the file is next saved. Streams that are not checked will 
be deleted when the file is next saved.
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Display Properties
This folder allows you to change how the data window of the sound file appears on the Sound Forge XP 
workspace. Checking a box will display that item in the current sound file's data window. An unchecked 
item will not be displayed. 

To set the current settings as the default display for all sound files, simply check the Save as the default 
for all new windows check box.

Shortcut
Edit Tool Selector Shortcut Menu 
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Send
Use this command to send the current sound file via electronic mail.

This option is only available in the 32-bit version of Sound Forge XP.

Sends a mail message with an attached sound file. Note that you must have electronic mail (email) 
capabilities to use this feature. When you select the Send command, your email program opens with a 
new message and embeds the active sound file from Sound Forge XP in the message. You then have the
option of sending the new mail message to the desired recipient.

When a sound file is embedded into a mail message, the entire contents of the sound file are inserted into
the message. To do this requires that any modifications to a sound file be saved before the message can 
be sent. Sound Forge XP will prompt you to save the file if this is necessary.

Sound files are generally very large when compared to text files. An email message
containing an embedded sound file can take a considerable amount of time to send and

receive, especially if you are using a modem and not a high-speed network.
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Exit
Use this command to exit Sound Forge XP. You will be asked whether you would like to save any sound 
files you have modified during the editing session.
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Temporary File Cleanup
If for some reason Sound Forge XP is terminated improperly – when Sound Forge XP or, most likely, 
another program crashes –    all of the opened and unsaved sound files can be recovered excluding those
opened in direct and read-only modes. Unless a file is opened in direct or read-only modes, a temporary 
file is created and any edits made are stored in this file. When an improper termination of the program 
occurs, these temporary files remain on your hard drive and can be reopened to recover any work done to
the sound files before crashing. Also, the original sound files will remain unchanged until you save your 
work.

Crash Recovery
When starting the program, any temporary files detected in your temporary file directory will indicate that 
something went wrong. You have the option to delete these files if no important work has been done, or to
just ignore these files. Ignoring the files leaves them intact on your hard drive.

Recover
Use this to change the ending of all file names from FORGExxx.TMP to FORGExxx.WAV. You can then 
open these .WAV files using the File Open dialog. The files will be placed in the directory specified on 
the Storage page of the Preferences folder.
Delete
This command deletes all the temporary files regardless of selection in the drop-down list. Use this only 
when you are sure that no important work is in the file.
Ignore
If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command. However, it is recommended that you either rename the files and check their 
contents or delete them, since they are taking up valuable disk space.



Mono to Stereo
When converting a mono (single channel) file to a stereo (two channel) file, you must specify what 
channel or channels of the stereo file the mono data should go to. This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading mono material into a stereo file.

Left Channel
The mono sound data is placed only on the left channel of the stereo file.

Right Channel
The mono sound data is placed only on the right channel of the stereo file.

Both Channels
The mono sound data is placed on both the right and left channels of the stereo file.



Stereo to Mono
When converting a stereo (two channel) file to a mono (one channel) file, you must specify what channel 
or channels of the stereo data should go to the mono file. This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading stereo material into a mono file.

Left Channel
Only the left channel of the stereo file is used in the operation.

Right Channel
Only the right channel of the stereo file is used in the operation.

Mix Channels
The left and right channels are mixed together to perform the operation.



Attach video
This dialog box allows you to select an .AVI file from which a video stream will be attached to the current 
sound file.
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Edit Menu
Undo 
Redo 
Repeat
Cut 
Copy 
Copy Object Link
Paste 
Paste Special|Crossfade 
Paste Special|Mix 
Paste Special|Overwrite 
Paste Special|Replicate 
Paste Special|Paste to New 
Trim/Crop 
Clear/Delete 
Select All 
Tool|Edit 
Tool|Magnify 
Tool|Pencil
Go To 
Selection 
Undo All 
Disable Undo/Redo 



Undo
Use this command to undo the last edit operation. For instance, if you deleted a section of data by 
accident, simply choose the Undo option from the Edit menu to put the data back.

You can also undo operations by choosing Undo/Redo History from the Special menu.

Tips
When working on large files, it takes Sound Forge XP a longer period of time to create an undo buffer. To 
save time and file space, you can disable the undo by selecting the Disable Undo item under the Edit 
menu or from within most processing functions.

Shortcuts
Control+Z
Alt+Backspace
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Redo
Use this command to re-perform an undone event. For instance, if you decide that you really did want to 
delete that selection of data, select Redo and the undo will be undone.

You can also redo operations by choosing Undo/Redo History from the Special menu.

Shortcut
Control+Shift+Z
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Repeat
Use this command to repeat the last performed operation. This can be used with most processing 
functions. The last dialog settings will be used unless you hold down the Shift key, which allows you to 
change the operation's dialog parameters.

Shortcut
Control+Y to repeat last operation with the last used dialog box options
Control+Shift+Y allows you to change the dialog settings before repeating
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Cut
Use this command to remove selected sample data and put it onto the clipboard. This command has no 
effect if there is no selected data. Cutting sample data replaces the previous contents of the clipboard.

Cutting data from the beginning of a very large file will take a long time to process. This is because large 
amounts of data need to be moved.

Note: You cannot cut from a single channel in a stereo file since the two channels in a stereo file must 
always be equal in length. To shift a single channel in time, use the Delay/Echo function in the Effects 
menu. 

Shortcuts
Control+X
Control+Del

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Copy
Use this command to copy selected sample data onto the clipboard. This command has no effect if there 
is no selected data.

Shortcuts
Control+C
Control+Insert
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Copy Object Link
32 Bit Only: This option is only available in the 32 Bit version of Sound Forge XP.

Use this command to copy an object link for the active sound file onto the clipboard. You can then Paste 
(or Paste Special) the Link into another application (such as Microsoft Word or Write) that supports Object
Linking and Embedding (OLE). This feature is useful for embedding sound files in documents.

Object links are simply references to existing sound files on your hard disk or network server. If you 
embed an object link to a sound file in a document, the sound file is not actually inserted into the 
document, just a reference. Therefore, if you copy the document to another computer, any sound file(s) 
that are embedded will not be available on the other computer unless the sound file is stored on a 
common network server.

If you intend to share documents between computers that contain embedded sound files, it is suggested 
that you store all sound files on a network server and embed them using Universal Naming Convention 
(UNC) path names. For example, if your server and share name for sound files is \\myserver\sounds, then
open and embed all sound files using the UNC path (i.e. \\myserver\sounds\<directory and file name >).

If you are running Windows 95, UNC path names are extremely simple to use. Instead of using a drive 
letter when browsing in the File Open dialog, select Network Neighborhood in the Look In field and 
browse to the appropriate network server and share containing your sound files. This method of browsing 
uses UNC names exclusively.

For more information on Copy Object Link, and OLE support in general, see Object Linking and 
Embedding (OLE).
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Paste
Use this command to insert a copy of the clipboard contents at the current insertion point. If you have 
selected data, the Paste command deletes it before inserting.

Note: This command has no effect if the clipboard is empty. Pasting data of different sample rates will 
cause the data in the clipboard to play at the same rate as the rate of the window in which the data is 
pasted. Pasting into a stereo file will insert data to both channels since the channels in a stereo file must 
always be equal in length.

Shortcuts
Control+V
Shift+Insert
Drag and drop a selection to another data window + Alt.

See also
Edit Menu
Copy, Paste, Cut, and Undo



Crossfade (Paste Special)
Use this command to crossfade a copy of the clipboard contents with the sample data. The crossfade 
start point is either the cursor point or the start or end of the selection in the destination file.

The crossfade operation is similar to a mix, except that you apply a linear fade to the source and 
destination data. It is commonly used as a transition between one sound segment to another.

Note: Crossfading data of different sample rates will cause the data on the clipboard to play at the same 
rate as that in the current sample with which the data is crossfaded. This command has no effect if the 
clipboard is empty.

When using drag and drop crossfading, make sure that the Control key is down when releasing the 
mouse button. When dealing with mono and stereo data, crossfading will occur on the channel which the 
selection is dropped to (Left, Right, or Both).

Shortcut
Control+F
Drag and drop a selection from the source to the destination Data Window while holding the Control key. 
Make sure that you don't start the drag with the Control key down, otherwise you will switch to Magnify 
Mode. The Control key must be down when you release (drop) the selection.

See also
Edit Menu
Drag and Drop Operations



Mix (Paste Special)
Use this command to mix a copy of the clipboard contents with the sample data. The mix start point is 
either the cursor point or the start or end of the selection in the destination Data Window.

Source Volume (-Inf. to 15 dB)
Gain applied to the source data before mixing with destination data.
Destination Volume (-Inf. to 15 dB)
Gain applied to the destination data before mixing with source data.
Apply destination volume to overlapping area only (On/Off)
When off, the Destination Volume gain is applied to the entire destination sound file. Otherwise, the 
Destination Volume gain is applied to only where the destination and source data are mixed.

Note: This command has no effect if the clipboard is empty. Mixing data of different sample rates will 
cause the data on the clipboard to play at the same rate as that in the current sample with which the data 
is mixed.

Shortcuts
Control+M
Drag and drop a selection from the source to the destination data window.
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Overwrite (Paste Special)
Use this command to replace an area of sample data with the contents of the clipboard.

The Overwrite command replaces data using the following rules:

Ÿ If an area is selected which is greater than the length of the clipboard, the data from the beginning of 
the selection is replaced for the length of the clipboard.

Ÿ If an area is selected which is less than or equal to the length of the clipboard, the data within the 
selection is replaced with the clipboard for the length of the selection.

The Overwrite command is useful when you are trying to replace silent sections of audio with background 
noise.

Shortcut
Control+H
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Replicate (Paste Special)
Use this command to copy multiple copies of the clipboard to the current data window.

The Replicate command will copy as many copies of the clipboard as will fit to a selected area. If no 
selection is currently made in the data window, the function will have no effect. 

Copy Partials
Selecting the Copy Partials button will fill the selected region completely, using a partial copy of the 
clipboard if needed.
Whole Copies
Selecting this option will use only whole copies of the clipboard, and will not fill the selected region 
completely if its length is not an exact multiple of the clipboard length.

Example:

1.Copy a 1 second sample onto the clipboard.
2.Insert a 5.5 second silence sample in the data wave form.
3.Select the 5.5 second area and select Replicate.
4.If you choose Whole Copies, 5 copies of the clipboard will be placed in the area the silence previously

occupied and 0.5 seconds of silence will remain at the end.
5.If you choose Copy Partials, 5.5 copies of the clipboard will be placed in the data rather than just 5. 

No silence will remain.
The replicate command is useful when you are trying to replace silent sections of audio with background 
noise. It can also be used to introduce "stuttering" effects or echoes.
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Paste to New (Paste Special)
Use this command to create a new data window which contains the contents of the clipboard.

Shortcuts
Control+E
Drag and drop a selection to the Sound Forge XP workspace to create a new file from the selection.
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Trim/Crop
Use this command to remove all data from the sample except the selected data. This command has no 
effect if there is no selected data.

Trimming/Cropping sample data does not copy data onto the clipboard.
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Clear/Delete
Use this command to remove selected sample data without copying it onto the clipboard.

Note: You cannot clear data from a single channel in a stereo file since the two channels in a stereo file 
must always be equal in length. This command has no effect if there is no selected data.

Shortcut
Delete
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Select All
Use this command to select all data in the current data window.

Shortcuts
Control+A
Control+Numpad 5
Double clicking the left mouse button in the Waveform Display will select all data.
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Edit Tool
Use this command to use the Edit Tool of Sound Forge XP. This is the typical editing mode used for 
selecting and editing data.



Magnify Tool
Use this tool to zoom in to a particular region without losing your selection. While using the Magnify Tool, 
when you make a selection Sound Forge XP will draw a dotted rectangle around an area and will magnify
the area when the mouse button is released. 

There are three modes of operation for the Magnify Tool, and these can be chosen by toggle-clicking 
(refer to the Using Sound Forge XP section explanation of toggle-clicking) while the Magnify Tool is 
selected. These modes allow for Zoom Time only, Zoom Level only or a Time/ Zoom Level.

To return to the normal editing, choose the Edit Tool from the Edit menu.

Shortcut
While using any tool, if you hold the Control key down before making a selection with the mouse, you will 
switch to the Magnify Tool. This is handy for quickly magnifying a particular section of your sound file.

Data Magnify Mode
When you are in the data window this cursor shows that you can select an area to magnify. Dragging 
within the data window will draw a dotted rectangle which specifies the region of data to magnify.



Pencil Tool
Use this tool to edit the waveform by drawing on it. For example, if you have a glitch in the sound data, 
zoom in to the glitch and smoothly re-draw the waveform using the Pencil Tool. 

While holding down the left mouse button, you can also use the arrow keys to fine tune the pencil 
position.

The Pencil Tool is only available when operating at magnification levels between 1:1 and 1:16. To return 
to the normal editing mode, choose the Edit Tool from the Edit menu.

Data Pencil Mode
When you are in the data window this cursor shows that you can draw new audio data. Dragging within 
the data window will draw a new line which represents the new audio data. This is an easy way to 
remove glitches or pops within the audio data.



Go To
Use this command to set the cursor to a particular location in the sound file.

Go To
Provides preset locations to pick from.
Position (0 to Total length)
The position where the cursor will be moved can be specified here.
Input Format
Determines the input format that will be used to enter the position.

If you have a selection, you can switch the cursor between selection points with the ` key
(reverse quote, normally above Tab key). You can also switch the cursor between

selection points by holding the Control key while selecting the Go to Start or Go to End
buttons in the Playbar or Transport toolbar.

Shortcuts
Control+G
F5
Waveform Display shortcut menu
Double-click on the selection start field in the playbar
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Selection
Use this command to change the start, end, length, or channel of the selection on the Set Selection 
dialog.

Selection
Provides samples to pick from.
Start (0 to Total Length)
The start point of the selection is specified here.
End (Start to End)
The end point of the selection is specified here.
Length (0 to Total Length)
The start point of the selection is specified here.
Channel (Left, Right, Both)
If the sound file is stereo, you can specify which channel of the data will be selected.
Input Format
Determines the input format that will be used to enter the Start, End, and Length.
Play
Choose the Play button to play the selected sample.
Play looped
Check this box to play the selected sample in a loop.

Shortcuts
Control+D
Waveform Display shortcut menu
Double-click on the selection length field in the playbar
                                                         
See also
Edit Menu
Shortcut Menus
Advanced Editing and Navigation



Undo All
Use this command to undo all operations performed on a file. Unless Undo was disabled at some point, 
this will return your file to its original state when opened. However, if you disable undo at any time, you 
might not be able to return to the files original state.

When not working in direct mode, you can simply close the file without saving changes to revert to the 
original file. However, when working in direct mode if you decide to not save the current changes, Sound 
Forge XP does an Undo All operation automatically before saving.



Disable Undo/Redo
Use this command to prevent Sound Forge XP from creating temporary files used for undoing operations.
Since creating undo files takes time and disk space, it is sometimes more convenient to have the Disable 
Undo option on, especially when working with large files.

Remember to turn the Disable Undo feature off when you wish to be able to undo operations.

Since Sound Forge XP doesn't modify the original file unless the file is opened direct or
read-only, you can always recover it by re-opening it. However, saved changes are

permanent.

Shortcut
Control+U

                                                         
See also
Edit Menu



View Menu
Maximize Width 
Full Screen 
Toolbars 
Clipboard Contents 
Clipboard Play 
Zoom Level|Out Full 
Zoom Level|Window 
Zoom Level|Selection 
Zoom Time|In Full 
Zoom Time|Normal 
Zoom Time|Out Full 
Zoom Time|Selection 
Focus to Data Window 
Regions List 
Video Preview 



Maximize Width
This command stretches the active data window to fit between the extents of the Sound Forge XP 
window.

Shortcuts
Control+Enter
Maximize Width button on lower-right hand side of the data window.

                                                         
See also
View Menu



Full Screen
This command super maximizes the Sound Forge XP workspace in your display. To return to the regular 
window display choose the Full Screen command again.



Toolbars
This command brings up the Toolbars tab in the Preferences folder and allows you to quickly bring up any
toolbars you would like on the Sound Forge XP workspace.



Clipboard Contents
Use this command to display information on the current contents of the clipboard. Information includes, 
size, sample rate, number of channels, and bits per sample. If no data is in the clipboard you will be 
notified with a message box.

                                                         
See also
View Menu



Play Clipboard
Use this command to hear the current contents of the clipboard. This command has no effect if there is no
data in the clipboard.
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Zoom Level|Out Full
Use this command to zoom out vertically to allow viewing of the entire amplitude range. This command 
also centers the centerline.



Zoom Level|Selection
Use this command to maximize a selected area both vertically and horizontally.

To zoom in and out vertically by small increments, you can use Shift+Up or Shift+Down
arrow keys or the Zoom In/Out buttons on the lower left-hand side of the data window.

Shortcuts
Control+Up arrow (when a selection is active)
Level Ruler shortcut menu
Double-click on the Level Ruler



Zoom Level|Window
Use this command to zoom in or out vertically to the maximum zoom ratio that allows you to view the 
entire waveform on the waveform display. This command also moves the centerline if the maximum 
positive and negative peaks are different.



Zoom Time|In Full
Use this command to maximize the horizontal magnification to one sample per pixel on the screen. When 
you zoom in full, the entire waveform display length will span a very small amount of time, usually around 
20 milliseconds (depending on the sample rate and window size).

To zoom in and out by small increments, you can use the up and down arrow keys.

Shortcuts
Control+Up arrow (when no selection is active)
Waveform Display Shortcut menu

                                                         
See also
View Menu



Zoom Time|Normal
Use this command to zoom out to the default zoom ratio preference setting. If the entire sound file can fit 
in the window at a closer magnification, zoom normal will only zoom out to that ratio.

To change the default for the Normal zoom ratio, go to the Display page in the Preferences folder.

Shortcuts
Control+Down arrow
Waveform Display Shortcut menu
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Zoom Time|Out Full
Use this command to minimize the data magnification and if possible, fit the whole sample in the data 
window. To zoom in and out by small increments, you can use the up and down arrow keys.

Shortcut
Waveform Display Shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Zoom Time|Selection
Use this command to maximize a selected area in the data window.

The Zoom Selection command will calculate the maximum zoom factor for the size of a selection area, 
draw the data at this zoom factor, and center the selection in the data window.

To zoom in and out in time by small increments, you can use the up and down arrow
keys or the Zoom In/Out buttons on the lower right-hand side of the data window.

Shortcuts
Control+Up arrow (when a selection is active)
Waveform Display shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Focus to Data Window
Use this function to return the screen focus to the sample data window. This is does the same operation 
as left-clicking anywhere on the data window.

Shortcut
Alt+0

                                                         
See also
Window Menu



Regions List
Use this to open or close the Regions List window. The Regions List contains all of the regions and 
markers that exist in the currently selected data window. To play a regions, press on the Play button to the
left of each region. Selecting a marker or region moves the cursor or selection in the data window.

Shortcut
Alt+1 to turn on or set focus.

                                                         
See also
View Menu
The Regions List



Video Preview
Use this to turn on or off the Video Preview Window.

Shortcut
Alt+6 to turn on or set focus.
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Effects Menu
Chorus 
Delay/Echo 
Distortion 
Dynamics 
Flange 
Noise Gate 
Pitch Bend 
Reverb 



Chorus
The Chorus effect creates the illusion of two or more sound sources playing together. This is done by 
adding a pitch-modulated and delayed version of the input signal to the unprocessed input signal. The 
effect simulates the variances in pitch and timing that occur naturally when two or more people try to play 
or sing the same thing at the same time.

Choose the level of chorus effect you want to use, from light (the lowest amount of chorus effect) to echo-
vibrato (the highest amount of chorus effect).

See also
Effects Menu
Sound Processing and Other Tools
Using Chorus



Delay/Echo
The Delay/Echo effect adds a delayed copy of the sound signal to the file. A single delay or decaying 
multiple delays can be added before or after the sound signal.

Dry Out (-Inf. to 0 dB)
Amount of unprocessed signal mixed into the output.
Delay Out (-Inf. to 0 dB)
Amount of delayed signal mixed into the output.
Multiple Echo (On/Off)
When Off, a single delayed copy is added to the file.
When On, multiple delayed copies are added by using feedback (delaying the delayed signal, and so 
on...), which creates a decaying echo effect.
Pre-Delay/Echo (ON/OFF)
When Off, the delayed copy is added after the sound, as heard in everyday life echoes.
When On, the delayed copy is added before the sound, as heard in the twilight zone.
Delay Time (0.0000 - 5.0000 Seconds)
Determines the time after or before which the delayed copy of the sound is added to the file. Also, if 
Multiple Echo is turned On, subsequent echoes occur at intervals specified by the Delay Time.
Decay Time (0.000 - 20.000 Seconds)
Determines the time it takes the multiple echoes to become nearly inaudible. Technically speaking, this 
is the time it takes an echo to decrease in amplitude by a factor of 30 dB.
If the Decay Time is less than the Delay Time, no echo will be created.

Tips
You can also use the Delay/Echo function to shift one channel of a stereo file backward or forward in time.
For example, if you have a file with music in the right channel and voice in the left, make a selection in 
only the left channel around the voice. Set the following parameters: Dry out level at 0%, Delay out 100%,
no Multiple delays/echoes, no Pre-delay/echo. You can then use the Delay time parameter to determine 
the time shift. If you want to shift the vocals backwards in time, check the Pre-delay check box.
To simulate a stereo sound from a mono file, copy the sound to both left and right channels of a stereo file
and then do a very small time delay of a single channel (Dry out level at 0%, Delay out level at 100%, no 
Multiple delays/echoes, no Pre-delay/echo). This simple technique often works in making the sound have 
a more realistic stereo image. When a sound wave comes from your side, your right and left ears receive 
sounds at different times, which is what this effect simulates.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Delay



Distortion
The Distortion effect can simulate the overloading of an amplifier or mangle a waveform into submission.

Choose the level of distortion you want to use, ranging from fuzz to hard clip.

See also
Effects Menu
Sound Processing and Other Tools



Dynamics
Compression affects the dynamic range of the sound file by varying the gain as a function of the input 
sound level.

A compressor lowers the dynamic range of a signal by reducing the level of high volume signals and 
applying an overall gain to raise the level up again. Compression is often used in vocals and music to get 
even volume levels which often results in a smoother, fuller sound.

Attack Time (0 to 500 ms)
Time, in milliseconds, required for the gain to change from a pre-threshold level to a post-threshold 
level.
Release Time (0 to 2,000 ms)
Time, in milliseconds, required for the gain to change from a post-threshold level to a pre-threshold 
level.
Threshold (-80 to -0.1 dB)
Signal level which differentiates the Attack and Release modes. In a simple compressor or gate, the 
threshold is the level at which the gain begins to deviate from 1.
Ratio (1.0:1 to Inf.:1)
Ratio of input to output levels above the Threshold. This Ratio determines how much a signal above the
Threshold will be boosted or faded as a function of its level.
When changing the Ratio, all points above the Threshold move closer or further away from the No Gain
line.

For best results, very low frequencies (below 20 Hz) present in a sound file should be
removed before applying the Dynamics functions. This makes it easier to monitor audible

frequencies while compressing.

See also
Effects Menu
Sound Processing and Other Tools
Using Compression



Flange
The flanging or wah-wah effect is heard in many 60s and 70s recordings. It is the result of mixing a 
modulated delay signal with the original signal to create a sweeping sound much like an airplane taking 
off.

Choose the type of flange effect you want to use, ranging from slow to warble.

Flange effects are best heard with long, sustaining sounds so that the entire sweep can
be heard.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Flange



Noise Gate
A noise gate removes signals below a set threshold. It is used to remove noise from silent breaks in a 
sample.

Threshold (-Inf. to 0 dB)
Signals below this level will be removed from the sample. Zero dB is a very high level, while -70 dB is 
very low. Noise levels are usually around -40 dB, but will vary widely. To get an estimate of the noise 
level, select a region of silence (which also contains noise) and run the Statistics tool. The maximum 
value (positive or negative) shown is a good estimate of the threshold noise level required. For 
example, if the maximum positive value is -40 dB (1.0%) and the maximum negative value is -36 dB (-
1.5%), use a number a bit higher than -36 dB (maybe -32 dB) as the noise threshold level.
Attack Time (1-500 ms)
Time it takes the gain of the gate to change from zero to one once the level rises above the threshold. 
The attack time is best kept to a minimum if percussive attacks are to be preserved. Higher attack times
make sounds slowly swell up in volume.
Release Time (1-2000 ms)
Time it takes the gain of the gate to change from one to zero once the level falls below the threshold. 
The release time is usually kept high to allow for natural sounding decays, otherwise long decays will 
be cut off.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Noise Gate



Pitch Bend
Pitch Bend is used to draw an envelope which corresponds to increasing or decreasing the pitch of a 
sample over time.

Envelope (2 to 16 points, -Range to +Range)
Specifies Pitch Bend over time. The vertical axis represents pitch change, with zero being no change. 
The horizontal axis represents the length of the selected region.
Click the left mouse button to define a point and drag to change its position. Click the right mouse 
button over an existing point to remove the point. You can create up to 16 envelope points.
Reset Envelope 
This button removes all points except the outermost two.
Range (-24 to 24 Semitones)
Maximum and minimum pitch change in Semitones (half-steps). Example: A range of twelve half-steps 
(one octave) allows an increase or decrease of the pitch by an octave.
Show Wave
Select this check box to draw the waveform of the current selection on the envelope graph. This is done
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

Pitch Bend is accomplished in the same manner as changing the playback speed on a
tape deck. Therefore, the length of the file will be changed.
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Reverb
Reverb is an effect to simulate various acoustic spaces. It consists of early reflections, which are the first 
reflections that arrive back to your ear, and the reverb itself.

Choose the amount of reverberation you want to use, ranging from that appropriate for a medium room 
(least amount of reverberation) to a metal tank (highest amount of reverberation).

Any generated reverberation will not extend the sound file. To ensure that the
reverberation tail does not get truncated at the end of the sound file, there should be

enough silence following the last sound. You can extend the file by using Insert Silence
(Process menu) at the end of the file before applying Reverb.

                                                         
See also
Effects Menu
Sound Processing and Other Tools
Using Reverb



Process Menu
Convert to 8-Bit 
DC Offset 
Fade Graphic 
Fade In 
Fade Out 
Graphic EQ 
Insert Silence 
Invert/Flip 
Mute 
Normalize 
Pan 
Pan Left to Right 
Pan Right to Left 
Resample 
Reverse 
Smooth/Enhance 
Swap Channels
Time Compress/Expand 
Volume 



Convert to 8 Bit
Use this function to convert 16-bit sound files to an 8-bit format. Because the signal-to-noise ratio of 8-bit 
audio is so small (42 instead of 96 dB), it is suggested that the volume of the sound file be maximized by 
using the Volume or Normalize functions before performing the conversion.

Truncate
This method of 16 to 8-bit conversion simply removes the least significant bits of a 16-bit sample. It is 
the least desirable of the three. 

Round
When rounding, 8-bit values are mapped to the nearest 16-bit value, thereby slightly reducing the 
quantization noise. 

Dither (0.01 to 2.00 bits)
Dithering is used to reduce the audible effects of quantization noise which are most audible in 8-bit 
samples. This is accomplished by adding a small amount of Gaussian noise to the signal to mask the 
more obtrusive 8-bit quantization distortion. 

The dither depth is the amplitude of the added noise in terms of the least significant bits of the sound 
file. For most cases, a value between 0.5 and 1.2 is sufficient.

Tip: Use very small amounts of dithering and listen to whether to quantization noise is
less obtrusive. Increase the dither amount until the dither noise is louder than the

quantization noise.

                                                         
See also
Sound Processing and Other Tools
Converting 16 to 8 bit



DC Offset
Use this command to change the baseline of a sound file. A recorded wave that is not centered around 
the zero baseline in the waveform display is said to have a DC offset. To correct for offsets, a constant 
value is added to each sample.

DC offsets are usually caused by electrical mismatches between your sound card and microphone. 
Glitches and other unexpected results can occur when sound effects are applied to files which contain DC
offsets.

Automatically Detect and Remove
When this option is checked, the DC offset is calculated for each channel individually and then 
automatically corrected.

Adjust DC Offset By (-32,768 to 32,767)
Enter the offset value. The offset can be from -32768 to 32,767 for 16-bit data and from -128 to 127 for 
8-bit data.

Tips: An easy way to spot DC offset is to zoom close up to a spot in the sound file
containing only silence and see if the silence waveform matches the centerline in the

waveform display.

An approximation of the DC offset of the waveform can be obtained by running the Statistics function 
under the Tools menu. For example, if a DC offset of 100 exists, then you should apply a -100 DC offset
to cancel out the existing offset.

Compute DC Offset From First 5 Seconds Only (On/Off)
When this option is enabled, only the first 5 seconds of a sound file are analyzed when measuring the 
DC offset. The only time that 5 seconds is not sufficient is if a long fade-in or mute has been applied at 
the beginning of the file.
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Fade Graphic
Use a fade to vary the volume of a sound file over time. The Graphic Fade dialog allows you to draw a 
fade envelope which will be applied across the current data selection. Up to 16 envelope points are 
allowed.

Draw the envelope by pulling the small square boxes (drag points) up or down. You can create a new 
drag point by left-clicking on any point of the fade envelope. To delete a drag point, single-click on it with 
the right mouse button, or double-click on it with the left mouse button. Once you have finished with the 
envelope, press the OK button to apply the fade.

Show Wave
Press this check box to draw the current selection's waveform on the envelope graph. This is done 
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

Reset Envelope
Press this button to return the fade envelope to its default shape

In
Use this command to linearly fade a selection from a volume of 0 dB to a volume of -Inf

Out
Use this command to linearly fade a selection from a volume of -Inf. to a volume of 0 dB. 
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Process Menu
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Fade In
Use this command to linearly fade a selection from a volume of 0 dB to a volume of -Inf



Fade Out
Use this command to linearly fade a selection from a volume of -Inf. to a volume of 0 dB. 



Graphic EQ
The graphic equalizer can boost or attenuate selected frequency bands to correct or enhance a signal's 
frequency spectrum.

Band Attenuation/Gain Faders (-60 dB to 15 dB)
Each of the nine sliders corresponds to the gain or attenuation factor that will be applied to the specified
frequency region.

The frequency on the bottom of the fader is the center frequency of the frequency band affected by the 
fader.

The value of the fader affects the frequency band as follows:

+15 dB Maximum boost

0 dB No effect

-15 dB Maximum attenuation

Accuracy  (Low, Medium, High)
Determines a compromise between filter precision and processing speed. Low precision is not 
recommended for performing very sharp filtering, when filtering very low frequencies, or when using a 
high sample rate.

Reset Bands
Press this button to return the band faders to their default settings.
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Insert Silence
Use this command to insert a section of silence into a sample.

Insert at
Start of File
Inserts the silence at the beginning of the file.
End of File
Inserts the silence at the end of the file.
Cursor
Inserts the silence at the current insertion point.

You cannot insert silence to a single channel of a stereo file since the length of each channel must always
remain equal. If you wish to insert silence into a single channel you can use the Delay/Echo function to 
delay one channel forwards or backwards in time.
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Invert/Flip
Use this command to invert the sample about the base line. Although this does not make an audible 
difference, it can be useful for matching a sample transition when executing certain pastes, mixes, or 
loops.
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Mute
Use this command to set a selection to a volume of 0 (silence).
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Normalize
Use this command to maximize the volume of a selection without clipping. The Normalize function scans 
the audio and applies a gain to raise its level to a specified (often very high) value.

Normalize to (-60 to 0 dB)
This value indicates the level to which the sound file will be normalized. For example, when using 
peaks, if the peak level is -10 dB, and the Normalize to setting is set to -3 dB, a constant boost of 7 dB 
will be applied to the entire file.

Note: When using Normalize on stereo data, if the selection includes both channels,
normalization is computed on the loudest sample value found in either channel and the

same gain is applied to both. If a single channel is selected in a stereo file then
Normalization will effect only that channel.
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Pan
Choose a Pan option to have Sound Forge XP automatically pan left to right or right to left. 

Choose Graphic to draw a dynamic pan envelope, which will be applied across the current data selection.
You can create up to 16 envelope points.

Process Mode
Pan (preserve stereo separation)
Allows you to perform right and left channel panning effects without mixing the channels together. This 
is used to simulate left/right positioning of stereo recordings.

Pan (mix channels before panning)
Allows you to perform right and left channel panning effects by first mixing the two channels and then 
changing the volume between channels.

Output Gain
The gain applied to the signal after processing.

Show Wave
Check this box to draw the current selection's waveform on the envelope graph. This is done 
automatically if the selection is small. For stereo files, you also have the option of displaying the left, 
right, or a mix of the two channels.

Reset Envelope
Press this button to return the pan envelope to its default shape.

Left to Right
Select this option to create a smooth panning effect from the left channel to the right. If the original 
source data is mono, Sound Forge XP automatically converts it to stereo.

Right to Left
Select this option to create a smooth panning effect from the right channel to the left. If the original 
source data is mono, Sound Forge XP automatically converts it to stereo.
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Pan Left to Right
Select this option to create a smooth panning effect from the left channel to the right. If the original source
data is mono, Sound Forge XP automatically converts it to stereo.



Pan Right to Left
Select this option to create a smooth panning effect from the right channel to the left. If the original source
data is mono, Sound Forge XP automatically converts it to stereo.



Resample
Use this function to change the sampling rate of an existing sound file.

New Sample Rate (2,000 to 60,000 Hz)
Sample rate to which the sound file will be converted.

Apply an Anti-alias Filter During Resample (On/Off)
Apply an anti-aliasing low-pass filter to the sound file before resampling when changing to a lower 
sampling rate. Since the maximum frequency that can be represented by a particular sample rate is 
one-half of the sampling rate (the Nyquist frequency), high frequencies in a sound file cannot be 
represented if the sound file is resampled to a lower sampling rate. Therefore, when changing to a 
lower sampling rate, if the sound file has a strong high-frequency content, anti-aliasing should be used 
to prevent these high frequencies from becoming low-frequency distortion.

Set the Sample Rate Only (do not resample) (On/Off)
If this option is checked the playback rate is changed without resampling the data. This means that the 
original pitch of the file is not preserved. When converting between two very close sample rates and 
speed is of the essence, this option can be turned on.

Interpolation Accuracy (1 - 4)
The Interpolation Accuracy parameter determines the complexity of the method used during the 
resampling process. The audible difference between the different values can be subtle without the use 
of test tones and is most apparent in high frequencies. 

In general, a setting of 1 is more than adequate for general purpose audio. Settings of 2 and 3 are good
for high-end audio. Setting this parameter to 4 forces some heavy duty number crunching (i.e. slow 
processing) but produces very near perfect results, good for audiophiles and audio researchers. 

Resampling data consists of changing the number of recorded samples per second.
When changing to a higher sample rate, extra samples are interpolated and the file size
increases. When changing to a lower sample rate, some samples are removed and the

file size decreases.
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Reverse
Use this command to reverse a selection. 

                                                         
See also
Process Menu
Sound Processing and Other Tools



Smooth/Enhance
Use this command to add or remove high frequency content in a sound file selection.

The Smooth function will smooth out fast-changing transients in a sound and is useful for removing 
glitches.

The Enhance function boosts the very highest frequencies (close to the Nyquist rate) in the sound file, 
making the sound file sound more vivid. It is useful for compensating for the effects of downsampling or 
for bringing out very fast transients in a sound file

Operation (-5 to 5)
Determines the amount of smoothing (high frequency attenuation) or enhancement (high frequency 
boost) is applied to the sound file.

For a very drastic high frequency boost or cut, repeat the effect 2 or 3 times with the
amount set to either limit.

Note that since the enhance function boosts frequencies near the Nyquist rate, the current sample rate 
will determine what frequencies will be affected. At 44,100 Hz, the effect can be very subtle (unless you 
repeat it a few times until your ears ring).
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Swap Channels
Select this option to exchange the contents of the right and left channels of a stereo recording.



Time Compress/Expand
The Time Compress/Expand function changes the duration of a sound file without altering the pitch.

Mode
Selects the algorithm used to process the sound. The modes have been labeled for suggested uses, 
such as music and speech, but do not assume that one mode will not work well with a certain type of 
sound. Depending on the source sound, different modes can vary the resulting quality drastically, so 
experimenting with all modes is suggested.

Check the bottom of the dialog box for a summary of your choices. You should be able to achieve 
excellent results for ratios between 75% and 115%. Beyond this range, you will start to hear artifacts 
such as echoes, flanging, or drop-outs. The different modes are supplied so that you can determine 
what works best for your case.

In many cases, many of the modes will work well, but in some instances (such as complex, multi-
instrument music or pitched drums) you'll have to try out all of the modes. In general, the settings 
designed for music will work with the largest variety of material.

Also, running the process a number of times using small increments (like 105%) will create different 
effects that processing all at once with a large time change.

Final Length (hr:mn:sc:fr)
Desired length of the selection. 

Blend Edges with Adjoining Data (On\Off)
When this option is turned on, the beginning and end of the selections will be crossfaded with the 
original sound data. This is used to minimize glitching.

To change the Original tempo displayed at the bottom of the dialog, you must go to the
Edit Tempo dialog (Special menu).
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Volume
Use this command to change the volume of a selection.

Gain (-Inf. to 20 dB)
Select a Gain amount from -Inf. to +20 dB. A value of negative infinity corresponds to a mute (0 %). 
Negative decibel values lower the volume (attenuation). Positive values are used to raise the volume 
(boost).

See also
Process Menu
Sound Processing and Other Tools



Special Menu
Transport 
Regions List 
Edit Frame Rate
Edit Tempo
Center Cursor
Drop Marker
Create Region 
Mark In 
Mark Out 
Toggle Selection 
Undo/Redo History Clear 
Undo/Redo Clear All 
Rebuild Peak Data 



Transport
Record
Play All
Play
Pause
Stop
Go to Start
Rewind
Forward
Go to End
Play Normal Mode
Play Looped Mode
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Record
Use this function to record to an existing or new data window.    If you have a file open in direct mode, 
Sound Forge XP defaults to recording to a new window. To record to the direct-opened file simply use the 
Window button (explained later).

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

New
This button allows you to create a new data window for recording.
Close
Press this button to exit record mode.
Remote
Press this button to enter Remote Recording mode. This mode will hide the main Sound Forge XP 
Window and show only the Record Remote dialog box (a condensed version of the Record dialog). This
allows you to easily record while using other components of your system like a CD player, mixer, or 
sequencer.
Go To
Pressing this button displays the Go To dialog for selecting a Start position. This option is not available 
in Punch In mode.
Selection
Pressing this button displays the Set Selection dialog for selecting a sample. This option is only 
available in Punch In mode.
Window
Pressing the window button allows you to select the data window into which you will record.
Mode
Selects the current recording mode. Modes are as follows:

Automatic Retake (automatically rewind)
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is automatically 
rewound to the original starting position.
Multiple Takes
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is set to ending 
position of the take. To review a take using the Play button, press the REW button to rewind the 
Start position to the beginning of the take then press Play. Pressing the FWD button will set the 
Start position to the end of the take in preparation for the next take.
Punch In (record a specific length)
This mode is used to record over the top of an existing region of sound. This allows you to record 
a portion of a previous take without recording a whole new file.

Start
Displays the position where recording will begin.
End
Displays the position where recording will end (this value is inclusive).
Length
Displays the length to record.
Input format
Use this to change how the Start, End, and Length values are entered and displayed as well as the 
display of Time Recorded and Time Left on Drive values.



Monitor (On/Off)
Select this checkbox to monitor the level of the input signal. This option can be enabled at any time. 
The meters light up as a function of the volume of the recording input. For best results the level should 
be somewhere in the yellow range with an occasional red. This button also activates the Peak and 
Margin values. The Peak value shows the maximum input level recorded since the last Reset was 
invoked. The Margin value shows the percentage the input level can be increased prior to clipping. If 
the Peak value reaches 100% (and the Margin value reaches 0%), clipping has occurred.
Reset
Resets the Peak and Margin values back to their initial states.
Prepare
Pressing the Prepare button prepares your system for recording. This means that the record device is 
opened and all preparation that can be done prior to recording is completed. This allows the system to 
begin recording as quickly as possible after the Record button is pressed. You do not need to use the 
Prepare button unless you are trying to begin recording immediately after pressing the Record button.
Record
Pressing the record button starts recording. If recording has been Prepared, then recording starts 
immediately. If recording has not been Prepared, Sound Forge XP attempts to start recording as quickly
as possible; a small delay may occur.
Play
Pressing the play button allows you to hear a section of data over which you are going to record or 
which you have just recorded. This allows you to keep recording until you get the correct take.
Review pre/post-roll
These two edit boxes specify the amount of time which will be played prior to and after reviewing a 
take.
Record Meters
The following commands and options affect the Record Meters display. The Record Meters options can 
be activated by right-clicking anywhere in this dialog or by Alt+Spacebar (Windows 95) or Alt+- 
(Windows 3.x). Choose Record Meters from the pop-up menu that appears. For direct access to the 
Record Meters options, right-click anywhere in the meters.

Reset Clip
This function resets the clip indication on the Record Meters. After a clip occurs, the clip indication
will remain lit until the Reset Clip function is invoked. You can also click on the clip light or levels 
to clear it.
Resolution    (-24, -42, -60 -78 or -90 to 0 dB)
These settings display the minimum and maximum readings for the Record Meters. Changing the
resolution of the meters is helpful for metering sound files of varying dynamism.
Show Labels
This option turns on or off the markings on the Record Meters.
Hold Peaks
This option turns on or off the markings to indicate the highest peaks in the sound file.
Hold Valleys
This option turns on or off the markings to indicate the lowest peaks in the sound file.

Blinking Status (On/Off)
This option enables or disables blinking of the status indicator. It is reached by right-clicking anywhere 
in the Record dialog.

See also
Special Menu
Using Recording



Play All
Use this function to play the entire sample file from beginning to end, regardless of cursor position or 
selection.

Shortcut
Shift+Spacebar
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Play
Playback file in current playback mode (Normal or Looped).

Shortcuts
Spacebar
Right-click on Overview
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Special Menu



Pause
Stop playback and keep cursor at the stop point.

Shortcuts
Shift+Spacebar
Enter
Right-click on Overview during playback
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Special Menu



Stop
Stop playback and return the cursor to its position prior to playback.

Shortcut
Spacebar (during playback)
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Go to Start
Moves the cursor to the start of the file.

Shortcut
Control+Home
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Special Menu



Rewind
Pressing this button moves the cursor backwards, take by take, in the current sound file. 



Forward
Pressing this button moves the cursor forward, take by take, in the current sound file. 



Go to End
Moves the cursor to the end of the file.

Shortcut
Control+End
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Play Normal Mode
Sets Playback mode to Normal Mode. When Play is selected while in this mode:

Ÿ If there is no selection, playback occurs from the cursor to end of file. 

Ÿ If there is a selection, playback occurs from the beginning of the selection to the end of the selection.

Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
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Play Looped Mode
Sets Playback mode to Looped Mode. When Play is selected while in this mode:

Ÿ If there is no selection, the entire sample is played in an endless loop.

Ÿ If there is a selection, the selection is played in an endless loop.

Shortcut
To switch between playback modes, use Control+Spacebar
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Special Menu



Regions List
Add
Delete
Edit
Replicate
Update
Clear
Copy to Clipboard
                                                         
See also
Special Menu
The Regions List



Add to Regions List
Use this function to add a selection to the Regions List.

Shortcut
Drag and drop selection to Regions List
Ruler Shortcut menu
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Shortcut Menus



Delete Region from Regions List
Use this function to delete a region from the Regions List.

Shortcut
In the Regions List, select a region and press Delete
Region Tag Shortcut menu
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Shortcut Menus



Edit Regions List
Use this function to modify a region in the Regions List.

Name
Name of the region, which can be up to 255 characters long.
Type (Marker/Region)
A Marker is a single point, a region is a start and end point, and has an associated length.
Start, End, Length, Input Format
Use to change the selection. Sound Forge automatically fills in the values depending on your selection 
or cursor position.

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu
Press Enter when a region in the Regions List has focus
Double click on a region in the Regions List
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Replicate Region in Regions List
Use this function to create a new copy of the marker/region.

Shortcut
Region List Shortcut menu
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Update Region
Use this function to change the current marker/region location to match the current cursor/selection. 

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu
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Clear Regions List
Use this function to remove all markers/regions from the Regions List.
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Copy Regions List to Clipboard
Use this function to copy the text of the Regions List onto the clipboard for use with a text editor. Excellent
for making a hard copy of the Regions List.

Shortcut
Region List Shortcut menu
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Edit Frame Rate
Use this command to change the Frames per second value used by Sound Forge XP for status 
information when using Absolute Frames or Time & Frames format. The included presets are there for 
your convenience. You can manually enter the frame rate below.

Set Frame Rate to:
Custom
Choose Custom and then enter the frames per second you want to use. 
Half NTSC video (14.985 fps)
This is one half of the standard rate for video broadcasts.
NTSC video (29.970 fps)
This is the standard rate for video broadcasts.
Red Book digital audio (75.000 fps)
When recorded to CD, the audio is divided into frames which occur at about every 8 ms. Thus, when 
editing a sound file that will end up in an audio CD, this format is useful for guaranteeing that the start 
and end of selected audio will exactly match with the final product. 
SMPTE Non-drop (29.970 fps)
This is the same as NTSC video.
Video for Windows Default (15.000 fps)
Default rate used by Video for Windows .AVI files.
Frames per Second (1 to 1000)
Number of frames per second used. You can select a pre-set from the list above or manually enter a 
value.
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Edit Tempo
Use this command to automatically calculate the musical tempo (Beats per minute) from the current 
selection. 

To use the Edit Tempo function, first make a selection in the waveform display. The selection made should
be equal in size (or integer multiple) to the length of a beat or measure. The easiest way to tune a 
selection to be exactly one measure long is to play the selection looped and change the selection points 
until a constant downbeat is heard.

Sound Forge XP uses the current tempo to display measures in the Time Ruler tool.

Type (Beat/Measure)
Choose whether the current selection in the waveform display is one beat or one measure long.
Start, End, Length, Input Format
Determines the selection used to calculate the tempo.
Beats Per Measure (1 to 32)
Use to specify the number of beats in a measure when selecting a measure (e.g. 4 for most pop music 
out there). It can also be used to specify beats per selection length if the selection is larger than one 
measure.
Beats per Minute (1.0 to 1000.0)
Sound Forge XP calculates this tempo value depending on your selection length, selection type 
(Measures or Beats), and Beats per Measure. 
Play
Choose this button to play the file with the current tempo settings.

Note: The default tempo (Default: 120) can be changed on the Status page of the
Preferences folder. 
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Center Cursor
Selecting this item will center the display so that the cursor appears in the center of the data window. This
item does not actually move the cursor to a new position in the data window, it simply redraws the display 
so that you will now see the areas of the sound file equally on either side of the cursor. If the cursor does 
not seem to center when selecting this, it is because the cursor is either very close to the beginning or 
end of the sound file, and therefore cannot be centered.

Tip: If you have a selection, you can switch the cursor between selection points using
Home and End. You can also switch the cursor between selection points by holding the

Control key while selecting the Go to Start or Go to End buttons in the Playbar or
Transport toolbar. 

Shortcuts
. (period)
* (asterisk)
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Special Menu



Drop Marker
The Drop Marker command is a way to mark positions in a sound file. You can drop a marker at the 
current cursor position while editing or "on the fly" during file playback. It is much easier to create a 
marker from the toolbar or by pressing 'M' on the keyboard rather than the menu (as this would be difficult
to coordinate on the fly). Markers can be quickly selected from the list in the Go To dialog box located in 
the same menu/button bar. Also, markers are placed in the Regions List for quick playback.

There is usually a very small delay between the time when you select Drop Marker and
when the marker is actually created. Using the keyboard shortcut 'M' gives the fastest

response, and thus the highest accuracy. 

Depending on the sound card you are using, there might be an offset error between what you hear and 
where the cursor is at. To correct this, go into the Wave folder in the Preferences Folder and use the 
Position Bias to correct for the sound card driver's offset error. 

Some sound cards do not return position information to Sound Forge very efficiently. If the cursor moves 
in large chunks during playback, check the Interpolate position between buffers to allow Sound Forge to 
estimate where the sound card playback is occurring.

Shortcut
M
                                                         
See also
Special Menu
Using Markers



Create Region
Use this function to create a new region in the Regions List from the current selection.

Shortcut
R
                                                         
See also
Special Menu
The Regions List



Mark In
Use this option to mark the in point of a new selection while the sound file is playing back. You can also 
use this as a method of marking the in point of a new selection while editing by moving the cursor to 
where you want the selection to start. This is a good way to accurately set the start of a selection. For 
greatest accuracy you should use the keyboard shortcut key '[' when Marking In during playback.

Note: If the there is a discrepancy between what you hear and the cursor position on
screen, use the Play position bias or Interpolate play position for inaccurate devices
between fields options on the Wave page in the Preferences folder (Options menu).

Shortcut
[ (left square bracket)
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Mark Out
Use this function to create a mark out point of a new selection. Mark In and Mark Out are used to 
determine a selection, and can be used during playback. For greatest accuracy you should use the 
keyboard shortcut key ']' when marking out during playback.

Note: If the there is a discrepancy between what you hear and the cursor position on
screen, use the Play position bias or Interpolate play position for inaccuracies between

fields options on the Wave in the Preferences folder (Options menu).

Shortcut
] (right square bracket)
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Toggle Selection
By using the "S" key (or this menu item), you can toggle back and forth between the last selection and 
last cursor position. For instance, you may be setting the cursor in various places while navigating 
throughout a sound file. If you then hit "S", the last selected region will immediately return to the display. 

Shortcut
S
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Undo/Redo History Clear
Use this function to erase the temporary files created in the undo history for the active file. These files do 
take up disk space, so you might want to periodically clear them when you are sure that you don't want to 
undo any of your previous changes. This function only affects the current sound file.
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Undo/Redo Clear All
This command will clear the undo histories for all open sound files. Clear all affects all of the opened 
sound files. After doing this you will be unable to undo changes you have made to all modified sound files.
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Rebuild Peak Data
This function recalculates the peak data file for the active data window. A peak data file is used in 
displaying a file's waveform without scanning the entire length of the file for the sample amplitudes. This 
makes screen redraws much faster.

If for some reason you believe that the waveform display is not accurately representing the sound file, you
can use this function to force Sound Forge XP to re-scan the entire file. However, under normal 
circumstances you should never have to do so since Sound Forge XP will always update the peak file 
after every edit operation and when loading a file.
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Window Menu
New Window
Cascade 
Tile Horizontally 
Tile Vertically 
Arrange Icons 
Minimize All 
Restore All 
Close All 



New Window
Use this command to create a new data window. The new window will be given a generic name. This 
command uses the sound parameters from when the File New command was last used.

Shortcut
Control+Shift+N

See also
Window Menu



Cascade
Use this command to arrange the data windows so they overlap with the title bar of each window 
remaining visible.

Shortcut
Shift+F5
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Tile Horizontally
Use this command to arrange the data windows side by side without them overlapping.
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Tile Vertically
Use this command to arrange the data windows top to bottom without them overlapping.

Shortcut
Shift+F4
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Arrange Icons
Use this command to arrange the minimized data icons in the Sound Forge XP workspace.
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Minimize All
Use this command to minimize all open data windows in the Sound Forge XP workspace.
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Restore All
Use this command to restore all minimized data windows in the Sound Forge XP workspace.
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Close All
Use this command to close all open data windows in the Sound Forge XP workspace.
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Options Menu
Status Format 
Annotations 
Video Options 
Scroll Playback 
Drag and Drop Snapping 
Lock Region Length 
Paste Events 
Preferences 



Status Format
Use this command to set the status format. Possible formats are:

Samples
Time
Seconds
Time & Frames
Absolute Frames
Measures & Beats
SMPTE Non-Drop
SMPTE Drop
SMPTE EBU
SMPTE Film Sync

Shortcut
Playbar Selection Status Shortcut menu

                                                         
See also
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Using Status Formats
Shortcut Menus
Status Preferences



Samples
Use this command to set the status format to Samples. A sample is the smallest division of digitized 
sound. The number of samples per second is determined by the Sample Rate.
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Time
Use this command to set the status format to Hour:Minutes:Seconds:Frames, with the frame rate 
adjustable from the Edit Frame Rate dialog under the Special menu. In this mode, the hour, minutes, and 
seconds are in real time, independent of the frame rate.
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Seconds
Use this command to set the status format to show seconds with six decimal place precision.

                                                         
See also
Options Menu
Using Status Formats
Status Formats



Time & Frames
Use this command to set the status format to Hour:Minutes:Seconds:Frames, with the frame rate 
adjustable from the Edit Frame Rate dialog under the Special menu. In this mode, the hour, minutes, and 
seconds are in real time, independent of the frame rate.
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Absolute Frames
Use this command to set the status format to show frames and fractions of a frame.
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Measures & Beats
Use this command to set the status format to beats.
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SMPTE Non-Drop
Use this command to set the status format to SMPTE Non-Drop (30 or 29.97 fps). The standard rate for 
SMPTE Non-Drop when synchronizing to video is 29.97. However, in music applications, a rate of 30.00 
is often used.

Note: When using a frame rate of 29.97, the time displayed will be different than real
world time because thirty frames are still used to measure one second. See SMPTE, the

ultimate confusion for more information.
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SMPTE Drop
Use this command to set the status format to SMPTE Drop (29.97 fps). Frames will be dropped at specific
points in time to ensure that the hours and minutes displayed stay synchronized to real world time. See 
SMPTE, the ultimate confusion for more information.
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SMPTE EBU
Use this command to set the status format to SMPTE EBU (25 fps). This is the standard rate used by 
European television. See SMPTE, the ultimate confusion for more information.
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SMPTE Film Sync
Use this command to set the status format to SMPTE Film Sync (24 fps), which is a common slower film 
rate. See SMPTE, the ultimate confusion for more information.
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Scroll Playback
Checking this option makes the data window scroll automatically during playback. When the cursor 
moves off of the current window it will quickly scroll to show another full window of data.

Shortcut
F6
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Annotations
The names of markers and regions can be shown on the waveform display, along with dotted lines which 
run the entire height of the window…all with your permission, of course.

Marker Names 
Marker Lines 
Region Names 
Region Lines 



Annotations|Marker Names
Displays marker names on the waveform display.
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Annotations|Marker Lines
Displays dotted lines on the waveform display showing where markers exist.

                                                         
See also
Options Menu



Annotations|Region Names
Displays region names on the waveform display.
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Annotations|Region Lines
Displays dotted lines on the waveform display showing where regions exist.
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Video Options
These options affect the Video Preview window.

Copy Current Frame 
White, Black or Default Background 
Animate Video Strip 
Number Frames  
Stretch to Window 
Integral Stretch 
Preserve Aspect 
Passive Update 



Video|Copy Current Frame
Enabling this option will copy the frame corresponding to the current cursor location to the clipboard.
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Video|Default Background
This option selects the color used surrounding frames in the Video Preview and video strips. The default 
color can be chosen from the in the Options menu on the Preferences page.
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Video|Black Background
This option selects the color used surrounding frames in the Video Preview and video strips.
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Video|White Background
This option selects the color used surrounding frames in the Video Preview and video strips.
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Video|Animate Video Strip
When this option is turned on, the video strip above the waveform display will come to life at the current 
cursor or play position. This feature is frame accurate, meaning that when you move the cursor, the 
correct frame corresponding to the cursor position will be displayed instead of the static overview frame.

When off, the video strip always shows the frame that corresponds to the left edge of each image in the 
video strip,
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Video|Number Frames 
Turn this on to show the frame number at the bottom left-hand corner if the video windows.
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Video|Stretch to Window
Turn this option on to cause each Video Preview frame to fit exactly into the Video Preview window. This 
mode is generally the slowest because resizing a frame by non-integral fractions requires many 
calculations.

                                                         
See also
Options Menu



Video|Integral Stretch
When this resize mode is enabled, the Video Preview frame will only be stretched by integral amounts. 
This is usually the fastest mode.

                                                         
See also
Options Menu



Video|Preserve Aspect
Check this re-size option when you want the original aspect ratio (horizontal vs. vertical size) of the video 
to be preserved. 
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Video|Passive Update
Checking this option will reduce the overhead needed to update the Video Display window. When on, the 
Video Display will only be updated when the processor is idle, which in slower computers is much less 
frequent. This will help to keep the audio from skipping when a computer can't update video frames fast 
enough.
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Drag and Drop Snapping
This command toggles on and off the ability to snap to objects when dragging and dropping from window 
to window. With this on you can snap to major time ticks on the Time Ruler and cursor positions.
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Lock Region Length
Use this to have the length of a region remain constant when changing the start or end time of a region.

Shortcut
Holding the Shift key down while dragging Ruler Tabs also locks the length of a region.
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Paste Events
Enabling this operation will transfer any events such as regions and markers from the source to the 
destination sound files when pasting, mixing, or crossfading. This occurs when using drag and drop or the
clipboard.

If you are using another application to paste data into other than Sound Forge, these events may cause 
problems. Although a well-written application should ignore these events, if you are experiencing clicks at 
the beginning or end of the data you should disable this option.



Preferences 
Many user-configurable options are available in the Preferences dialog. To select an item, simply click on 
the folder tab or use the Tab key to place the focus on the folder name and use the right or left arrow key 
to navigate through the folders. Options available in the Preference folder include:

General
Display
Editing
File
Performance
Status
Toolbars
Wave

See also
Options Menu



General Preferences
Use to select general user options.

Show a Tip of the Day on Startup Default: Checked
When this option is enabled, a handy Tip of the Day will appear every time you run Sound Forge XP.
Always Ask for Region and Marker Names Default: Checked
When creating regions, markers, or loop points and this option is turned off, the Edit Region or Loop 
dialog will not automatically appear. A default name based on location will be used.
Open Drag and Drop Sound Files in Direct Mode Default: Unchecked
Any files opened by dragging them onto the Sound Forge XP desktop (from outside of the program) will
be opened in direct mode when this option is enabled.
Open Command Line Sound Files in Direct Mode Default: Unchecked
When launching Sound Forge XP from the command line (DOS prompt), if this option is turned on any 
files in the command will be opened in direct mode. For example, if Sound Forge XP is being launched 
by another application (such as a multi-track editor), when this option is turned on Sound Forge XP will 
edit directly on the original file.
Default to Slow Scroll When Drag Selecting Default: Unchecked
In some very fast computers, automatic scrolling while selecting is too fast to use accurately. When this 
options is turned on, drag-selecting will cause a slow scroll.

Note: If you click the right mouse button while selecting, you can be toggle slow scroll on
or off.

Warn When Mix/Crossfade Rates Mismatch Default: Checked
Enabling this option tells Sound Forge XP to warn you with a dialog prior to mixing or crossfading data 
which has different sample rates. Mixing or Crossfading data of different sample rates may produce 
unintended sounding results.
Always Open Full-screen Default: Unchecked
Enabling this option forces Sound Forge XP to always open in full-screen mode. If this option is 
disabled Sound Forge XP opens in the size and position it was in when it was last closed.
Confirm on Close Default: Unchecked
Enabling this option forces Sound Forge XP to prompt you with a confirmation message box prior to 
exiting Sound Forge XP.
If you are a system administrator you may want to enable this option for users who are new to 
Windows, and who may double-click on the close box by accident.
Compatible Draw Mode (for Broken Video Drivers) Default: Unchecked
Because Sound Forge XP's drawing routines are highly optimized, they increase the chance of causing 
little-known video card problems to arise. Some video cards have bugs in their drivers which can make 
your system lock up when Sound Forge XP tries to draw a waveform. If you experience a system 
lockup frequently in Sound Forge XP, it is likely that your video card is causing this problem.
Compatible draw mode uses a different method of drawing the waveform which, although not as 
smooth, puts less stress on the video card. With some video cards, this mode actually increases the 
draw speed. However, more flashing can occur.
This problem is known to happen with ATI's Mach64 card when using High Color (16-bit) in Windows 
95.
Compatible draw mode Default: Unchecked
When this mode is enabled, Sound Forge XP will use a less optimized method of scrolling the 
Waveform Display. In some instances, this can reduce interference problems between your audio and 
video card during Smooth Scroll playback.
Ignore fact chunk when opening compressed WAV files Default: Unchecked
Check this option if you want to ignore the fact chunk when you're opening compressed .WAV files.
Show all ACM convert formats in Save As Default: Checked



When enabled, Sound Forge will enumerate all compression formats available for each ACM 
compressor. However, this enumeration process can be slow on slow machines. For simple ACM 
codecs (Microsoft ADPCM, IMA ADPCM, etc.), this option is unnecessary (they have only one 
compression type per input) and could be disabled to speed up the selection of ACM formats.
Show Free Storage Space on Status Bar Default: Checked
When this option is turned on, the total amount of free disk space available on your specified temporary
drive is displayed on the status bar.
Show Shuttle Controls on Data Window Transport Default: Unchecked
When enabled, Rewind and Forward buttons will appear on each Data Window's Transport.
Show OLE Drag Source on Data Window Transport Default: Checked
When checked, the OLE Drag Source control is displayed on the right side of the status bar in all data 
windows. This provides a convenient method of creating Sound Forge XP audio objects that can be 
embedded into other documents. If you do not use this feature and want to reclaim the space for the 
status bar, simply uncheck this option.
Recently Used File List Default: Enabled (2 to 9)
This option allows you to set the number of recently used files which will appear in the File menu. If you 
do not wish to have any files listed in the File menu, uncheck the check box for this option.
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Display Preferences
Use to set your display preferences.

Normal zoom ratio Default: 1:4,096
Specifies the normal zoom magnification you want to use. Higher values show more data on initial file 
loading, which takes more time.
Default sound file window height Default: 12
Specifies the height of the sound file window, from small (1 line) to big (25 lines).
Default video strip height Default: 4
Specifies the height of the video strip, from small (1 line) to big (25 lines).
Color Preference for
The color preferences section allows you set a custom color for a variety of graphics within Sound 
Forge XP. Each graphic has a default color or you can set a custom color by checking the Custom box 
and setting the component Red, Green, and Blue of each color.
From the drop-down list, choose an item, such as the play cursor, for which you want to set a color.
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Editing Preferences
Use this to set preferences related to editing and undo operations.

Limit Number of Undo Buffers To (0 to 999) Default: 100
If this is checked, it determines the maximum number of Undo operations that will be saved before they 
start to get deleted. Having many Undo operations available will use a lot of hard-disk space.
Limit Number of Redo Buffers To (0 to 999) Default: 100
If this is checked, it determines the maximum number of Redo operations that will be saved before they 
start to get deleted. Having many Redo operations available will use a lot of hard-disk space.
Default All Windows to Undo Disabled Default: Unchecked
Enabling this option will keep Sound Forge XP from creating undo buffers for any operation which 
modifies a sound file. You are still able to turn the undo creation on by using the Disable Undo 
command (Edit menu) for any window, but by default no undo buffers will be created.
Drag & Drop Auto Rise Delay (0.1 to 2.0 seconds) Default: 0.7
Determines the time necessary before a window underneath the cursor becomes active during drag 
and drop operations.
Disable Triple-clicking to Select All Data Default: Off
Turn this option on if you don't want Sound Forge to select all sound data when you triple-click. You 
might want to turn this off if triple-clicks are constantly being falsely detected when you make a 
selection and then try to do a drag operation. Otherwise, lowering Window's double-click threshold time 
might help.
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File Preferences
Use this to set preferences related to opening and saving files.

Warn if Save Changes the Sound Data Default: Checked
When you save a sound file to a different format, such as doing 16 to 8-bit conversions or compressing 
audio, you will not hear the conversion's effect on the sound until you re-open the file. If this option is 
enabled, you will get a message warning of this.
Automatically Re-open Default: Unchecked
if Save Changes the Sound Data 
If this option is on, when you save a file to a different format Sound Forge XP will save the file and then 
re-open it. This will happen when you change bit size, channels, or compression format and it will allow 
you to listen to any changes in sound quality.
Sector Align Data Default: Unchecked
for Digidesign's Session 8 .WAV Files 
This option is only necessary if you are using Sound Forge XP to modify files for use with Digidesign's 
Session 8. Enabling this option forces Sound Forge XP to align the data portion of .WAV files on a 
sector boundary, which is needed when using .WAV files with the Session 8.
Save .VOC Files Using Newest Format Default: Unchecked
(16-bit capable)
Prior to Creative Labs' boards supporting the playback of 16-bit data, VOC files had no way of storing 
16-bit audio data. With the addition of 16-bit playback sound boards to the Sound Blaster line of 
products, a newer version of the VOC file was created. With this option disabled Sound Forge XP will 
save all 8-bit files in the old format and all 16-bit files in the new format. With this option enabled it will 
save all files in the new format. Only enable this option if you have software which requires the new 
format for 8-bit data.
Open and Save Default: Off
with Sound Forge 3.0 Compatible Regions
Sound Forge XP 3.0 had a minor bug when opening and saving regions in which the total length was off
by one sample. Since we both opened and saved the files inconsistently with the published standard, it 
didn't affect anything. Sound Forge XP 4.0 fixes this problem, but in doing so this means that file 
created with Sound Forge XP 3.0 will have their region length display 1 sample smaller than before.
If this bothers you, turn this option on when opening a file saved in Sound Forge XP 3.0, turn it off, and 
then save the file. From there on after, the region lengths will not be off by one in Sound Forge XP 4.0 
(but will be in 3.0!)
Default SDS Channel When Saving (1 to 16)Default: 1
Specifies the channel used in SDS packets when saving audio as an SDS file.
Default SDS Patch When Saving (0 to 127) Default: 0
Specifies the patch used in SDS packets when saving audio as an SDS file.
Default Dialogic .VOX Sample Rate for Open Default: 8,000 Hz
Specifies the default sample rate used when opening Dialogic .VOX sound files in Sound Forge XP. 
This option is necessary because Dialogic .VOX sound files do not contain this information. Typical 
settings for this option are 6,000 Hz and 8,000 Hz.
Associate Sound File Extensions
Pressing the Associate Sound File Extensions button from the File tab in the Preferences folder opens 
the Sound File Associations dialog. This dialog provides a method of associating audio files with Sound 
Forge XP. When a file is associated with Sound Forge XP, you can simply double-click on a sound file in
the File Manager or the Windows 95 Explorer and it will open for editing.
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Performance Preferences
Use this to set preferences related to opening and saving files.

Temporary Storage Folder Default: C:\FORGE40\
The specified directory is used to store temporary files used by Sound Forge XP.
Sound Forge XP stores its temporary data in a temporary directory on your hard drive. Using temporary
file space allows you to edit very large files and keeps Sound Forge XP from eating up large portions of 
RAM on your computer. Your temporary directory must have enough space to handle the total size of all
files you plan to edit at one time along with space for any clipboard data and undo buffers. 
If you change the Temporary storage folder, you will have to close Sound Forge XP for the change to 
take effect.
Free Storage Space in Selected Folder
Shows the amount of available disk space in the selected folder.
Video Decompression Mode Default: 8 bits always
Determines the bits per pixel (color resolution) which will be used by Sound Forge when it 
decompresses video frames before displaying. Note that when a high number of bits is used, the 
performance demands on your system are higher. The available modes are:

8 bits always
Sound Forge will always decompress the video to 8 bits per pixel (256 color).
Best for display
Sound Forge will decompress the video to the best format that matches your system's color 
capabilities.
Full decompress always
Sound Forge will always decompress the video to its original bits per pixel when displaying. This is 
useful if you want to ensure that the video frames you see contain all the color information stored in 
the file. Also, if you wanted to paste frames to the clipboard, this ensures maximum resolution.

Peak Ratio Default For New Sound Files Default: 1:256
When drawing the waveform display, Sound Forge XP will use a peak file instead of scanning all of the 
data when the zoom ratio is above this level. Lower values allow for faster scrolling at those ratios, but 
increases the peak file's size. For example, setting this value to 1:128 instead of 1:256 will make the 
peak file two times larger but will make scrolling at 1:128 faster and scrolling at 1:65536 or higher ratios 
slower.
To calculate the size of the resulting peak files, you divide the size of the file by the Peak ratio. For 
example, a 100 MB sound file will need a 0.39 MB (100/256) peak file when using 1:256.
Wait Cursor Zoom Ratio Threshold Default: 1:512
Specifies the amount of zoom above which an hourglass cursor will be displayed between data window 
repaints. If the mouse cursor seems to flicker on and off a lot when redrawing wave data, you may want
to increase this value. This value is ignored during playback.
Show the Position of the Playback Cursor Default: Checked
When this option is enabled, the Position field in the status bar will show the cursor position during 
playback. Disable this option if you have a very slow computer or video card.
Show the Record Counter While Recording Default: Checked
When this option is enabled, the record time will show in the Record dialog while recording. Disable this
option if you have a very slow computer or video card.
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Status Preferences
Use to select display status options.

Default SMPTE Format Default: Non-Drop 30 FPS
Specifies the SMPTE type used when selecting a SMPTE format option from the Status Bar shortcut 
menu.

Non-Drop 30 FPS
Calculates status values using a 30 frames per second SMPTE code.
Drop 29.97 FPS
Calculates status values using a 29.97 frames per second SMPTE code. This is accomplished by 
dropping two frames every minute except for minutes 00, 10, 20, 30, 40, and 50.
EBU 25 FPS
Calculates status values using a 25 frames per second SMPTE code. This format is the European 
Broadcast Union time code.
Film Sync 24 FPS
Calculates status values using a 24 frames per second SMPTE code. This format is for standard 24 
frames per second film media.

Default Time Format Default: Time
Specifies the time format (time or seconds) used when selecting the Time option from the Status Bar 
shortcut menu.
Default Frames Per Second (1 to 1,000) Default: 15.000
Specifies the default frame rate used to calculate frame values.
Frame values are useful when trying to synchronize sound with animation. Most animation players 
specify a playback frame rate at which video frames are shown to the user. If you are using an 
animation that has a frame rate of 15.0 frames per second, you would set the frame rate to 15.0. When 
status values are shown by Sound Forge XP they will be shown in values of frames. This allows you to 
find the frame to which a given point in the sound file corresponds.
Frame rates can be any value between 1.0 and 1,000.0 frames per second.
Default Beats Per Measure (1 to 32) Default: 4
Specifies the number of beats in each measure for displaying in measures and beats. For example 2/4 
time would have two beats per measure.
Default Beats Per Minute (1 to 1,000) Default: 120.000
Specifies the number of beats per minute, i.e. the tempo of a song for displaying lengths. For example, 
a tempo of 120 is 120 beats per minute.
Display Format for SMPTE Code Default: 00:00:00.00
Specifies how SMPTE values will be formatted for display by Sound Forge XP. Select one of the 
available preferences from the drop-down list.
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Toolbars Preferences
Use to select which toolbars are displayed on the main screen. A check before the toolbar means that the 
toolbar is turned on. The following toolbars are available:

Standard Default: Checked
Contains standard file, and edit operations.
Transport Default: Checked
Contains record and play operations.
Status Default: Unchecked
Contains operations to set the display Status Format as well as the Snap To operations.
Show Tooltips Default: Checked
The Show Tooltips check box turns on or off the help information box displayed next to the mouse when
it is held over certain items.
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Wave Preferences
Use this folder to specify what wave devices Sound Forge XP should use for recording and playback. 

Note: The capabilities of wave devices may limit you from playing some files.

Playback
Specifies the device to be used when playing sound data.
Selecting a mapper device such as the Wave Mapper or Microsoft Sound Mapper allows Windows to 
select an appropriate device to use for the current sound data.
Record
Specifies the device to be used when recording sound data.
Selecting a mapper device such as the Wave Mapper or Sound Mapper allows Windows to select an 
appropriate device to use for the current sound data.
Interpolate Position for Inaccurate Devices Default: Checked
Specifies whether Sound Forge XP should interpolate the position of the play position pointer during 
playback. If this option is not checked, Sound Forge XP relies on the device driver for the sound card to
provide the correct position of the pointer during playback.
Many sound card drivers do not report their position accurately. If the play position pointer does not 
move smoothly you should enable this option. You may also want to contact your sound card 
manufacturer for updated drivers.
If your sound card driver does not have accurate position reporting, your Drop Marker and Mark In/Out 
positions will also be off when dropping markers while playing.
Position Bias (-64 to 64) Default: 0
Specifies an offset value which Sound Forge XP should add to the position values returned by the 
sound card wave driver during recording or playback.
Many sound card drivers do not report their position accurately. When you play sounds back, the 
position of the play pointer may seem to lag or precede the actual sound you are hearing. If this is the 
case, you may want to adjust this value. Most sound card drivers that report incorrect position give a 
value ahead of the actual sound.
To remove this bias, start with smaller values and work toward larger ones in increments of 4 (a value of
1 is equal to 512 bytes) until the play position pointer is accurate. Recommended settings are 4, 8, 16, 
and 32. These settings correspond to the typical bias values for these drivers of -2048, -4096, -8192 
and -16384 (negative multiples of 2048) bytes. 

An inaccurate playback cursor is due to poorly written sound card drivers. If you
experience this problem, call your sound card manufacturer and request that they get

their act together. 

Total Buffer Size (kilobytes) Default: 512
Select the amount of RAM you would like to use for buffering sounds during play and record. Using a 
large value can optimize performance at high sample rates but may also cause a slight delay starting 
playback.
Preload Size (kilobytes) Default: 0
Determines the total amount of wave data that will be queued to the sound driver before playback 
starts.
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Tools Menu
DTMF/MF Tones 
Statistics 
Synthesis 



DTMF/MF Tones
Use this to generate the standard dial tones used by the telephone companies.

Dial String
Use this to enter the phone number to be generated along with any necessary pause characters. 
Unknown characters will be ignored.
Amplitude (-Inf. to 0 dB)
Peak level of the waveform.
Tone Style to Generate

DTMF 
Dual Tone Multi-Frequency signals are used by the standard push-button phones. It uses 
combinations of 679, 770, 852, 941, 1209, 1336, 1477, and 1633 Hz sine waves.
MF 
CCITT R1 signals are used internally by the telephone networks. They are generated by a 
combination of 700, 900, 1100, 1300, 1500, and 1700 Hz sine waves.

Single Tone Length (0.001 to 2 seconds)
Output length of individual tones.
Break Length (0.001 to 2 seconds)
Length of the silence between tones.
Pause Length (0.001 to 5 seconds)
Length of silence to insert when the pause character is found.
Fade The Edges of Each Tone
When on, the tones are faded in and out a few milliseconds to prevent glitching.
Pause Character
Character which when present in the dial string will cause a pause between successive tones.
Insert New Tone Sequence At (Cursor, Start of file, End of file,)
Point where the generated waveform will be placed within the existing sound file.
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Statistics
This tool displays statistical information about the selected sound file region.

Cursor Position 
This indicates the cursor position in samples from the start of the sound file.
Sample Value at Cursor
This value represents the instantaneous amplitude at this position.

For 16-bit sound files, the range of values is -32,768 to 32,767. For 8-bit sound files, the
range of values is -128 to 127.

Maximum/Minimum Position and Sample Value
Maximum and minimum sample values and the location, in samples, where they occur. 
This is useful for determining if any clipping occurs in the sound file. It can also be used to determine 
the noise level of a signal for use on the Noise Gate effect. For example, to find the noise amplitude, 
run the Statistics function on a region of noisy silence.
RMS Power
Root Mean Square of the sample values relative to the RMS value of a maximum-amplitude square 
wave (the loudest possible recording). 
When used on short intervals relates to the volume level of the sound file. However, if used on a large 
selection with large volume variation, this value becomes less meaningful. For another way to measure 
loudness, use the Scan Levels button in the Normalize dialog.
The calculation used in Sound Forge XP 4.0 is slightly different than in Sound Forge XP 3.0. The value 
of 0 dB corresponds to a maximum amplitude square, not sine wave. A maximum value sine wave will 
read at -3.0 dB.
Average Value (DC Offset)
This is a sum of all of the sample values in the selected region divided by the number of samples. If 
non-zero, this usually indicates that there is a DC offset in the recording process.
Zero Crossings
Times per second that the waveform changes from a negative value to a positive value. This value can 
be used as a rough estimate of the frequency of the sound data for very simple waveforms.
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Synthesis
Use Synthesis to generate a simple waveform of a given shape, pitch, and length.

Amplitude (-Inf. to 0 dB)
Peak level of the waveform to be generated. When generating Noise, the amplitude is affected by the 
cutoff frequency selected.
Waveform Shape (Sine, Square, Saw, Triangle, Noise, Absolute Sine)
Shape of a single period of the waveform.
Length (0.001 to 60.0 seconds)
Output length of the generated waveform.
Frequency (0.01 Hz to Sampling Rate/2)
Frequency of the waveform.
When creating noise, the frequency specifies the low-pass cut-off frequency. For white noise, the 
frequency must be set to its maximum available setting.
Note that aliasing occurs with many of these waveforms when using high frequencies because they are 
not band-limited.
Insert New Waveform At (Cursor, Start of file, End of file)
Point where the generated waveform will be placed within the existing sound file.
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Sound File Formats
The file formats recognized by Sound Forge XP are listed below along with the extension used to identify 
them to the user. An arbitrary extension has been assigned for each of the formats used by computers 
other than the PC. Many of these formats when found on another type of computer will tend to use the 
extension .SND. Thus, even if a file has the .SND extension it may not be a Sounder/ SoundTool file. 
Active Streaming Format (.ASF)
This is the new Active Streaming Format (ASF) used by Microsoft's NetShow On-Demand. ASF files are 
designed for both audio and video streaming over the Internet. 
Ad Lib Sample (.SMP)
This format is used by the Ad Lib Gold card, for its sampled instruments. It supports, 8-/16- bit, 
stereo/mono, and 4-bit Yamaha ADPCM compression.
Amiga SVX File (.SVX/.IFF)
This file type is found on the Commodore Amiga and is similar in substance to the Microsoft .RIFF Wave 
format.
Covox 8-Bit File (.V8)
This format is used with Covox software. It is an 8-bit mono uncompressed file format.
Creative Labs VOC File (.VOC)
This is one of the more commonly found sample sound formats found on PC-compatible computers. 
The .VOC format supports packed data which Sound Forge XP will unpack prior to importing the file. 
The .VOC format also supports information for silence, looping, and varying sample rates. When Sound 
Forge XP imports a .VOC file it uses the first sample rate found and ignores such information as looping 
and silence. Sound Forge XP will save .VOC files as unpacked data with none of the additional 
information such as looping or silence. Sound Forge XP gives you the ability to save .VOC files in either 
the old or new .VOC standard. The new .VOC standard supports 16-bit data. Refer to the Preferences 
section in the Reference chapter for information on configuring Sound Forge XP to always use the 
new .VOC standard.
Dialogic VOX File (.VOX)
This format is used with specialized voice data boards. It is a 4-bit mono ADPCM file format which 
expands to 16-bit data.

 Indicates this file format supports the saving of sample looping information.
Gravis Patch File    (.PAT)
This format is used by the Gravis UltraSound Card. Sound Forge XP can only read and write Gravis 
Patch files which have single samples stored in them. Patch files with multiple samples are not 
recognized. Sound Forge XP recognizes Gravis Patch files which are of version 1.10. Older versions, 
such as 1.00, are not supported.
Intervoice (.IVC)
This file format is for use with Intervoice telephony systems. It is a mono format with a variety of 
compression schemes available.
Macintosh AIFF    (.AIF/ .SND)
This format is used on the Apple Macintosh to save sound data files. An .AIFF file is best when 
transferring files between the PC and the Mac using a network, since most network software will delete 
any resource information in a Macintosh file. Sound Forge XP can also read an .AIFF with a Mac binary 
header attached but will identify the file as a Macintosh Resource instead.
Macintosh Resource (.SND)
This format is used on the Apple Macintosh to save sound resources. When reading a file of this type it 
must have a Mac-Binary header. This header is attached to binary files transferred with common 
Macintosh file transfer programs. Sound Forge XP does not save to this file format.
MIDI SDS File    (.SDS)
This format is a file which contains the exact data that would be transferred to a sampler when using the 
MIDI Sample Dump Standard (SDS) protocol. It is a series of MIDI SysEx messages. MIDI SDS supports 
mono files only.
NeXT / Sun (Java) File (.AU/.SND)



This is the standard format of sound files found on the NeXT and Sun Sparc station computers. This 
format has a large number of sub types of file data. Sound Forge XP reads and writes the most common 
data formats for these files, 8-bit linear, 16-bit linear, and u-Law.
RealMedia (.RM/.RA)
These are compressed formats designed for real-time audio and video streaming over the Internet.
SampleVision File    (.SMP)
This format is used with Turtle Beach's SampleVision software. It is a 16-bit mono file format. The .SMP 
format is meant to be used with sampling keyboards.

 Indicates this file format supports the saving of sample looping information.
Sonic Foundry Sample Resource (.SFR)
This format is an old format defined by Sonic Foundry and is supplied for compatibility. It is not 
recommended for use in saving files.
Sound Designer 1    (.DIG/ .SD)
This format is used by Sound Designer 1.
Sounder/SoundTool File (.SND)
This format is used with the shareware applications Sounder and Sound Tool. It is very popular on bulletin
boards and various online services.
Video for Windows (.AVI)
This is a Microsoft digital video file format. It supports multiple channel audio, but Sound Forge XP will 
only allow you to open one audio and one video stream at a time. When saving as an .AVI, many 
compression schemes are available for both the video and audio streams.
Wave (Microsoft) File    (.WAV)
This is the format for sampled sounds defined by Microsoft for use with Windows. It is an expandable 
format which supports multiple data formats and compression schemes.
Raw Files (.RAW)
Raw files can be composed of any sound data. If the data is any form of 8- or 16-bit PCM 
(uncompressed) or G.711 A-Law or u-Law (a form of companded compression), then Sound Forge XP 
can open and save the file.

 Indicates this file format supports the saving of sample looping information.



Summary Information Fields
IARL Archival Location
Indicates where the subject of the file is archived.
IART Artist
Lists the artist of the original subject of the file. For example, "Bach."
ICMS Commissioned
Lists the name of the person or organization that commissioned the subject of the file. For example, 
"XYZZY Records."
ICMT Comments
Provides general comments about the file or the subject of the file. If the comment is several sentences 
long, end each sentence with a period. Do not include newline characters.
ICOP Copyright
Records the copyright information for the file. For example, "© Copyright Sonic Foundry, Inc. 1996." If 
there are multiple copyrights, separate them by a semicolon followed by a space.
ICRD Creation Date
Specifies the date the subject of the file was created. List dates in year-month-day format, padding one-
digit months and days with a zero on the left. For example, "1964-03-02" for March 2, 1964.
ICRP Cropped
Describes whether an image or sound has been cropped and, if so, how it was cropped. For example, 
"third movement, first through fourth bars."
IDIM Dimensions
Specifies the size of the original subject of the file. For example, "8.5 in h, 11 in w."
IDPI Dots Per Inch
Stores dots per inch setting of the digitizer used to produce the file, such as "300."
IENG Engineer
Stores the name of the engineer who worked on the file. If there are multiple engineers, separate the 
names by a semicolon and a blank. For example, "Sayre, Jack; Feith, John."
IGNR Genre
Describes the original work, such as, "landscape," "portrait," "still life," etc.
IKEY Keywords
Provides a list of keywords that refer to the file or subject of the file. Separate multiple keywords with a 
semicolon and a blank. For example, "Madison; aerial view; scenery."
ILGT Lightness
Describes the changes in lightness settings on the digitizer required to produce the file. Note that the 
format of this information depends on hardware used.
IMED Medium
Describes the original subject of the file, such as, "computer image," "drawing," "lithograph," and so forth.
INAM Name
Stores the title of the subject of the file, such as, "Madison From Above."
IPLT Palette Setting
Specifies the number of colors requested when digitizing an image, such as "256."
IPRD Product
Specifies the name of the title the file was originally intended for, such as "Encyclopedia of Midwest 
Geography."
ISBJ Subject
Describes the contents of the file, such as "Aerial view of Madison."
ISFT Software
Identifies the name of the software package used to create the file, such as "Sound Forge XP."
ISHP Sharpness
Identifies the changes in sharpness for the digitizer required to produce the file (the format depends on 



the hardware used).
ISRC Source
Identifies the name of the person or organization who supplied the original subject of the file. For 
example, "Sonic Foundry, Inc."
ISRF Source Form
Identifies the original form of the material that was digitized, such as "slide," "paper," "map," and so forth. 
This is not necessarily the same as IMED.
ITCH Technician
Identifies the technician who digitized the file. For example, "Palmer, Curt."
DISP Sound Scheme Title
Identifies the name of the sound scheme, such as "doorbell."



Sound Forge XP and the Microsoft Audio Compression Manager

Sound Forge XP for 32 Bit Windows Note: The Microsoft Audio Compression Manager
(ACM) is currently not available under Win32s. This is a limitation of Win32s, not Sound

Forge XP for 32 Bit Windows.

The Microsoft Audio Compression Manager (more commonly referred to as the ACM) is a standard 
interface for Audio Compression and Filtering in Windows and Windows NT. This interface allows 
applications like Sound Forge XP to use compression and filtering algorithms provided by other 
companies.
Sound Forge XP fully supports audio compression and filtering through the ACM. This enables you to use
any ACM compatible compression and filter driver with Sound Forge XP. The best part of this support is 
you don't have to learn anything new to use it! Sound Forge XP transparently opens compressed WAV 
files and provides all available compression formats for WAV files in the Save As dialog. There are no silly
Import and Export commands. 
There are roughly three pieces to the ACM (though these pieces are tightly coupled). It is not necessary 
for you to know any details about these pieces to use the ACM from Sound Forge XP, so this information 
is supplied for those who want to know more. That being said, the three pieces of the ACM are:
Audio data compression and decompression
Audio data filtering
Transparent Playback and Recording of non-hardware supported audio files
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Audio data compression and decompression
The first piece of the ACM allows you to compress and decompress audio data. Audio compression is 
used to decrease the amount of data required to represent a sound; this ultimately results in smaller 
sound files. However, there are drawbacks to using audio compression on your sound files:

1. Most audio compression algorithms will degrade the quality of the sound. This is referred to as 
lossy compression since information contained in the sound is lost when it is compressed. The 
amount of sound degradation is entirely dependent on the algorithm.

2. Audio compression requires more processing time than uncompressed data. The amount of 
processing time is dependent on the algorithm, as well as your hardware setup. The result is 
opening and saving compressed files will usually take longer than uncompressed files.

3. Compressed files are not as portable as uncompressed files. If you are distributing .WAV files in a 
compressed format, you must make sure the person receiving the files can use them. Also, not all 
audio software can use compressed .WAV files, which could make using other programs with 
Sound Forge XP inconvenient.

In Sound Forge XP, any compressed .WAV file can be opened as long as a compatible ACM driver is 
installed and enabled. If there is no compatible ACM driver available for a compressed .WAV file, Sound 
Forge XP will inform you of the problem when you try to open it.
Saving compressed .WAV files is as simple as choosing the compression algorithm in the Format drop-
down list of the Save As dialog. Once a file has been saved as compressed, Sound Forge XP will always 
save changes to the file using the selected compression algorithm; you do not need to re-select the 
compression format each time you save. Of course you can change the compression format at any time 
with the Save As dialog. You can also revert to an uncompressed format.
Experimentation is probably the most important step in deciding whether or not to use audio compression 
for your projects.



Audio data filtering (Digital Signal Processing)
The second piece of the ACM provides access to Digital Signal Processing (DSP) algorithms. The ACM 
refers to these DSP algorithms as Filter drivers. Though the term Filter in this context is more generic 
than just frequency filtering (like Graphic EQ). An ACM filter can implement almost any type of audio DSP 
algorithm. Reverb, distortion, and time change are just a few of several possibilities.
Sound Forge XP does not come with any ACM filters. You must obtain ACM filters from other sources. 
However, since the ACM filter architecture is fully documented by Microsoft, it is possible that many types 
of filters will become available on BBB's and other places for use with Sound Forge XP. If any ACM filters 
are installed in your computer, you will see the ACM Filter menu item under the Tools menu.
Sound Forge XP allows you to use any ACM filter installed and enabled on your computer to process 
sound files. Simply select the ACM filter option under the Tools menu to choose the filter and its attributes 
that you wish to apply to your sound data. The ACM Filter tool works exactly like all other Sound Forge 
XP DSP functions including the option to save presets and set custom selections.



Transparent Playback and Recording of non-hardware supported audio files
The third part of the ACM is probably the most significant (or at least the coolest). It is called the Sound 
Mapper and allows audio data formats that are not directly supported by your sound card to be played 
and recorded. Sound Forge XP lets you use the Sound Mapper by selecting it for Playback and Record in
the Wave folder of the Preferences dialog. Additional configuration of the Sound Mapper for your system 
can be done using the Windows Control Panel.
If the ACM is not installed on your computer, the Sound Mapper option will be called the Wave Mapper 
instead. The Wave Mapper and Sound Mapper can be thought of as the same device (to a computer 
program, they are one and the same). However, the Sound Mapper, which requires the ACM to be 
installed, is much more powerful than the Wave Mapper. Keep this in mind when you hear people talk 
about the Wave Mapper and Sound Mapper.
Let's go through some examples of what the Sound Mapper can do. If you have a sound file that is 
recorded at a bizarre sample rate like 22,257 Hz (perhaps a file that came from an external sampler), and 
the closest sample rate that your sound card supports is 22,050 Hz, then the sound file normally cannot 
be played. You would have to change the sample rate of the file to 22,050 Hz before you could play it. 
However, changing the sample rate (without resampling) would cause the sound to play at a lower pitch.
The Sound Mapper can play this sound file correctly without forcing you to resample the file first. The 
Sound Mapper will map the sound to the best format possible and perform the resampling in real time. 
Yes Virginia, there is a Santa Claus!
Other examples include the ability to play 16-bit sounds on an 8-bit-only sound card. Or playing stereo 
sounds on a mono-only sound card. And believe it or not, you can record stereo files on a mono-only 
sound card. However, this last example is essentially useless because the Sound Mapper will simply 
duplicate the mono input of your sound card in both channels. So keep in mind that the Sound Mapper 
cannot create something that is better than what the sound card can supply.
The usefulness of the Sound Mapper for non-compressed sound files can be summarized as 
convenience. You don't have to convert the sound to a supported format before you listen to it. Some of 
the tasks that the Sound Mapper can perform (like format conversions while recording) are available not 
because they are useful in real world situations, but because the developers of the ACM knew it could be 
done. Much like climbing a mountain for no better reason than it's there.
So what about compressed sound files? Yes, the Sound Mapper allows you to play (and sometimes 
record) compressed sound files. Even on sound cards that do not support compression directly. So you 
can play a sound file that is compressed with Microsoft ADPCM or The DSP Group's TrueSpeech on any 
sound card without decompressing the sound file first. Many multimedia and entertainment software titles 
use compressed sound files to save disk space. The software then plays the files through the Sound 
Mapper.
We stated above that the Sound Mapper can sometimes record compressed sound files. The reason for 
not always being able to record compressed files (even when the compressed file can be played) is 
simple. Compressing sound data can be very computationally expensive (it takes a long time); the 
amount of time required is completely dependent on the compression algorithm and how it is 
implemented. Decompressing sound data is almost always faster than compressing the same sound data
which makes it possible to play it back in real time.
It should be noted that Sound Forge XP does not play and record compressed sound files directly. Rather,
all compression and decompression is performed while opening and saving the sound files. This limitation
is actually insignificant; Sound Forge XP is the perfect tool for authoring compressed sound files for the 
ACM and many software authors are using Sound Forge XP for exactly this. Sound Forge XP saves 
compressed sound files using the best quality possible – something that cannot always be done in real 
time. So saving compressed sound files with Sound Forge XP will usually sound better than those 
recorded with audio compression.
Notes on Sound Forge XP's sound file compression support:

Ÿ The Open dialog allows you to preview compressed .WAV files if you have an appropriate ACM 
driver is installed. However, you must have your Playback device set to the Sound Mapper for this 
to work (Preferences|Wave in the Options menu).



Ÿ When saving uncompressed audio data to a compressed format with the Save As dialog, it is a 
good idea to close the file and re-open it after saving. Since Sound Forge XP does the compression
and decompression during saving and loading you will not be able to hear what the file sounds like 
with compression until after you've saved and reloaded the file.



Setting up the Microsoft Audio Compression Manager
The Microsoft Audio Compression Manager is part of Windows 95 and NT. If you are running Windows 
3.x, Sound Forge XP will install Video for Windows in your computer, which also installs the ACM.
In Windows 95, to view the installed audio compression and decompression drivers, go to Control Panel|
Multimedia|Advanced|Audio Compression Codecs. Double-clicking on any of the codecs allows you to 
enable or disable each one.



SMPTE Time Code
The Society of Motion Picture and Television Engineers (SMPTE) time code may be one of the most 
misunderstood concepts among individuals within the music industry. After working with SMPTE time 
code for years, many people are still confused by the concept, so don't feel bad if you haven't got it all 
figured out. Hopefully this discussion will clear the mud.
The biggest problem with SMPTE time code is that, depending on whether you sit on the video or audio 
side of the fence, SMPTE time codes may mean different things to you. When dealing with SMPTE you 
will probably see five, perhaps six, different types of time codes formats (six is for the people who are 
really confused).
Here is a description of each SMPTE time code format:
SMPTE 25 EBU
This SMPTE code runs at 25 frames per second and is also know as SMPTE EBU (European 
Broadcasting Union). The reason for having this rate is that European television systems run at exactly 25
frames per second.
SMPTE 24 Film Sync
This SMPTE code runs at 24 frames per second and is also know as SMPTE Film Sync. This rate 
matches a nominal film rate of 24 frames per second (the slowest speed possible for apparent continuous
motion).
OK, those two are easy. Now things start to get a little crazy.
SMPTE 30 Non-Drop (as used in the audio world)
In the US, the 60 Hz power system makes it easy to generate a time code rate of 30 frames per second. 
This rate is commonly used in audio environments and is typically known as 30 Non-Drop. You will 
probably use this rate when synchronizing audio applications like a multi-track recorder or your MIDI 
sequencer.
If all you care about is working with audio and not dealing with video, stop reading right here. We 
mean it! All you really need to know is that there are three different SMPTE rates you might want to use: 
SMPTE 24, SMPTE 25, and SMPTE 30 Non-Drop. However, be aware that SMPTE 30 Non-Drop in the 
video world runs at 29.97 frames per second.
True SMPTE 30 Drop and SMPTE 30 Non-Drop (as used in the video world)
If you are planning to work with video, the frame rate of exactly 30 frames per second is never used. 
When NTSC color systems were developed, the frame rate was changed by a tiny amount to eliminate 
the possibility of crosstalk between the audio and color information. Even though it is still referred to as 
SMPTE 30 Drop or Non-Drop, the actual frame rate that is used is exactly 29.97 frames per second. This 
poses a problem since this small difference will cause SMPTE time and real time (what your clock reads) 
to be different over long periods. Because of this, two methods are used to generate SMPTE time code in
the video world: Drop and Non-Drop.
In SMPTE Non-Drop, the time code frames are always incremented by one in exact synchronization to 
the frames of your video. However, since the video actually plays at only 29.97 frames per second (rather 
than 30 frames per second), SMPTE time will increment at a slower rate than real world time. This will 
lead to a SMPTE time versus real time discrepancy. Thus, after a while, we could look at the clock on the 
wall and notice it is farther ahead than the SMPTE time displayed in our application.
SMPTE Drop time code (which also runs at 29.97 frames per second ) attempts to compensate for the 
discrepancy between real world time and SMPTE time by "dropping" frames from the sequence of 
SMPTE frames in order to catch up with real world time. What this means is that occasionally in the 
SMPTE sequence of time, the SMPTE time will jump forward by more than one frame. The time is 
adjusted forward by two frames on every minute boundary except 00, 10, 20, 30, 40 , and 50. Thus when 
SMPTE Drop time increments from 00:00:59:29, the next value will be 00:01:00:02 in SMPTE Drop rather
than 00:01:00:00 in SMPTE Non-Drop. In SMPTE Drop, it must be remembered that certain codes no 
longer exist. For instance, there is no such time as 00:01:00:00 in SMPTE Drop. The time code is actually
00:01:00:02.
When synchronizing audio to video, it is crucial that the SMPTE time code (30 Drop or Non-Drop) used in 



your sequencer or digital audio workstation is the same as the SMPTE time code striped onto the video. 
Only then will the SMPTE times on the video screen and computer monitor match exactly during 
playback.
In the audio world, people have started to call 30 Non-Drop (which runs at 29.97 frames per second) 
29.97-Non-Drop to distinguish it from the 30 Non-Drop used between audio applications (which runs at a 
true 30 frames per second). SMPTE 30 Drop (as used in video) may also be referred to as SMPTE 29.97 
Drop just to reiterate that the frame rate is actually 29.97 frames per second. It just depends on who you 
talk to.
However, you must remember that there is no difference between 30 Drop and 29.97 Drop time code. 
There are those who have tried to say that there is such a thing as a SMPTE time code which actually 
runs at 30 frames per second and generates "drop frames", but such a time code would not show "real 
world time" and would also be incompatible with the 29.97 NTSC frame, so its use is unclear.
How Sound Forge XP deals with the issue
For SMPTE 24, SMPTE 25, and SMPTE 30 Drop time codes, Sound Forge XP behaves as you would 
expect. The 24, 25 and 30 Drop frame rates are calculated and generated at exactly 24, 25, and 29.97 
frames per second respectively. In 30 Drop rate, the "dropped frames" are inserted to make up for the 
time discrepancies with real world time.
For SMPTE 30 Non-Drop, the default method for Sound Forge XP is to calculate all SMPTE values at 
exactly 30 frames per second. If you are working with video and need SMPTE Non-Drop running at 29.97 
frames per second, you can turn off the Use 30 frames per second for SMPTE Non-Drop option in the 
MIDI/Sync Preferences folder. This will cause Sound Forge XP to use 29.97 frames per second instead 
of 30 frames per second for SMPTE 30 Non-Drop.
Some calculations for your benefit:
SMPTE 30 fr = 33.3333 ms per frame; SMPTE 29.97 fr = 33.3667 ms per frame
1 minute = 60 seconds * 30 = 1,800 frames per minute
1 minute = 60 seconds * 29.97 = 1,798.2 frames per minute
Difference per minute = 1.8 frames.
1 hour = 3,600 seconds * 30 = 108,000 frames per hour
1 hour = 3,600 seconds * 29.97 = 107,892 frames per hour
Difference per hour = 108 frames.
Thus in drop frame we need to "catch up" by 108 frames per hour
For example, in Non-Drop mode the SMPTE time code of 01:00:00:00 will equate to a real world time of 
01:00:03:18. Therefore, there is a lag behind real world time of 3 seconds and 18 frames after 1 hour.
Here is a nifty chart to show how SMPTE Drop works. As time progresses, two frames are dropped each 
minute except at the 00, 10, 20, 30, 40 , and 50 minute points. Notice that after one hour, 108 frames 
have been dropped. This number corresponds to the number of drop frames we calculated above needed
to match SMPTE 30 (29.97 fps) time to real time.

Number of dropped frames versus minutes elapsed over one hour
Minutes 00 10 20 30 40 50

xx:00:00:00 xx:10:00:00 xx:20:00:00 xx:30:00:00 xx:40:00:00 xx:50:00:00

0 0 frames 18 frames 36 frames 54 frames 72 frames 90 frames
1 2 20 38 56 74 92
2 4 22 40 58 76 94
3 6 24 42 60 78 96
4 8 26 44 62 80 98
5 10 28 46 64 82 100
6 12 30 48 66 84 102
7 14 32 50 68 86 104
8 16 34 52 70 88 106
9 18 36 54 72 90 108

Using CSOUND, MTU, IRCAM, BICSF and EBICSF Files



Although Sound Forge XP supports a large number of sound file formats directly, it does not support the 
CSOUND, MTU, IRCAM, BICSF or EBICSF file types. However, by using the Raw File Type capabilities 
of Sound Forge XP, sound data from these file types can be extracted.
The IRCAM or IRCAM-Gross format consists of a 1024 byte header prior to the audio data. This header 
contains standard information like the number of channels, sampling rate, and data format. It also can 
contain information such as the name of the sample and comments on what is included in the file. This is 
the format used by the MTU system and is often referred to as MTU files. IRCAM files support two types 
of data formats: 16-bit linear PCM and floating point data.
BICSF or EBICSF files (Berkeley/IRCAM/CARL Sound File or Extended BICSF) are an extension of the 
IRCAM format. The difference being that instead of using the standard IRCAM header they replace the 
first 28 bytes of the header with a standard NeXT/Sun header. This allows the IRCAM format to continue 
to hold additional information in its 1024 byte header and still allow the files to be read by software that 
supports the NeXT/Sun file format (such as Sound Forge XP).

Opening and Saving files
BICSF and EBICSF files
When reading BICSF or EBICSF Sound Forge XP will identify them as NeXT/Sun files. This is due to the 
fact that the header of the BICSF file has been modified to allow it to be read as a NeXT/Sun File. Sound 
Forge XP has no difficulty reading these files as long as they are in one of the supported NeXT/Sun data 
formats.
IRCAM, CSOUND and MTU files
When reading any of these types you must import the files as a Raw data file. The best way to do this is 
to set up the correct parameters in the Sound Forge XP Raw File Type dialog box and then save presets 
labeled accordingly. Sound Forge XP's Raw File import will allows you to read these files as long as they 
are mono or stereo and are stored in 16-bit linear format. Sound Forge XP will not allow you to read the 
floating point format IRCAM files.

Opening an IRCAM file
To open an IRCAM sound file in Sound Forge XP, follow these steps:

1. Open the File Open dialog box.
2. Select the Raw File type.
3. Select an IRCAM file to load.
4. Press the OK button in the File Open dialog. This will bring up the Raw File Type dialog box.
5. Select the following parameters:

Sample rate: Set the most common sample rate you use (typically 44,100).
Sample type: 16-bit PCM
Format: Signed
Channels: Mono or Stereo (depends on the file)
Byte order: Big endian or Little endian (depends on where the file was generated).
Header: 1,024 bytes
Trailer: 0 bytes

6. Before selecting OK to load the file press the Save As button to create a preset. Type in an 
appropriate preset name and press OK.

Now whenever you wish to load an IRCAM file, you can load it as Raw File Type and then select the 
preset you saved to set all the necessary parameters to load the file. Note that if any of the files are not 
the same as your preset, you should change them in the raw dialog box. You may even want to create 
multiple presets.
It is important to note that the Byte order of files is not always the same for files generated by CSOUND. 
The CSOUND executables for the PC generate files which use Little Endian byte ordering. CSOUND for 
other platforms tends to generate files with Big Endian ordering. MTU files also use Big Endian ordering. 
The best policy is to try a file first in Big Endian. If the sound data seems to be garbage, then try loading 
the file using Little Endian. Again you may want to save presets for byte ordering, as well as mono/stereo,



if you are receiving CSOUND files from a variety of other computers.

Saving files with Sound Forge XP
When saving files of the above types you will not be able to save them as IRCAM, CSOUND or MTU. You
will have to save any files of these types as one of the file formats supported by Sound Forge XP.
If you wish to save a file for use with software which supports the BICSF/EBICSF format you should save 
the file as a NeXT/Sun file which will not save any of the additional information found in a BICSF/EBICSF 
file but should allow the software to read the data as a NeXT/Sun file.



Troubleshooting
1. When playing files from my SCSI drive, why does the sound have a warbling effect? ANSWER 

2. When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the 
Macintosh not recognize them as sound files? ANSWER

3. Why do some effects take so long to process a file? ANSWER

4. When I start Sound Forge XP my Play and/or Record buttons/options are grayed out. Why can I not
play or record? ANSWER

5. Why can I not get Sound Forge XP to respond to levels from my Microphone or my CD Player? 
ANSWER

6. I have sound files that don't want to play on my system. Sound Forge XP loads them fine, why will it
not play them? ANSWER

7. Why will Sound Forge XP not open my compressed files like Microsoft ADPCM? ANSWER

8. Why is it when I play my sound files the play pointer that Sound Forge XP displays seems to be off 
from what I am hearing? ANSWER

9. When I record or play back files I hear what sounds like small clicks in the sound. ANSWER

10. When I record (or play) data at high sample rates, I cannot get Sound Forge XP to stop by pressing 
the Stop button. ANSWER

11. After converting WAV files to Redbook audio using the software which came with my Compact Disc 
recorder, there are audible clicks at the end of the track. ANSWER

12. My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can I 
open it with Sound Forge XP? ANSWER

13. When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti, my 
system crashes. ANSWER

14. When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves but I 
do not hear any output. ANSWER

15. When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch is 
wrong). ANSWER

16. Microsoft ADPCM files created using Sound Forge XP crash when I play them in Media Player on 
my Turtle Beach sound card. Why? ANSWER

17. When I play a sound file, I sometimes hear a click at the beginning or end of the selection. 
ANSWER

18. While drawing the Waveform Display, my system locks up completely. ANSWER

19. When opening an AVI file, if the audio stream format is 44.1 kHz stereo file Microsoft or IMA 
ADPCM, the audio track does not    open correctly. ANSWER



Q: When playing files from my SCSI drive, why does the sound have a warbling effect? 
A: When playing files from a SCSI drive that is connect to a SCSI adapter that utilizes a DMA channel 

(such as most Adaptec adapters) you may experience a warbling effect in the sound playback. This 
can occur if your sound card uses DMA and its DMA channel is set to a higher number than your 
SCSI adapter.

To fix this problem, set the DMA channel used by your sound card is a lower number than that used 
by your SCSI adapter. So, if your SCSI adapter is set to DMA channel 5 and your sound card is set to 
DMA channel 7, try reconfiguring them so the sound card uses DMA channel 5 and your SCSI 
adapter uses DMA channel 7.

                                                         
See also
Troubleshooting 



Q: When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the 
Macintosh not recognize them as sound files?

A: The Macintosh uses special information within it's operating system to keep track of the types of files 
to which it has access. Sound Forge XP for Windows can save the audio data in the correct file 
format, but it cannot tell the Macintosh what type it is. To do this you must use a program on the 
Macintosh, like ResEdit, which allows you to change the Type of the file. You simply need to set the 
Type field to AIFF for the Macintosh to recognize the file as a sound file.

                                                         
See also
Troubleshooting 



Q: Why do some effects take so long to process a file?

A: Some processing functions used by Sound Forge XP are very math intensive. Examples include EQ 
and the reverb effect. This means that millions of integer and floating-point arithmetic operations must
be performed for each second of sampled data. If your computer's CPU does not have a math co-
processor (in the Intel architecture that means if you have an i486 SX instead of an i486 DX or 
Pentium), floating-point operations will drastically slow you down and there is not much you can do 
except save up for a faster processor.

Of course, running effects on stereo, 44,100 Hz, hour long files will slow you down no matter what 
machine you are using. If you are going to be deleting or inserting space into these huge files, we 
recommend that you break the files into smaller ones and then mix the smaller files together once you
are done processing them. This is especially painful when you insert or delete from the beginning of a
large file, since Sound Forge XP must then shift the rest of the file over.

                                                         
See also
Troubleshooting 



Q: When I start Sound Forge XP my Play and/or Record buttons/options are grayed out. Why can 
I not play or record?

A: When Sound Forge XP starts, it checks to see if you have a wave playback and record device 
installed in your system. If you do not then it disables the appropriate operations. If you are sure that 
you have a sound card installed in your system, yet Sound Forge XP does not recognize this, you 
need to check a couple of things. First check the Wave folder in the Preferences dialog. The two 
settings of importance are the Playback and Record drop-down list boxes. These options determine 
the wave playback and record devices which will be used by Sound Forge XP. By default Sound 
Forge XP uses the Wave Mapper (may also be called the Sound Mapper) device which should 
automatically pick an appropriate device for use by Sound Forge XP. If either the Playback or Record 
device is set to (None) then Sound Forge XP can not execute the corresponding operation. To learn 
more about configuring your wave devices refer to the Wave Preference folder in the Reference 
section.

                                                         
See also
Troubleshooting 



Q: Why can I not get Sound Forge XP to respond to levels from my Microphone or my CD Player?

A: Most sound cards come with multiple inputs which you can record sound from. These may include 
microphone, CD, auxiliary, MIDI and line inputs. Although some cards record from all of these inputs 
at the same time, many cards make you choose which device is currently your record device (also 
known as the input source). These cards come with software which allows you to pick which device is
the input source. You will need to refer to your sound card manual to determine how to set the input
source.

Most sound cards also come with some kind of application which controls the input level of the 
recording device. You may need to increase the level of your input sources in order to record from 
them. Again, you will need to refer to your sound card manual to learn how to adjust these levels.

                                                         
See also
Troubleshooting 



Q: I have sound files that do not want to play on my system. Sound Forge XP loads them fine, 
why will it not play them?

A: Sound Forge XP allows you to load many different types of sound files, including ones that your 
system may not be capable of playing. There are a variety of reasons that your sound card may not 
be capable of playing a file.

Some sound cards only allow playback and recording at specific sample rates. Typically these rates 
are limited to 11,025, 22,050, and 44,100 Hz. If you try to play a file that is 32,000 Hz the sound card 
will not allow you to play it.

If you have an older sound card it may only support Mono playback. If this is the case simply convert 
any Stereo files to Mono and you will be able to play them.

If you have an older sound card it may only support 8 bit playback. If this is the case simply change 
the sample size of the file from 16 to 8 bits.

                                                         
See also
Troubleshooting 



Q: Why will Sound Forge XP not open my compressed files like Microsoft ADPCM?

A: Sound Forge XP has built in support for the Microsoft Audio Compression Manager (ACM). This 
allows you to open files that are compressed with a variety of algorithms including Microsoft ADPCM, 
IMA ADPCM, and other third party compression schemes like True Speech from The DSP Group.

If you cannot open a Microsoft ADPCM file, you may not have the Microsoft ACM installed in your 
system or you do not have the Microsoft ADPCM driver installed and enabled for the ACM. Please 
refer to the Appendix's on Installing the Microsoft Audio Compression Manager and Sound Forge XP 
and The Microsoft Audio Compression Manager for more information on how to install and use the 
ACM with Sound Forge XP.

                                                         
See also
Troubleshooting 
The Audio Compression Manager
Installing the ACM



Q: Why is it when I play my sound files the play pointer that Sound Forge XP displays seems to 
be off from what I am hearing?

A: For Sound Forge XP to display the current position of the pointer relative to playback of audio data it 
must rely on your sound card driver to provide the correct position. Many sound card drivers do not do
a very good job of this. Typically the position these cards provide is both off by a fixed amount as well 
as reported only in large discrete steps. Sound Forge XP provides a way to compensate for this by 
setting various options in the Wave Preferences folder (File menu). Refer to the Wave Preferences 
folder in the Reference section for more information.

                                                         
See also
Troubleshooting 



Q: When I record or play back files I hear what sounds like small clicks in the sound.

A: When Sound Forge XP is recording or playing audio data it needs to move large amounts of data 
between your hard drive and your sound card. This can be a tremendous amount of work for your 
computer depending on the kind of system you have. If Sound Forge XP can not move the data fast 
enough then you will hear small "gaps" between blocks of data which typically sound like clicks or 
puttering. There are a number of things you can do to reduce the overhead during the time Sound 
Forge XP is moving sound data, all of which are covered in the Using Sound Forge XP section called 
Optimizing Sound Forge XP.

                                                         
See also
Troubleshooting 
Clicks at start or end of playback, Q&A 



Q: When I record (or play) data at high sample rates, I cannot get Sound Forge XP to stop by 
pressing the Stop button.

A: Sound Forge XP tries very hard to keep recording and playback of audio smooth (no gaps in your 
sound). So there may be delays between the time that you press the Stop button and the time that 
Sound Forge XP actually stops. Note that you can always press and hold the Escape key to stop 
record or playback no matter how bad the situation is. Just be a little patient and wait a few seconds. 
These delays are usually only observed when one or more components of your system can not keep 
up with the data rate. Typical faults are:

1. Very slow (older) hard drives.
2. Poorly written Sound Card Drivers.
3. Setting your Storage directory to a slow device like a Network drive or a Compressed Hard drive.
If at all possible, use the fastest uncompressed storage device available with Sound Forge XP. For 
more information on configuring your system, see the section on Optimizing Sound Forge XP.

                                                         
See also
Troubleshooting 



Q: After converting WAV files to Redbook audio using the software which came with my Compact
Disc recorder, there are audible clicks at the end of the track.

A: Not all software for converting WAV files to Redbook audio handles the WAV file structure correctly. 
The software simply skips the first 44 bytes of data in the WAV file and then considers everything else
in the file to be audio data. This means that if you have saved Summary Information, Sampler 
Information, or Regions data in the WAV file it will be interpreted as audio data.

If you are experiencing this problem simply, use the Save As command in Sound Forge XP to save a 
new WAV file with the Save Summary Information and Save Regions check boxes unchecked. This 
tells Sound Forge XP to save only the minimum amount of information needed for a WAV file. Also 
saving a file with Sector aligned data for Digidesign's Session 8 (File Preferences) turned on can 
cause a glitch at the start of the sound file in other software.

                                                         
See also
Troubleshooting 



Q: My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can
I open it with Sound Forge XP?

A: RBK files are simply Raw PCM sound data files. These files are used by some Compact Disc 
recorders. These files are used to store Redbook audio onto a Compact Disc. RBK files are data only 
and contain no other information. They are stored as 16 bit, stereo data with a sample rate of 44.1 
kHz. There are a number of things that make them different than a normal 16 bit raw file:

1. The channels are stored in reverse order.
2. The data is stored in Big Endian format (Motorola).
3. The data length of the file has to be a multiple of 2352 bytes (1 CD sector). The size of a CD 

sector is calculated as follows:
1 second of 44.1k, 16 bit, stereo Audio = 176,400 bytes.
CD audio has 75 sectors of data for each 1 second of audio.
Sector size = 176,400/75 = 2352 bytes.

To open an existing RBK file, simply use the RAW file option in Sound Forge XP's Open dialog box 
and select the RBK preset. Remember that you will have to swap the channels if you want to maintain
the correct left/right channel settings.

                                                         
See also
Troubleshooting 



Q: When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti,
my system crashes.

A: This is caused by a severe bug in the Turtle Beach Multisound and Tahiti sound card drivers. You will 
experience the same crash no matter what software you use to play sample rates above 44,100 Hz--
including Media Player and even Turtle Beach's own Wave application.

Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves 
but I do not hear any output.

A: This is caused by a bug in the Turtle Beach Multisound driver.

Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch
is wrong).

A: This is due to poorly written sound drivers that incorrectly play sounds with sample rates that are not 
supported by the sound card hardware. For example, a sound that is supposed to play at 13,000 Hz 
might get played at 11,025 Hz instead. This will cause the pitch to be lower and the playback time 
slower than it should be. The Microsoft Windows Sound System Version 2.0 and many 'compatible' 
sound cards contain this unfortunate bug.

Contact your sound card manufacturer for updated drivers.

                                                         
See also
Troubleshooting 



Q: Microsoft ADPCM files created using Sound Forge XP crash when I play them in Media Player 
on my Turtle Beach sound card. Why?

A: Turtle Beach has implemented the Microsoft ADPCM format in the DSP of their audio cards. 
Depending on the version of the drivers you are using, you may crash when playing files created in 
Sound Forge XP on these cards.

This is a bug in the Turtle Beach drivers. Contact Turtle Beach for updated drivers.

                                                         
See also
Troubleshooting 



Q: When I play a sound file, I sometimes hear a click at the beginning or end of the selection.

A: If you hear a click during playback start or stop, the first thing to check is whether there is a waveform 
glitch or sudden spike at either end of your selection (or file). Zoom In Full and ensure that the 
selection start and end points are located in complete silence and no glitches exist.

If you're certain that the selection endpoints contain no audio but still hear a pop, the most likely 
culprit is your sound card's software driver. We have found that some versions of several sound 
card's drivers cause random glitching when starting or stopping playback.

Sound Forge XP has been tested with many different sound cards by thousands of users, and we are 
very confident in its correct implementation of standard Windows audio functions. Almost all of the 
technical support calls we receive are due to hardware conflicts or poorly written sound card drivers. If
you experience any sound recording or playback problems, follow these steps:

1. Ensure that you are using unique interrupts (IRQ's) and DMA channels between all of your 
hardware.

2. Try playing the sound file with Media Player (mplayer.exe or mplayer32.exe), which is included 
with Windows 3.x, 95 and NT. If the playback glitching exists with Media Player also, there is 
definitely a problem with the sound card hardware or driver.

3. Contact your sound card manufacturer and request for the latest drivers for your sound card.

                                                         
See also
Troubleshooting 
Hear clicks during playback, Q&A 



Q: While drawing the Waveform Display, my system locks up completely.

A: If you experience a system lockup frequently in Sound Forge XP, it is likely that your video card is 
causing this problem. This problem is known to happen with ATI's Mach64 card when using High 
Color (16-bit) in Windows 95.

Because Sound Forge XP's drawing routines are highly optimized, they increase the chance of 
causing little-known video card problems to arise. To solve this problem, turn on Compatible Draw 
Mode (for Broken Video Drivers) under the General Preferences (Options menu).

                                                         
See also
Troubleshooting 



Q: When opening an AVI file, if the audio stream format is 44.1 kHz stereo file Microsoft or IMA 
ADPCM, the audio track does not    open correctly.

A: This is due to a known bug in Video for Windows. It only happens if the file is both 44.1 kHz, stereo, 
and compressed using Microsoft ADPCM. To get around this problem, resample the audio to 22 kHz 
before saving.

                                                         
See also
Troubleshooting 
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ADPCM
Adaptive Delta Pulse Code Modulation (ADPCM) is a method of compression audio data. Although the 
theory for compression using ADPCM is standard, there are many different algorithms employed. As an 
example, Microsoft's ADPCM algorithm is not compatible with the International Multimedia Association's 
(IMA) approved ADPCM.



A-Law
A-Law is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in United States' 
telecommunications. A-Law is very similar to µ-Law, however, each uses a slightly different coder and 
decoder.



Aliasing
Aliasing is a type of distortion that occurs when digitally recording high frequencies with a low sample 
rate. For example, in a motion picture, when a car's wheels appear to slowly spin backwards while the car
is quickly moving forward you are seeing the effects of aliasing. Similarly when you try to record a 
frequency greater than one half of the sampling rate (the Nyquist Frequency), instead of hearing a high 
pitch you may hear a low frequency rumble.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the 
sound has been recorded, aliasing distortion is impossible to remove without also removing other 
frequencies from the sound.



Amplitude Modulation
Amplitude Modulation (AM) is a process whereby the amplitude (loudness) of a sound is varied over time.
When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies
are created which can strongly alter the timbre of a sound.



Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (like drums, piano, guitar 
plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a 
very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a 
slow attack.



Audio Compression Manager (ACM)
The Audio Compression Manager (ACM) from Microsoft is a standard interface for audio compression 
and signal processing for Windows. The ACM can be used by Windows programs to compress and 
decompress WAV files, as well as apply DSP algorithms to audio data.



Audio Event Locator
The Audio Event Locator is similar to a scrub function. However, rather than playing the sound file at a 
slow speed, it loops playback around the cursor position. This position can be selected by dragging the 
cursor around in the Sound Forge XP overview window.



Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a 
voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an 
example, the 8 bit binary number 10011010 represents the unsigned value of 154 in the decimal system. 
In digital sampling, a binary number is used to store individual sound levels, called samples.



Bit Depth
Bit Depth refers to the number of bits used to represent a sample. For example 8 bit and 16 bit are two 
common Bit Depths. Sound Forge XP uses the term Sample Size when referring to Bit Depth.



Byte
A byte refers to a set of 8 bits. An 8 bit sample requires one byte of memory to store, while a 16 bit 
sample takes two bytes of memory to store.



Channel Converter
The Channel Converter is a function in Sound Forge XP that converts files from mono to stereo and 
stereo to mono with independent level control of the new channels. This function can also create 
interesting effects by converting stereo files to stereo with various levels and inversion of channels.



Chorus
Chorusing is an effect created by combining a signal with a modulating delayed copy of itself. This effect 
creates the illusion of multiple sources creating the same sound. 



Clipboard
The clipboard is where sample data is saved when you cut it from a sample so that you may past it or mix
it into another sample.    Sound Forge XP maintains it's own clipboard for cutting and pasting sample data 
allowing you to keep memory usage to a minimum.    However, this does not change the normal operation 
of the clipboard and you can still cut and paste between Sound Forge XP and other Windows 
applications.



Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In 
digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16 bit 
data. Clipping causes sound to distort.



Cutoff-frequency
The cutoff-frequency of a filter is the frequency at which the filter changes its response. For example, in a 
lowpass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than 
the cutoff frequency are not affected.



CODEC
Acronym for Coder/Decoder. Commonly used when working with data compression.



Crossfade Loop
Sometimes a sample loop cannot be easily created from the given source material. In these instances a 
crossfade can be applied to the beginning and end of the loop to aid in the smooth transition between the 
two. The Crossfade Loop function provides a method of creating sampling loops in material that is 
otherwise difficult to loop.



Data Window
Each opened sound file in Sound Forge XP has its own Data Window. On top of each Data Window is a 
Title Bar displaying either the title of the sample or the name of the file. Also in each Data Window are the 
Waveform Display, Ruler, Playbar and other tools that give you information and allow you to navigate 
throughout the entire sound file.



DC Offset
DC Offset is phenomenon that occurs when hardware such as a sound card adds DC current to a 
recorded audio signal. This current causes the audio signal to alternate around a point above or below the
normal -infinity dB (center) line in the sound file. To visually see if you have a DC offset present you can 
zoom all the way into a sound file and see if it appears to be floating over the center line. Sound Forge XP
can compensate for this DC offset by adding a constant value to the samples in the sound file.



Decibel
The decibel (abbreviated as dB) is a unit used to represent a ratio between two numbers using a 
logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times 
greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 
6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing two instantaneous values.
Decibels are commonly used when dealing with sound because the ear perceives loudness in a 
logarithmic scale.
In Sound Forge XP, most measurements are given in decibels. For example, if you want to double the 
amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value 
for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be 
referred to having a value of -6 dB.



Destructive Editing
Destructive editing is the type of editing whereby all cuts, deletes, mixes and other processes are actually 
processed to the sound file. Anytime you delete a section of a sound file in Sound Forge XP the sound file
on disk is actually re-written without the deleted section. This is different than non-destructive editing. See
Non-destructive Editing.



Direct Edit Mode
Opening a file from the Open dialog with the Operate directly on the sound file box checked, opens the 
file in direct edit mode. This simply means that no temporary file is created for the file. The first time you 
open a file in direct edit mode, a peak data file will be created and stored in the directory that the file 
resides. From then on opening and saving the file will be almost instantaneous regardless of the size of 
the file. Please note, however, that any edits you make to the file are actually changing the file. With the 
unlimited Undo capability of Sound Forge XP this shouldn't be a problem, but keep in mind that if the 
system crashes for any reason, the file will be saved in the state that it is in when it crashes and no undo 
will be available.



Device Driver
A Device Driver is a program that allows Windows or DOS to "connect" different hardware and software 
together. For example, a sound card device driver is used by Windows software to control sound card 
recording and playback.



Digital Signal Processing
Digital Signal Processing (DSP) is a very general term describing anything that alters digital data. Signal 
processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the 
analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a 
combination of programming and mathematical techniques. DSP techniques are used to perform many 
effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your 
computer's processor and specialized DSP chips can be used to perform any DSP operation. The 
difference is that DSP chips are optimized specifically for mathematical functions while your computer's 
microprocessor is not. This results in a difference in processing speed.



Drag-and-Drop
Drag-and-Drop is a quick way to perform certain operations using the mouse in Sound Forge XP. To 
Drag-and-Drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and 
move the mouse) and drop it (let go of the mouse button) at another position on the screen. For more 
information on where you can use Drag-and-Drop, look in Appendix A: Shortcuts.



Dynamic Range
Dynamic Range is the difference between the maximum and minimum signal levels. It can refer to a 
musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before 
distortion vs. noise floor). For example, orchestral music has a wide dynamic range while thrash metal 
has a very small (always loud) range.



Equalization (EQ)
Equalizing a sound file is a process by which certain frequency bands are raised or lowered in level. EQ 
has various uses. The most common use for Sound Forge XP users is to simply adjust the subjective 
timbre of a sound.



File Associations
This dialog allows you to associate sound file extensions (such as .wav, .au, .snd, etc.) with Sound Forge 
XP. This dialog is opened from the File page of the Preferences dialog.



File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows, the 
most common file format is the Microsoft WAV format. However, Sound Forge XP can read and write to 
many other file formats so you can maintain compatibility with other software and hardware 
configurations.



Frequency Modulation
Frequency Modulation (FM) is a process whereby the frequency (pitch) of a sound is varied over time. 
Slow frequency modulation results in pitch-bending effects. Fast frequency modulation creates many 
different side-band frequencies.



Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is 
basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these 
frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200
Hz) of the spectrum.



Insertion Point
The Insertion Point is like the cursor in a word processor.    It is where pasted data will be placed or other 
data may be inserted depending on the operation.    The Insertion Point appears as a vertical flashing 
black line and can be moved by clicking the left mouse button any where in the data window.



MCI
The Media Control Interface (MCI) is a standard way for Windows programs to communicate with 
multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can be easily 
controlled by most multimedia Windows software.



Media Player
Media Player is a Windows 3.1 program that can play digital sounds or videos using MCI devices. Media 
Player is useful for testing your sound card setup. For example, if you can't hear a sound play through 
your sound card in Sound Forge XP, try using Media Player. If you can't play the sound using Media 
Player, check the sound card's manual (do not call Sonic Foundry's Technical Support until you've called 
the sound card manufacturer).



Noise-shaping
Noise-shaping is a technique which can minimize the audibility of quantization noise by shifting its 
frequency spectrum. For example, in 44,100 Hz audio quantization noise is shifted towards the Nyquist 
Frequency of 22,050 Hz.



Non-Destructive Editing
This type of editing involves a pointer-based system of keeping track of edits. When you delete a section 
of audio in a non-destructive system the audio on disk is not actually deleted. Instead, a set of pointers is 
established to tell the program to skip the deleted section during playback. Sound Forge XP is a 
destructive editor.



Normalize
To normalize a file means to raise its volume so that the highest level sample in the file reaches a user 
defined level. Use this function to make sure you are fully utilizing the dynamic range available to you. 
Sound Forge XP also allows normalization to RMS power. This means that a scan will be done on the 
sound file and it will be raised in level so its RMS power will be equal to the normalization level. This is 
helpful for making multiple files perceptually as loud as each other.



Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one half of the sample rate and represents the highest 
frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist 
Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz will produce aliasing 
distortion in the sample if no anti-aliasing filter is used while recording.



Overview
The Overview is the area on the Data Window directly under the Title Bar. The entire length of the 
Overview represents the entire sound file. Cursor, selection, and position information is shown relative to 
the entire length of the sound file.



Peak Data File
A peak data file is what is created by Sound Forge XP when a file is opened in direct edit mode for the 
first time. This file stores the information regarding the graphic display of the waveform so that opening a 
file is almost instantaneous in direct edit mode. This file is stored in the directory that the file resides in 
and has a .sfk extension. If this file is not in the same directory as the file, or is deleted, it will be 
recalculated the next time you open the file in direct mode.



Playbar
The Playbar is the bar at the bottom of each Data Window.    On the left of the Playbar are the following 
buttons: Go To Start, Go To End, Stop, Play Normal, Play Loop, Play Sample.    On the right are the 
Selection Status Fields which display the selection start, end, and length.



Quantization
Quantization is the process by which measurements are rounded to discrete values. Specifically with 
respect to audio, quantization is a function of the analog to digital conversion process. The continuous 
variation of the voltages of a analog audio signal are quantized to discrete amplitude values represented 
by digital, binary numbers. The number of bits available to describe these values determines the 
resolution or accuracy of quantization. For example, if you have 8-bit analog to digital converters, the 
varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 
values.



Quantization Noise
Quantization noise is a result of describing an analog signal in discrete digital terms (see quantization). 
This noise is most easily heard in low resolution digital sounds that have low bit depths and sounds like a 
shhhhh type sound while the audio is playing. It becomes more apparent when the signal is at low levels, 
such as when doing a fade out.



Reactive Preview
Reactive Previews allow for the tweaking of parameters in a function dialog while the preview is playing. 
When a parameter is changed the preview will automatically rebuild and continue playback.



Resample
To resample means to recalculate samples in a sound file at a different rate than the file was originally 
recorded. If a sample is resampled at a lower rate, sample points are removed from the sound file 
decreasing its size, but also decreasing its available frequency range. Resampling to a higher sample 
rate, Sound Forge XP will interpolate extra sample points in the sound file. This increases the size of the 
sound file but does not increase the quality. When down-sampling one must be aware of aliasing. See 
Aliasing. 



Root Mean Square
The Root Mean Square (RMS) of a sound is a measurement of the intensity of the sound over a period of 
time. The RMS power of a sound corresponds to the loudness perceived by a listener when measured 
over small chunks of time.



Ruler, Time
The Time Ruler is the area on a data window above the waveform display. It shows the horizontal axis 
units as well as marker, region, and loop tags.



Ruler, Level
The Level Ruler is the area on a data window to the left of the waveform display. It shows the vertical axis
units as either percents or dB's.



Ruler Tags
Ruler Tags are the icons on the Ruler which represent the location of Markers, Regions, and Loop points 
in the Waveform Display.



Sample
The word sample is used in many different (and often confusing) ways when talking about digital sound. 
Here are some of the different meanings:

Ÿ A discrete point in time which a sound signal is divided into when digitizing. For example, an audio 
CD-ROM contains 44,100 samples per second. Each sample is really only a number which contains
the amplitude value of a waveform measured over time.

Ÿ A sound which has been recorded in a digital format; used by musicians who make short recordings
of musical instruments to be used for composition and performance of music or sound effects. 
These recordings are called samples. In this manual, we try to use sound file instead of sample 
whenever referring to a digital recording.

Ÿ The act of recording sound digitally, i.e. to sample an instrument, means to digitize and store it.



Sampled Sound
Sampled sounds are sounds which have been recorded in a digital format and saved on your system for 
playback through a sound board. A sampled sound is sometimes referred to as a sample. However, a 
sample can also refer to a single point in a sampled sound.



Sampler
A sampler is a device that records sounds digitally. Although, in theory, your sound card is a sampler, the 
term usually refers to a device used to trigger and playback samples while changing the sample pitch.



Sample Rate
The Sample Rate (also referred to as the Sampling Rate or Sampling Frequency) is the number of 
samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity 
than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher
sample rates.



Sample Size
The Sample Size, or Bit Depth,    refers to the number of bits used to represent a single sample. Sound 
Forge XP uses either 8 or 16 bit samples. While 8 bit samples take up less memory (and hard disk 
space), they are inherently noisier than 16 bit samples.



Shortcut Menu
A Shortcut menu, also called a Shortcut menu, is a context sensitive menu which appears when you click 
on certain areas of the screen. The functions available in the Shortcut menu depend on the object being 
clicked on as well as the state of the program. As with any menu, you can select an item from the 
Shortcut menu to perform an operation. Shortcut menus are used frequently in Sound Forge XP for quick 
access to many commands. An example of a Shortcut menu can be found by right clicking on any 
Waveform Display in a Data Window.



Sign-Bit
Data that has positive and negative values and uses zero to represent silence. Unlike the Signed format, 
two's complement is not used. Instead, negative values are represented by setting the highest bit of the 
binary number to "one" without complementing all other bits. This is a format option when opening and 
saving RAW sound files.



Signed
Data that has positive and negative values and uses zero to represent silence. This is a format option 
when opening and saving RAW sound files.



Status Bar
The Status Bar is the bar at the bottom of the Sound Forge XP main screen.    The Status Bar fields on the
right of the Status Bar contain information about the active Data Window (Sample Rate, Sample Size, 
Stereo/Mono, Total Size).    On the right side of the Status Bar, help and processing information is 
displayed.



Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).



u-Law
u-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian 
telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and 
decoder.



Unsigned
Data that has only positive values and uses half the maximum value to represent silence. This is a format 
option when opening and saving RAW sound files.



Waveform
A Waveform is the visual representation of wave-like phenomena, such as sound or light. For example, 
when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth 
waveform. The Waveform Display in each Data Window represents exactly this.



Waveform Display
The Waveform Display is the part of the Data Window which shows a graph of the sound data waveform. 
The vertical axis corresponds to the amplitude of the wave. For 16 bit sounds, the amplitude range is -
32,768 to +32,767. For 8 bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, 
with the left most point being the start of the waveform. In memory, the horizontal axis corresponds to the 
number of samples from the start of the sound file.



Zero Crossing
A Zero-Crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits 
at zero crossings with the same slope, the chance of creating glitches is minimized.



Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain 
does not change in small enough increments, zipper noise can become very noticeable. Sound Forge 
XP's fades are accomplished using 64-bit arithmetic, thereby creating no audible zipper noise.



Tips of the Day
Accurate play cursor position 
Attach a video to a sound file 
Context-sensitive help 
Digidesign's Session 8 
Direct file editing 
Docking a Toolbar 
Double-clicking with markers and regions 
Drag and Drop Mix, Crossfade, and Paste 
Dropping markers 
Edit boxes 
Faders and trackbars 
Find the maximum level in a file 
Fine tuning a control 
Keyboard shortcuts 
Magnify Mode 
Making a selection during playback 
Marker Navigation 
Maximize the level of a sound file 
New file from selection 
Opening files 
Optimizing your system 
Pencil tool 
Play Loop mode 
Playing to the cursor 
Re-select the last selection 
Repeating an operation 
Saving a file in RealMedia format 
Scrolling with the Time Ruler 
Shortcut Menus 
Silky smooth fades 
Spinner Controls 
Time and Level Zoom 
Toolbars 
Turn off Tip of the Day 
Vertical Zoom 



Turn off Tip of the Day Next 
To keep this window from popping up every time you run Sound Forge XP, go to the General Preferences 
page (Options menu) and uncheck Show Tip of the Day on open. While doing so, you will realize how 
many options and features Sound Forge XP has. You might then decide that if you learn a new trick from 
this Tip of the Day feature every time you run Sound Forge XP you'll save yourself valuable editing time.
List all Tips of the Day 



Optimizing your system Next      Prev 
Some suggestions concerning how to optimize your system to improve Sound Forge XP's performance 
are included in the Optimizing Sound Forge XP    section. 
List all Tips of the Day 



Direct file editing Next      Prev 
For very fast file opens and saves, opening files in Direct Mode allows you to work on the original file 
instead of a backup.
List all Tips of the Day 



Level Zoom Next      Prev
To view low-level sounds, zoom vertically by using the Level Zoom spinner on the lower left-hand corner 
of the Data Window or press Shift+Up/Down arrow keys. Once you're zoomed in, you can drag the Level 
Ruler up and down to change the zero line.
List all Tips of the Day 



Marker Navigation Next      Prev 
To move the cursor to the next maker or region, press Control+Left/Right Arrow keys. If you also hold 
down the Shift key, a precise selection can be made.
List all Tips of the Day 



Double-clicking with markers and regions Next      Prev 
Double-clicking on the Waveform Display between two markers selects the region between them. The 
same goes for double clicking inside regions. Triple clicking or holding down the Control key while double 
clicking selects the entire file. Dragging the new selection extends the selection to the next marker, loop, 
or region.
List all Tips of the Day 



Toolbars Next      Prev
Toolbar buttons exist for almost all functions. To view a list of all possible toolbars, select View|Toolbars. If 
you hold the cursor over a toolbar button, a floating ToolTip displays the button's function.
List all Tips of the Day 



Shortcut Menus Next      Prev 
Shortcut menus exist for almost every square inch of space in Sound Forge XP. To view a shortcut menu, 
move the cursor to any area and click the right mouse button. Press F1 while selecting any menu item for 
more information.
List all Tips of the Day 



Docking a Toolbar Next      Prev 
You can drag floating toolbars anywhere on the screen or dock them to any side. Double clicking on any 
toolbars free space switches it from being floating or docked. To keep a toolbar from docking, hold down 
the Control key while dragging it.
List all Tips of the Day 



Spinner Controls Next      Prev 
Instead of clicking on the upper or lower buttons on a spinner, you can also drag the center button to 
change the control's value. When you move the mouse slowly (or hold the Control key while dragging), 
the value will change in small increments.
List all Tips of the Day 



Edit boxes Next      Prev 
Any control which requires you to type a number can also be changed by using the Up/Down or Page 
Up/Page Down arrow keys. Holding down the Control key allows for larger increments or decrements.
List all Tips of the Day 



Faders and trackbars Next      Prev 
To fine tune a fader or trackbar value, as when you choose Graphic EQ from the Process menu, hold 
down both the left and right mouse button while dragging the control. You can also use the Left/ Right 
arrow and Page Up/Down keys.
Double clicking on a control changes the value to its default state.
List all Tips of the Day 



Keyboard shortcuts Next      Prev 
Some of the most useful keyboard shortcuts include:

Spacebar Play/Stop
Enter Pause
C Center cursor on screen

List all Tips of the Day 



Opening files Next      Prev 
You can quickly open files by dragging them from any folder onto the Sound Forge XP desktop. If you 
have Open Drag and Drop Sound files in Direct Mode selected from the General page of Preferences, the
files will be opened even faster.
List all Tips of the Day 



Drag and Drop Mix, Crossfade, and Paste Next      Prev 
By dragging a selection from one open file to another, you can mix, crossfade or paste. To crossfade, hold
down the Control key before dropping. To paste, hold down the Alt key before dropping.
List all Tips of the Day 



New file from selection Next      Prev 
To create a new copy of the current selection, simply drag it onto an open area of the Sound Forge XP 
desktop. 
List all Tips of the Day 



Making a selection during playback Next      Prev 
To make a selection during playback, press the [ key to set the start time and then the ] key to set the end 
time and make the selection.
List all Tips of the Day 



Magnify Mode Next      Prev 
To quickly switch to Magnify Mode, hold down the Control key before making a selection. When you let go
of the mouse button, the selection will be magnified to fit the screen.
While in Magnify Mode and making a selection, clicking toggles between Horizontal Only, Vertical Only, 
and Horizontal and Vertical magnify modes.
List all Tips of the Day 



Re-select the last selection Next      Prev 
To re-select the last selection, press the S key. Press again to clear the selection.
List all Tips of the Day 



Time and Level Zoom Next      Prev
To quickly zoom a selection both vertically and horizontally, double click on the Levels Ruler. Double 
clicking again zooms out to the default zoom ratios.
List all Tips of the Day 



Digidesign's Session 8 Next      Prev 
You can save files compatible with Digidesign's Session 8 by checking the Sector align data option on the
File page of the Preferences properties sheet (Options menu).
List all Tips of the Day 



Dropping markers Next      Prev    
You can create markers by pressing M during playback. It is also possible to drop markers while recording
by pressing the drop marker button in the record dialog.
List all Tips of the Day 



Silky smooth fades Next      Prev 
Choose Fade from the Process menu, and then choose the Graphic  option to apply Dithering and Noise 
Shaping to fades to minimize 16-bit quantization noise.
List all Tips of the Day



Maximize the level of a sound file Next      Prev
Choose Normalize from the Process menu to specify an amount for the peak amplitude or loudness of a 
sound file. You can use this to make all sound files equal in loudness.
List all Tips of the Day 



Saving a file in RealMedia format Next      Prev 
The RealMedia file format allows you to broadcast audio and video in real time over the Internet. To save 
a file in the RealMedia format (.rm), choose Save As from the File menu, and then select RealMedia as 
the file type.
List all Tips of the Day 



Playing to the cursor Next      Prev 
To play up to a cursor (with no selection), Control-click the Play Normal button.
List all Tips of the Day 



Pencil tool Next      Prev 
The Pencil Tool allows you to draw a waveform straight into the Waveform Display. This is commonly 
used for correcting glitches. To enable the Pencil Tool, zoom in greater than 1:16 and select Edit|Tool|
Pencil.
List all Tips of the Day 



Repeating an operation Next      Prev
To repeat the last operation, use Control+Y.
List all Tips of the Day 



Attach a video to a sound file Next      Prev 
To add a video to an open sound file, select the Video folder in File|Properties and press Attach video. 
You will then need to save the file as a Video for Windows AVI file.
List all Tips of the Day 



Find the maximum level in a file Next      Prev 
To find the maximum level in a file, choose the Statistics option from the Tools menu.
List all Tips of the Day 



Fine tuning a control NextPrev 
To fine-tune a slider, fader, or spinner, hold down both the right and left mouse button while dragging. 
Holding down the Control key while dragging works the same way.
List all Tips of the Day 



Scrolling with the Time Ruler Next      Prev 
To scroll the Waveform Display backwards or forwards in time, drag the Time Ruler above the waveform.
List all Tips of the Day 



Accurate play cursor position Next      Prev 
If the play cursor in the Waveform Display seems slightly unaligned with the wave graph, use the Play 
position bias option on the Wave  page of the Preferences properties sheet (Options menu). This 
compensates for sound cards that report position information incorrectly.
List all Tips of the Day 



Context-sensitive help Next      Prev 
To get help on any main or pop-up menu item, select the item from the menu and press F1 while the 
menu is still up. Pressing the Help button or F1 while in any dialog will take you directly to the page in the 
Help file describing the dialog's function.
List all Tips of the Day 



Play Loop mode Prev 
To play in Loop Mode, press the Play Looped button . During playback, changing the cursor or 
selection by poking around the Waveform Display updates the play position immediately. This is very 
useful for tuning loops or selections and auditioning different parts of a file.
List all Tips of the Day 




